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1 Introduction

1.1 Introduction

NVMS Pro is an integrated security management platform released by our company, with the powerful capability of video surveillance
management, real-time preview, record storage, record playback, record download, alarm linkage, decoding on TV Wall, keyboard control,
vehicle entrance and exit management as well as intelligent analytics. Moreover, multi-subsystem of the third party in the security
surveillance industry can be accessed to this platform, such as alarm system, access control system, visual talk-back system, one-key alarm
system, e-fence and so on. Additionally, due to its open system architecture, its SDK/OCX can be provided to the third party for secondary
development. Therefore, NVMS Pro can meet the client’s demands of centralized multi-subsystem management and multi-business

convergence and can be widely used in the video surveillance of industrial park, education, banking, chain stores and buildings.

1.2 System Components
1.2.1 System

Control Center

Authentication

3 Media Server
Server

(" Front-end Access ) Background Monitor )

Decoder Client

— |

Camera

iy

swifch TV wall -i

switch

1.2.2 Front-end Access

®  Front-end devices include IPC, DVR and NVR.

®  You need to connect monitor devices such as IPC, DVR and NVR to internet through hubs or routers accessed by Cat5 or Catbe
cables (less than 100 meters) or optical fiber.

®  Run monitor client through local PC to configure the local video monitor, monitor devices and so on.

1.2.3 Background Monitor

®  Background monitors include TV Wall Client, Configuration Management Center and Monitor Client.

®  You can setup the real-time image of display devices, these display devices including TV-Wall (decoding images to show on the
TV-Wall through video decoder), digital display screen and so on.

®  Run configuration center through local PC to configure and manage the entire system

®  Run monitor client through local PC to view, playback and remotely configure and manage the real-time video of front-end monitor
devices.

1.2.4 Control Center

) In the control center, configure servers including authentication server and media transfer server to realize various service, such as,
device authentication(including Web), video transmission, image storage, alarm handling, etc.
® In the control center, add IP-SAN storage array to realize centralized storage.

® In the control center, connect servers and IP-SAN storage array to internet through switches.




1.3 \ersion

\ersion Signal access on trial Average signal access Max signal access

NVMS Pro 32 channels video signals 300-400 channels video signals 10000-ch video signals




2 Configuration Requirement

2.1 Software and Hardware Configuration Requirement

2.1.1 S&H Config Requirement for Control Center

N[} NVMS components

Recommendation for hardware

configuration

Recommendation for

software configuration

User Manual

Number

Inter(R) Core(TM) i5 4500 3.0GHz

Professional/Ultimate

Management Server or above /16GB memory
(including Web /ITSATA/ Gigabit NIC or AMD Windows Server 2012
/Windows Server 2016
1 Server/Alarm HD6570 or above, 512MB GDDR5 Windows10 As needed
Server/Access or above (multi-screen : 1GB Professional/Ultimate
server/E-Map Server) GDDR5memory) /500GB SATA/
Gigabit NIC
Windows Server 2012
2 Intelligent Server CPU configuration: /Windows Server 2016 As needed
g Inter(R) Core(TM)i5 75003.0GHz /Windows10

3 Transfer Server

CPU configuration:
Inter(R) Core(TM)i5 75003.0GHz

Windows Server 2012
/Windows Server 2016

/Windows10

Professional/Ultimate

It depends on the video format
and the number of channel

viewing simultaneously

4 Stream Media Server

CPU configuration:
Inter(R) Core(TM)i5 75003.0GHz

Windows Server 2012
/Windows Server 2016
/Windows10
Professional/Ultimate

It depends on the video format
and the number of channel

viewing simultaneously

Inter(R) Core(TM) i5 7500 3.0GHz

or above /16GB DDR3 Windows 7 SP1 64bit
/Intel HD Graphics 530 2GB, Professional/Ultimate
5 Monitor /INVIDIA GeForce GTX 1060 6GB Windows 10
or above (multi-screen : 2GB Professional/Ultimate/
GDDR5memory) /500GB SATA/ Home 64bit
Gigabit NIC
It depends on the stream,
5 HDD Capacity:500GB/1TB/2TB/3TB —_— channel and time of the storage
video
6 IP-SAN Supports 16/24/28 SATAS o 't depends on the number of the

HDD

Note: Face recognition IPC configuration: the application scenes should be set as “Security Monitoring”, or the snapshot interval should




When all IPCs added to the platform perform face detection or comparison, the number of the captured pictures reported to the platform

be set to more than 1s.

should not exceed 1,000 pictures per minute.

The recommended 64-bit hardware configurations are as follows.

NVMS Recommendation for hardware Recommendation for software N
umber
components configuration configuration
Inter(R) Core(TM) i5 7500 3.0GHz or above Windows 7 SP1 64bit
; Professional/Ultimate
. iarfian /16GB DDR3 /Intel HD Graphics 530 2GB, wing 0 As required by
indows
Client-64bit INVIDIA GeForce GTX 1060 6GB ) _ g
or above (multi-screen : 2GB Professional/Ultimate/
GDDR5memory) /500GB SATA/ Gigabit NIC Home 64bit

2.2 Requirement for Firewall

In order to ensure network security, it is necessary for the system to set up a firewall. All monitor ports should be opened on the installed

servers. The open ports are as follows:

Server Port Type Port ‘
Authentication Server Internal Port 6003
Http Server Service Port 8088
Internal Port 6006
Transfer Server

Auto Report Port 2009
(Pit_(:\:f/g; /ISI:-r\SIZrN) Internal Port 6009
Configuration Server Internal Port 7002
Alarm Server Internal Port 6033
TV Wall Server Internal Port 6036
Access Server Internal Port 6013
Intelligent Server Internal Port 6069
Application Server Internal Port 6093
HTTP Port 8090
RTSP Port 554

Media Stream Server
HLS Port 8091
RTMP Port 1935

Note: The above-mentioned ports are the default internal ports of servers. If all these ports are modified, these open ports shall be modified

accordingly in the firewall configuration.

2.3 Checking Installation Environment




Item Checkup Standard

Hardware Check whether the hardware meets the standard required. (including CPU, memory, HDD, etc.)

—— Check whether the software meets the standard required. (including the type and version of the operation
system, NVMS version, etc.)

Front-end device Check whether the device access is normal.

Firewall setup Check whether those open ports of firewall meet the standard required.

Network Check whether the networks of front-end devices and center equipments are normal.

TCP/IP config Check whether the settings of IP address, subnet mask, gateway and DNS correct.

2.4 Configuring Server IP Address

The IP address of the server (computer) is the IP address of the platform. Please make sure the platform and other devices are connected to

the WAN/LAN

. It is recommended that the platform and the devices that are about to be added to the platform are in the same local

network segment. Here is how to set the server IP address:

1.  Connect the network cable to the server, power on and start the server.

i
2. Click at the lower right corner of the computer desktop and then click “Open Network and Sharing Center” as shown below.

File

%= » Control Panel » All Control Paneltems » Network and Sharing Center
Edit View Tools Help

Control Panel Home

View your basic network information and set up connections

Ch dapter setti . | F= See full map
ange adapter settings u_’k - @
Ch d d shari
set;:gia M ADMIN-PC Netwaork 12 Internet
(This computer)
View your active networks Connect or disconnect
% Network 12 Access type: Internet
i ™ Public network Connections: I Local Area Connection 3
Change your networking settings \
{i- Set up @ new connection or network
=

Set up a wireless, broadband, dial-up, ad hoc, or VPN connection; or set up a router or access point.

3. Click “Local Area Connection x”-> “Properties”.
4.  Select IPv6 or IPv4 according to the actual network environment. Here we take IPv4 as an example. Then click “Properties” of IPv4.




5.

[ o s . et R

General

MNetworking

Connection
IPv4 Connectivity: Internet
IPvE Connectivity: Mo Internet access
Media State: Enabled
Duration: 14 days 04:54:46
Speed: 100.0 Mbps

Activity
Sent —— gkl ——  Received
T
Bytes: 2,125,192 | 9,285,794
[ @Properﬁesl [ @Disaﬂe ] [ Diagnose ]

Connect using:
‘ & Realtek PCle GBE Family Controller ‘

This connection uses the following tems:

& Client for Microsoft Networks

B 0105 Packet Scheduler

g File and Prirter Sharing for Microsoft Networks
i Intemet Protocol Version 6 (TCP/IPvE)
B8 |niemet Protocol Version 4 (TCP/IPv4)
v Link-Layer Topology Discovery Mapper |/ Driver
& Link-Layer Topology Discovery Responder

[owa ]
Description

Tranemission Control Protocol/intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected netwaorls.

Uninstall | I Properties "

\ Close

| oK || Cancel |

actual network environment. After that, click “OK” to save the settings.

Select “Use the following IP address” and then configure the IP address, default gateway and DNS server addresses according to the

Internet Protocol Version 4

General

for the appropriate IP settings.

(7) Obtain an IP address automatically
(@) Use the following IP address:

IF address:
Subnet mask:

Default gateway:

Preferred DNS server:

Alternate DS server:

Validate settings upon exit

You can get IP settings assigned automatically if your network supports
this capability, Otherwise, you need to ask your network administrator

255,255, 0 . 0

Obtain DNS server address automatically

(@) Use the following DNS server addresses:




3 Install and Uninstall the Software

3.1 Install the software

Server, Client and MYSQL need to be installed separately.

3.1.1 Install MySQL
Double click MySQL.exe to install.

1) Select “I accept the license terms”, Click [Next], select “Custom” and then click [Next];

MySQL. Installer License Agreement MySQL. Installer Choosing a Setup Type
Adding A

g Community Ade ommunity

To proceed you must accept the Oracle Software License Terms. Please select the Setup Tvoe that suits vour use case.

Developer Default

[ gancer
MySQL. Installer Select Products and Features e Installation
; Adding t
Please select the prodiscts and features you would like to install on this machine. Press Execute to upgrade the followng producs.
Filt | mrosua Satus Progress  Notes |

e [E] msct sonver 728 Beady bo Inatat

Avadable Products: Products Teatures To Be Installed:
LSO Sererns b MySEA Server 5704 - 085
MySOL Server

& Documertation

o BRI OB TG R LA L AR Cliek [Exeeute to install or update the following pacages

[Cepae | J | ook || epecste | [ cancel

3) Click [Next]>[Next], as shown below.




Installer Installation MySQL. Installer Product Configuration
Add munity
s B G wpgradie e (oowing prodicis we'll now walk threugh a canfiguration wizard for each of the foSawing praducts,
Frodudt Status Progress  Notes ¥ou can cancel at any paint if you wish to leave this wizard without configuring al the
@ D MySQL Senar 5714 Compiste products.
Product Stabus.
MySOL Server 5714 Repdyto Condgure
Ll n 13
: Ahvirw Detags » 1
et > cancel | Betr || Lancel

4) Check “TCP/IP”, “Open Firewall port for network access” and “Show Advanced Options” as shown below. Then enter MySQL Root
Password, a minimum of 4 letters.

Type and Networking

Server Configuratian Type
Choose the corred server configuration
setting will define how much system re:

Config Type: Development Machine

Installer Accounts and Roles

et Roet Account Password
Erer the password for the roal sccound. Please remember to stose this passward m

MySOL Root Password: | &

Repeat Password:

Cennectsaty
Use the folowing controls to sehect how you would bke 1o connect 1o this server
V| Teeae Port Mumb-er: 35306
+ | Cpen Firewall part for network access
reamed Fipe Pipe Name: ML

Pasiwrard mivimum lenglh: &

| Shared Memary  memaory Name:

our uner and spphicatiani. Aviagn a role 1o Ehe uses that

advanced Configuration

Host Uer Role
dditional configuration page where you can set

[Cemoe | [ goncet |

5) Click [Add User] to set username and password. To avoid forgetting, please enter “root” and the above password. Then click
[OK]>[Next];

Accounts and Roles MySQL. Installer ‘Windows Service

oot Account Password [¥] Configure MySQL Server as a Windows Service
Enter the paséword for the root account. Please rem 1o store ths password n a

Windows Serace Details

usermname, passeord, and datsbase role
Usginame oot ] Sart the MySGL Server at System Startup
Host A Hesvs G00 -
Reole EEELN—
Run Windows Service as ..
The MySOL Server needs Lo rim under 3 gven e
f your system you need to pick one o

Authonscason @) NySaL
Password SH000E8

Canfirm Password #6888
Password Strength:

Based on the securdy
aptians below,

tem Account
ded for most scenanos

Custom User
A&n emsting user account can be sslected for advanced seenarios.

gancol |

<pack || Mets || cancel

6) Click [Next] to go to “Advanced Options” interface. Please set according to the following picture. Then Click [Next];




er Manual

————
= S
Plugins and Extensions MySQL. Installer Advanced Options |
MYSOL a5 3 Dotument Store ySQL Legging Optians
s the fallowin s 1o select how you would lik b s b Error Log. On
| Enabie X Pretoced FMySOL Bt 8 Document Store
Port Mumber: 33060 Enorlog TPCET = I

Cpen Firewall port for network access 3 Genend Log
SHARting with MySQL Server 5.7, MySOL tupports document fore development. tn
cater to provide a complete document tore/NoSOL expenience there 1 a new
the X Frotocal. The e capsviities of the i
Frotncol enable us to Drovide modem deveboper AFls with features such as
asmehionous calls, pipesring. and more. In acdrion to imglementing document
cedfections, the new % DevA also supports relational and cembined document
store/velational cagabdities. Now developers, desgners and DBA can deplay
34 JataDaLEs that Implement document store, Telstional, or hybid
document/relation models.

e Fain  |PERPClag

Click here to vitw bvSOL &% 0 Document Sare anlin

for replication and data
by » Fename base sh

ions. Tt has » peformance impact on the

Senveld: 1
1
cgack | [ mmar || gancel [staa | [CHea> |[ Comen J:
7) Click [Execute]=>[Finish];
— =
MySQL. Inst Apply Server Configuration MySQL. Installer Apply Server Configuration
)L Ser QL Server 5.7.14
. Press [Execute] to apply the changes The cantiguration operation has stopped.
Conpuraion 300 |iag, | contguration stess, 120

O stopping Server (if necessary]

) writing configuration file

O updating firewall

O adsting Windows service (if necessary]

Begnning cenfiguiation Ap: ABSHIng seoulity selings
Aftempling 1o Lpdate ooty LeRlingt.

Uipdated sequrity seblings.

Ensed sonfiguration siep: Applang secunty serlings

Begnning cenfiguistion fep: Creating uses bttounts
Aftemgrting 10 A9 New MpbQL User

Added New Usess.

Ended canfiguration step: Creating user accounts

o

Inflializing Database [f necessary]
Btgnning cenniguiation tep: Updating SEa Meny Link
Aftampling 10 verity command.ee dient shortcut
Verdlied command-dne cdient ibartout.

Verdied commang-Sne dient shorteut

O Starting Server
Y Apphying seturity settings

o
O Creating user accounts

n

e T MySGL i
Ended conliguration step: Updating Fireveall for MySGL Bocument Dats Frabure Set

- Updating Start Menu Link

a

Updating Firewall far MySQL Document Data Feature Set

Confeguration Tor MySOL Sener 59,04 has succeeded. Peace dick Finish to
ontirmr.

8) Click [Next]>[Finish].

MyS(‘}L' Installer Product Configuration MYE'QL Inslall.er Installation Complete

el now walk through & configuration wizard for each of the following praduts, The installation oracedure has been comoleted.

"ou can cancel 3t any paint if you wish 15 Leave this wizaed without configuring all the

products. | copyregto chpbourd |
Product Status
MySER Serves 5734 Coraguation Complete

« il -

| bet> || Cancel

3.1.2 Install Server

1) Double click “NVMS server.exe”. Select the Ul language as needed.




MNVMS Server - InstallShield Wizard >

Select the language for the installation from the choices belaw.

Englizh [United States) R

Caca

2)  Atip will pop up to suggest you to close the antivirus software. If no prompt window appears, please skip this step.

rtip lﬂ

It is suggested that the 360tray.exe be closed first and then continue!

oK |

3)  Click “I accept the terms of the license agreement” and then click [Next].
4)  Click [Browse] to select the installation location and then click [Next].

| - .
lrzstel|5 ; <hock 7| Moz | o]

5)  Check “Launch Software” as needed and then click [Finish]”.

NVMS Server - InstallShield Wizard

InstallShield Wizard Complete

The In:

InstallShield < Back Finish Caneel
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3.1.3 Install Client

1) Double click “NVMS Client setup.exe” and then select the Ul language as needed.

MYPS Client - InstallShield Wizard *

Select the langquage for the inztallation fram the choices below,

Englizh [United States] w

Carcel

2)  Atip will pop up to suggest you to close the antivirus software.

rti|;l li]

It is suggested that the 360tray.exe be closed first and then continue!

OK |

3)  Select “l accept....” and then click [Next] to continue.
4)  Click [Browse] to select the installation location and then click [Next].

MVMS Client - InstallShield Wizard

Choose Destination Lo

InstallSiield < Back. Cancel

5)  Check “Launch Software” as needed and then click [Finish]”.

NVMS Client - InstallShield Wizard

InstallShield Wizard Complete

InstallShield < Back Finish Cancel
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3.2 Uninstall Software

If the new version needs to be installed or there is no need to use this software, this software can be uninstalled. It is strongly
recommended to back up the configuration data before installing the new version of NVMS.

The uninstallation steps of the Server are similar to the uninstallation of the client. Here we take Server uninstallation for example.

Click “Start” = All Programs—=> NVMS Server->Uninstall to pop up the wizard. Click “Yes” to confirm.

Select whether to delete the database, intelligent analysis data or configuration files as needed. Then clicking the “Finish” button ends the
uninstallation.

Select whether to delete the database, intelligent analysis data or configuration files as needed. Then clicking the “Finish” button ends the

uninstallation.

Uninstall Dptians

v | | | = |
Tnstal i < Rack | Mt | Esnce).

12



4 Login

4.1 Run Servers

Before logging onto the client, please ensure all servers are working normally. Having been installed successfully for the first time, the
server tray will minimize on the taskbar of the computer. Double click the server tray icon to pop up the server tray interface. You can also
right click the server tray icon and select “Display main interface” to pop up the server tray interface as shown below.

- ServerTrayUI X

Server Status Set Port Configure
Management Server D Running () 6003/7001 Configure
Database Server D Running L Configure |
Configuration Server D Running () 7002 Apply
Reboat All
HTTP Server P Running [ @) 8080 Apply
Transfer Server D Running () 6006/2009 Configure
ServerlP Address: ' -
Storage Server D Running ‘:) 6009 Apply
10.20.52.7 -
Alarm Server D Running () 6033 Apply
Access Server D Running () 6013 Apply
TV Wall Server D Running () 6036 Apply
Intelligent Analysis Server D Running () 6069 Apply
| Vel Uil Tz Stream Media Server 4°% Starting (} Configure
Display main interface 0(d)1(h)44(m)30(s) Application Server D Running () 6093 Apply
Quit '

The working status and port can be viewed from the server tray. All servers can be stopped and restarted. Additionally, all server ports can
be modified as needed. Click the corresponding port number to modify it and the modified port can be saved automatically after you move
your mouse to another place. Please remember to set the password of the database server to the pre-defined one by clicking [Configure].

Please set up according to the actual network.
How to configure stream media server and get video streams via RTSP/HLS/RTMP protocol? Please refer to Appendix for details.

4.2 Login

Double click the shortcut icon of “Monitor Client” to run the software as shown below.

User Name
& admin|

Password Forget password?
a8

Authentication Server Port
10.214.11.98 6003

[[] Remember Password (] Auto Login

13



(@ Enter username and password (the default username is admin; the default password is 123456).
@ Enter the IP address and port of the authentication server (the default port is 6003).

Check “Remember Password” or “Auto Login” as needed.
® Click [Login].
If you forget the password, please click “Reset password”. Then a small window will appear. You can reset the password by answering the
pre-defined questions.

Reset Super Administrator Password X

Create Security Questions / Answers Dynamic Password

Config Server: 7002

Question: When is the birthday of the person you like?
Answer:

Question: When's your father's birthday?
Answer:

Question: When were you born?

Answer:

o I=zm

If this is the first time for you to log in, please create security questions and answers. (Go to Home - User and Permission = User
Management-> Edit Security Questions/Answers)

Edit Security Questions / Answers X

Create Security Questions / Answers

Question:
Answer:
Question:
Answer:
Question:

Answer:

o ==

It is important that you remember the answers for these questions or you will not be to reset your password and be locked out.

If you don’t set the security questions and answers, you can reset your password by dynamic password. Click “Reset password” and then
click “Dynamic Password” to go to the dynamic password page. Search the CPU ID, MAC Address and the current time and then send
these information to the technical staff to get the dynamic password. Note that the management server and client must be installed in the
same server, or the CPU ID, the current time and MAC address cannot be searched.

After you log in, a record partition setting box will pop up. Please select the desired record storage location. Then click [OK] to save the
settings.

14



Record Partition Setting x

] Partition Symbol  Partition Size  Remain Size
CiSystem Driver) 10268
D 18768 B5GB
18768 9068

4.3 Main Menu Interface Introduction

ishboard - Face Attendance

Data Dashboard Video Preview Storage Playback

Intelligent Dashboard Video Preview | Alarm Preview Record Playback | By Time Shce | By Event
- E-Map Monitoring @! By Tag = Record Backup - Search Picture

Record Setting  Schedule Setting

3

E-Map TV Wall Management Resource Management

v E-Map Setting

TV Wall Setting | TV Wall View Add, Edit or Delete Device | Device Setting
TV Wall Task Settings % Area Setting | Channel Group Setling @

TV Wall System Setting

§ Device Alarm  ® Motion Delection 8 Face Alarm 8 Other Intelligent Alarm @ Subsystem Alarm 8 Zone Alarm 8 Sensor Alam. 8 Ac trol Alarm @ Offline Alarm @ Server Alarm B alarm Taosk (@D
Alarm Time Alarm Source Alarm Type W Storage Playback  Device Playback  Storage Snapshot  Device Caplure | Alanm Processing Hﬂl‘ld.\
N Monitoring Point: Face Detection ©) A [
2022 01-07 10:33:26 Device MarneBE_IP Cameralest Monitoring Point- Face Comparison (;) m ,— |
’A 4

#022-01-07 10:33:25 N1Z, Manitaring Point-Face Comparisan G}

There are five parts in the main menu interface. The descriptions of each part are as shown below.

Menu Bar
\[o} Description \[o} Description
1 Menu Bar 4 Status Bar
2 Tab Bar 5 Alarm Information Bar
3 Functional Areas
Tab Bar

15



User Manual

Menu Description
View “Live View”, “Edit live view”
System Including  “Switch User” , “Register”, “About”, “Modify Password”, “User Manual” and “Skin”

Functional area

Menu

Data Dashboard

Description

Smart display video window, device status, face comparison, human body temperature screening, E-map,
etc.

Video Preview

To view live images and to record, snapshot and talk, etc.

Storage
To remotely play the local records or back up records.
Playback ypiay P
E-Map To manage and display maps, hot spots, etc.
VA To set TV wall and decoding videos on TV Walls
Management
Resource To add, modify or delete areas, devices or servers.
Management
Group . . .
To manage people, vehicles and assign the access permission
Management
Accou_nt _and To add, modify or delete user account and set permissions for these accounts.
Permission

Alarm Center

To set alarm linkage and schedule; To search alarm logs.

Alarm System

To set alarm subsystem, zones and linkage of the alarm server

Access Control

To open the door remotely or set alarm linkages or view e-map or search log.

Management
Attendance . .
To set alarm linkage or view logs.

Management

Parking Lot . . .

g To manage vehicles in the parking lot
Management
Search Including image search by face, face comparison retrieval, license plate comparison retrieval, smart

snapshot retrieval and visitor record search.

Face Greeting

To welcome visitors based on face recognition technology

Face Attendance

To help to manage staff attendance based on face recognition technology

Line Crossing
Counting

To monitor and analyze people/vehicle flow in real time

Body
Temperature
Measurement

To view the statistics of body temperature

Industrial
Temperature
Measurement

To view the real-time video, analyze data and search records.

Operation and
Maintenance
Management

To search, export and maintain logs.

Configuration

To set record path, snapshot path, system startup and maintenance, overload and alarm view.

Evacuation To view the host/MICS/EM status
System
Edit Cor.nmon To select the functional module you want to display in the home page
Function
Other buttons:




Description

= Click it to hide the interface.

E Click it to zoom in or out the interface.

Click to exit the software.

|| Click it to add the video preview page.
When the tab pages exceed the applicable numbers, this icon will display. Click it to view the hidden
tabs.

Common buttons:
Button ‘ Description

Click it to edit the item.

Click it to delete the item.

Check the camera and then click it to select

Check the camera and then click it to remove

Click it to add all items

AN | A IVIENN

Click it to remove all selected items




5 Device Management

5.1 Add Encoding Device

In the main menu interface, click “Add, Edit or Delete Device” to go to the following interface as shown below.

Add, Edit or Delete Device Device Setting Area Setting Channel Group Setting

Gy ~

IP Address,

Device Type

Encoding Device (Online/Total number:0/0);

Add Encoding Device X

Quickly Add Manually Add Initiatively Report Unbound Auto Report Device
Device Quantity:63
- ~
O Device Name IP Address Modify IP Address Port Subnet Mask Protocol Version Dev
Device Name 10.20.19.208 r/l 6036 255.255.0.0 Standard Device 144 00:18:AE:€
] Device Name 10.20.52.200 m 6036 255.255.0.0 Standard Device 147 00:18:AE:/
a Device Name 10.20.18.38 r/l 6036 255.255.0.0 Standard Device 146 00:18:AE:£
m} IP Camera 10.20.18.130 M 8000 255.255.0.0 Standard Device  5.1.1.0 00:18:AE:E
] IPCamera 10.2019.56 80 0.0.0.0 ONVIF
O IPCamera 10.2019.112 80 0.0.0.0 ONVIF
m} IPC 10.20.18.94 r/l 9008 255.255.0.0 Standard Device |5.0.1.0 00:18:AE( .,
< >
Select Transfer Server  Transfer Server Select Storage Server Storage Server
Select Area (3 default area [J Automatically Link Area
o |

Then click “Add” to add devices. You can add multiply devices in this interface, such as face detection IPC, face recognition IPC/NVR,

face recognition terminal, active deterrence IPC, ANPR camera, etc.

5.1.1 Quickly Add

Click [Refresh] to quickly search devices in the same local network as shown below. Check the device and allocate the transfer server,
storage server, area for it. After that, click [OK].
Click “Default password” to set the default username and password of the devices from different manufacturers, such as Hikvision, Dahua,
etc. The default username of the standard device is “admin and the default password of the standard device is “123456”.
Note:
* The default media transfer server and storage server can be selected when adding devices. Users can also create new media
transfer server and storage server in advance (see Add Media Transfer Server and Add Storage Server).

* Area must be set up before adding devices. Click [Add Area] to create an area (See Area Setting).

5.1.2 Manually Add
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Add Encoding Device

Quickly Add Manually Add Initiatively Report Unbound Auto Report Device

1P Address ' | @ . 0 - 0 - 0 ‘ Standard Device 6036 admin LITTIT)

IP Address

IP Range
Domain Name
Serial No.

URL

IPV6

Select Transfer Server  Transfer Server A\ Select Storage Server Storage Server s

Select Area (D) A3 v [J Automatically Link Area
Default Password

(@  Enter IP address/IP range/domain name/Serial No./URL/IPv6 address, username and password and choose protocol type.
@  Click [Test] to test whether the device is connected successfully or not.

(®  Select transfer server, storage server and area and then click [OK].
Devices can be added in batch by adding IP range.

If “URL” is selected, you shall add the device via RTSP protocol. Enter the URL, username and password of the device and then click

[Test] to test whether the device is connected successfully or not.

Add Encoding Device

Quickly Add Manually Add Initiatively Report Unbound Auto Report Device

URLRTSP://192.168.226.201:554/Profilel RTSP = (10 |||||
IP Address:0.0.0.0 Standard Device 6036 admin sssese
< >
Select Transfer Server Transfer Server v Select Storage Server Storage Server %
Select Area () A3 v [J Automatically Link Area
(o

How to get a URL?

Here we take the IPC of our company for example. Log in to the web client of the IPC and then go to “Config”> “Network”—> “RTSP”
interface to configure RTSP.

The default RTSP port is 554 and the URL format is “rtsp://IP or domain name:port/profilel”. For example:

rtsp://192.168.1.1:554/profilel. Profilelstands for main stream; profile2 stands for sub stream; profile3 stands for the third stream.
For the URL of a device from other companies, please consult their technical documentation.
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5.1.3 Initiatively Report

Select the “Initiatively Report” Tab to see the following interface.

Add Encoding Device X

Quickly Add Manually Add Initiatively Report Unbound Auto Report Device
Device Number Protocol User Name  Password Delete
No. | 4924 Standard Device admin sesees
Select Transfer Server Transfer Server Select Storage Server Storage Server
Select Area () A3 [J Automatically Link Area
o =

(@  Enter the device ID set in the DVR/NVR or IP camera and choose the protocol.
[} If the DVR/NVR is needed to add, please go to Network—>Platform Access interface of the DVR/NVR. Check “Enable”, enter the IP

address and port (default 2009) of the NVMS and then set the device number of the DVR/NVR.
® If the IP camera is needed to add, please go to Network Configuration—>Server Configuration of the IP camera. Check “Enable”,

enter the IP address and port (default 2009) of the NVMS and then set the device number of the IP camera.

Config Home » Network » Advanced
System
. N
Basic Information | Port SNVl Onvif DDNS SNMP  802.1X RTSP  RTMP  UPnP  Email FTP  HTTPS QoS

Date and Time | Local Config

Storage ¥ Enable \

Server Port 2009 |
@ Image 1 IP add .

Server Add 10.214.11.99 — address of Media Transfer Server
Display Settings | Video/Audio | I A e ‘ I

OSD | Video Mask | ROI Config | I Device ID ‘4924 I x

Zoom/Facus Device number

- [ save |
‘B_ Alarm

Motion Detection | Anomaly

Alarm Server

v'{ Event

Object Abandoned/Missing

Video Exception | Line Crossing

| Region Intrusion

‘,g,i Network

Teerp | o

@  Select the transfer server, storage server, area and then click [OK].

5.1.4 Quickly Add Auto Report Device

For the auto report devices, you can go to the “Unbound Auto Report Device” interface to add them quickly.
Note: please fill out the auto report information in the NVR/IPC in advance and then the device information can be searched in the

“Unbound Auto Report Device” interface.
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Add Encoding Device

Quickly Add Manually Add Initiatively Report | Unbound Auto Report Device Device Quantity'l
O 4924 4924 standard |y cfer Server
Device
Select Transfer Server Transfer Server % Select Storage Server Storage Server v
Select Area () A3 Avs [J Automatically Link Area
Default Password “

5.2 Modify or Delete Device

After devices are added successfully, they will be listed as below.

Add, Edit or Delete Device ‘ Device Setting Area Setting Channel Group Setting

Device T)«'PE Select Area Select Transfer Server Select Storage Server Upgrade

Encoding Device (Online/Total number:16/1

Decoder (Online/Total number:0/0)

LED Display Device (Online/Total number:0/ O F/| single ipc Standard D... 1 1 2 192.168.52.244
Intelligent Analysis Server (Online/Total nun —y

The device channel number, alarm status, online status and record status can be viewed from the above table.
Click |_/| to modify the device information.

Click “"l to delete the added device.
Select the desired devices and click [Delete] to delete multiple devices simultaneously.

5.3 Device Area Selection

Select one or more encoding devices and then click [Select Area] to modify the area of the selected devices.

5.4 Batch Import/Export
You can import multiple encoding devices (NVR/IPC) in different local network at a time. The setting steps are as follows:

1. Create an Excel file and then edit the device information as follows. Please copy the text of the first line.

A | B | C | o | E |
ip protocol port userName password
10. 214. 40. 88 6036 standard device  admin 123456
10. 214. 40. 89 6036 =ztandard device  admin 123436
10. 214. 40. 90 6036 =ztandard device  admin 123456

Protocol: four protocols can be used here, including “ipc”, “standard device”, “NVR” and “TVT".

2. Save the file as “.cvs” or “.xIsx”.
3. Click Home—>Resource Management->Add, Edit or Delete Device. Then click [Import] to import the file.
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J Add, Edit or Delete Device Device Setting Area Setting Channel Group Setting

Select Are Import _ @ Select Transfer S

Encoding Device (Online/Total number:8/14 Import

Device Type

Decoder (Online/Total number:0/0) Export Templat

Alarm Host (Online/Total number:0/0) . (port Templat

Export encoding devices: check the device you want to export and then click [Save Form] to export the device list.

5.5 Device Upgrade

In the “Add, Edit or Delete Device” interface, check the devices you want to upgrade and then click [Upgrade]. Select the upgrade type as

needed.

Add, Edit or Delete Device Device Setting Area Setting Channel Group Setting

Delete Select Area Select Transfer Server Select Storage Server Upgrade Save Form

Encoding Device (Online/Total number:8/14 h g for IPC

Device Type

Decoder (Online/Total number:0/0)
Alarm Host (Online/Total number:0/0)

Access Control System (Online/Total numbe

Note: When multiple devices are upgraded simultaneously, the selected devices must be the same series.

5.6 Device Setting

Go to Home->Device Setting interface as shown below. In this interface, the parameters of the device can be set up.

Add, Edit or Delete Device ‘ Device Setting ‘ Area Setting Channel Group Setting

Encoding Device v | 0OSD Setting ‘ Image Setting Stream Setting Privacy Mask Setting ROI Setting Focusing Setting Motion Detection
[ = = s
Search QR !? | . 4 224 0 S0 14 - F6iE2A

i s 2

B (2 A3 (Online/Total number:6/7)
B M 10.214200.75 80

B @ 154nve] g

E- @ IP Camera

E- @ IP Camera

E- @ IP Camera3

- M N12

B R E3 '(i}n ine/lotal numb...

Monitoring Point Name

Show OSD Name Horizontal Position 0 Vertical Position 0

B Show Timestamp Horizontal Position 6350 Vertical Position 0

Apply

Different devices have different menus. Please configure the device according to the corresponding user manual.

5.7 Area Setting

Go to Home—> Area Setting interface as shown below.
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Add, Edit or Delete Device

@ A3

e All Empty Area

14

Device Setting ‘ Area Setting ‘ Channel Group Setting

7

—_

Click [Add] to go to Area adding interface. Enter area name to create parent area. Then click [OK] to save the settings. To create sub area,
click [Add], choose the parent area, enter the area name and click [OK].

Parent Area

Area Name

Create Area

Cancel

'

5.8 Server Settings

5.8.1 Add Media Transfer Server

Media transfer server is in charge of the video signal reception of the front-end devices (like IPC) and transfers the signal to the client to
view or to the storage server to record. The command of viewing the video of the front-end devices sent by the client or storage server is

transferred by the media transfer server to the front-end devices. There is a default transfer server. If you want to add a new transfer server,
please follow the directions as below.

1. Goto Home—>Add, Edit or Delete Device->Media Transfer Server.

J Add, Edit or Delete Device ‘ Device Setting Area Setting

Channel Group Setting

Device Type

Encoding Device (Online/Total number:8/14
Decoder (Online/Total number:0/0)

Alarm Host (Online/Total number:0/0)
Access Control System (Online/Total numbe|
LED Display Device (Online/Total number:0,
Intelligent Analysis Server (Online/Total nun

Storage Server (Online/Total number:1/1)

Media Transfer Server (Online/Total numbel

Access Server (Online/Total number:1/1)
Alarm Server (Online/Total number:1/1)

TV Wall Server (Online/Total number:1/1)

10.214.11.109

6006

No

2. Click [Add] to go to media transfer server addition interface. Users can quickly add or manually add media transfer servers.

3. Select the “Quickly Add” tab and click [Refresh] to quickly search servers in the same local network. Check the desired servers and

click [OK] to save the settings.
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Add Media Transfer Server x
Quickly Add Manualty Add Server Quantlty5

-

'z | 1P Adldress FPort

] 1021440123 5006
| [l 10.214.118.72 G006
10.214.11.109 &006

“ ke

Select the “Manually Add” tab to go to the media transfer server adding interface. Enter the server name, IP address and port and click

[OK] to save the settings.

Add Media Transfer Server x

Quickly Add Manually Add
Server Name 1P Address Part Hot Spare . Delete

Media Transfer Serverl 0000 6006 No

When adding the transfer server, you can select it as a hot spare server.
If there are devices under the transfer server, this server cannot be changed to a hot spare server.
If you have added a hot spare server, it will work as follows.
1. When the transfer server of the device is offline and the offline time exceeds the predefined service fault time, the device will be
transferred by the online hot spare server.
2. When the original transfer server of the device is online again and the online time exceeds the predefined server fault time, the
device will be transferred by the original transfer server.
To set the server fault determination time, please go to Home—> Configuration—> System Configuration interface to set.

5.8.2 Add Storage Server

Storage server is in charge of the storage of record information, including the information of schedule record, record based on motion
alarm, sensor alarm, smart detection alarm (like object removal detection, line crossing detection, etc.), responding to the search and
playback of all storage data. It also supports self-defined storage path settings and IP-SAN access. There is a default storage server. If you
want to add a new storage server, please follow the directions as below.

1.  Click Home—>Add, Edit or Delete Device->Storage Server.

Add, Edit or Delete Device Device Setting Area Setting Channel Group Setting

P
Device Type Add ) Delete

Encoding Device (Online/Total number:8/14 a
Decader (Online/Total number:0/0) [m] Server Name  Device Number ~ Channel Number 1

Alarm Host (Online/Total number:0/0) O Storage Server 14 22 1
Access Control System (Online/Total numbe
LED Display Device (Online/Total number:0

Intelligent Analysis Server (Online/Total nun

IFturage Server (Online/Total number:1/1) I
L o A
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2. Click [Add] to go to storage server adding interface. Users can quickly add or manually add storage servers.

3. Select the “Quickly Add” tab and click [Refresh] to quickly search servers in the same local network. Check the desired servers and
click [OK] to save the settings.

Select the “Manually Add” tab to go to the storage server adding interface. Enter the server name, IP address and port and click [OK] to
save the settings.

When adding the storage server, you can select it as a hot spare server. Once the host server is offline, the spare server will take over.

After the storage server is added, click = to set record partition. In the record partition setting interface, select the disk and click [OK]
to save the settings.

Record Partition Setting

If you have added a hot spare server, it will work as follows.
1. When the storage server of the device is offline and the offline time exceeds the predefined service fault time, the recorded file of the
device will be saved by the online hot spare server.
2. When the original storage server of the device is online again and the online time exceeds the predefined server fault time, the
recorded file of the device will be saved by the original storage server.

To set the server fault determination time, please go to Home—> Configuration-> System Configuration interface to set.

5.9 Channel Group Settings

Go to Home—> Channel Group Setting interface as shown below.

Add, Edit or Delete Device Device Setting Area Setting Channel Group Setting

@ Add Channel Group X

Channel UPp Nal  Channel Group Name | Yoo |

b 28 Group 1 \ Keyboard Number 7
Dwell Time 5Sec

Parent Channel Group 232 Group 1

Selectable Device Selected Device
4 []A3 4 [] A3
[J 10.214.200.75_80_CAMO01 < [J IP Camera
O 154n

IP Camera

[ 1P Camera3

[ N12; >>
0 N12 <4
O N1 .
b
< > < >

Q Select All Reverse Clear All “ | Cancel

@® Click [Add].
@ Enter channel group name, channel group and dwell time.
(® Select the parent channel group.
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@ Add channels to the channel group. Check the desired channels and click > to add channels; choose the selected channel and click

< to remove those channels; Click >> to add all channels; click << to remove all selected channels. You can also enter the
key words to search the channels and then select them.
® Click [OK] to save the settings.
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6 Group Management

6.1 People Management

You can add group for four libraries—Person list, VIP list, Visitor list and Blacklist.
Here taking “Add target to person list” for example

6.1.1 Add Group

®  Add the parent group
Go to Home->Group Management->Group Management—>Person List.

Person List VIP List Visitor List Block List
Add Group X
Q

Delete

E- [@ Default Group Name

— “ Cancel ‘

Right click on the blank of the person list column and then the “Add” button will appear. Click it to add the group name.

Note: The added parent group name and face information under it will be synchronized to the face database of the NVR, but the sub group
name will not be added to the NVR. The face information under the sub group will automatically be added to its parent group in the NVR.
If the parent group fails to synchronize to the face database of the NVR, but the face information of sub group is successfully added to the
NVR. Now, the face group name will be named “creation date-intelligent server IP-creation time (s)-list type-parent group name” as shown
below.

MNo. Group

1 2022 4 21_10.214.200.200_32 (3853)

2 2022 4 22 10.214.200.111_1 (1128)

3 2022 4 22 192.168.52.214 47 White_default'0)

Group Name in NVR

For IPC, the added face information under person list and VIP list will be automatically added to the allow/white list of the IPC. The added
face information under visitor list and block list will be synchronized to the corresponding list.

®  Add the sub group:

Put the cursor on the parent group name and then you will see the follow buttons. Click “+” to add the sub group name. A maximum of 9
sub groups can be created.

Person List

=-| @ Default Group 7 T

Click to bind the camera.

Bind the camera to the group: Add the people images of the group to the face database of the binding camera. When the person whose
picture has transferred to the face database of the binding camera appears in the detection area, the face comparison result will be sent to

the platform.
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Note: the added group or person must be bound with one or more cameras, or the face comparison result will not be gotten by the

platform.
Authorization Binding X

P Ul ) » O i@ VIP
P D@ %4
»
K
£ > £ >

In the people management interface, click “Sync Records” = ”People” or “Device” to view the synchronization status.

PersonalVehicle Management ‘ Sync Records ‘ Task

Person List

Device Name  All W

earch Q 0 xy Device Name... Default Group Failure ( “"

- [ Default Group -
an O Xy IP Camera  Default Group Success ||||

- O Xy N9 Default Group Success ||||
& dsm

- & fa
& N9

6.1.2 Add Target

You can add targets for four libraries-- people, VIP, Visitor and Blacklist.

®  Add target one by one
Select the group name and then click [Add] to add the target information
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Person List VIP List Visitor List Black List Vehicle registration

Person List v
Add Clear All Targets Change Group Failure Record

Search Q

Default Group

Add Target X

Name*: Birthday: 2022-01-07
Gender: Male Country:
gad Province: City:

Work Type: Work ID:
Telephone: Card Number:

<
ID Type: ID Card ID NO:
Remark:

The default is the device bound to the target distribution Group [Default Group]

Click “*  and select the face image saved in the local PC. Then fill out the corresponding information and click [OK] to save.
Note: the resolution of the face image shall be less than 3840*3840.

If the target is added to the group of the VIP, register date and VIP level shall be fill in.

®  Batch Import

In the above interface, click [Export template] to export an Excel template and then fill out the corresponding information in the table as
shown below.

After that, create a file named “Image” and then put the face images under this file.

A B c o E ¥ L5} H ! 3 K L M L] o P

1.The marked red item is required;
2.When entering the phone number and certificate number, please add *; for example, 13500000000 is written as '13500000000;
3.The date format is 2020.01.01;

4.The certifleate number shall not excead 20 digits;

8, Thee VIP level is general, medium and high;
Name Birth Date Gender 10 Type IDNO Country Province City Telephone Remark VIP Level Registration Date Department Type of work Staff Number Picture address
Helen 7070.08.05 Femala  IDCard 123 China  Sichuan  Chengdu 13500000000 High 1070-08-05 T anginesr T o Helan jog
David  2020-08-05 Male 1D Card 12 China Sichuan Chengdu T 13500000000 High 2020-08-05 L2 engineer 12222 David. jog.

Put the image file and the personal information file into the same directory.

Click [Import] =[Excel Import]

Person List VIP List Visitor List Black List Vehicle List

Clear All Targets Failure Record Export Template

Select Curren

Q

+ = . OO
Default Group Reversely Select oo

Batch Import

File Import

I =3 -4 iR 13

Click [Import] and then select “Batch import” to import face pictures in bulk, but the target information must be modified manually.
Click [Import] and then select “File import”. You can select whether to search the sub folder.

Search Subfolders: choose a folder including multiple subfolders and then all pictures in the folder and its subfolders will be imported.

Not Search Subfolders: the pictures in the folder will be imported, but the pictures in the subfolders will not be imported.

»  Convert images to an Excel

Multiple images also can be converted to an Excel. Then click “Import EXCEL” to add targets. The setting steps are as follows.
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1. Name the face images (like David_Male_1989-01-03_Engineer_Groupl), separating each field with “_".

2. Clicking on é displays an image conversion box. Click IEI to select the desired images.

3. Click @ respectively to set the image naming rules and content of the header.

Image conversion tool X

Image list | |
Image naming rules | | A
Content of the header | | @]

*(aonerate Fyrel tor imnort Cancel

Note:
1. The naming sequence of each image selected must be the same. Please select the image naming rules in accordance with the

sequential order of the name of the image.
The content of the header must contain those items of the image name and can be selected in any order.
3. The content of the header must contain name and group (face database), which can be entered in the image name in advance and also

can be edited in the exported Excel.

®  Modify or Delete Target

Name: J Birthday: 02-01
Gender:  Female Work type:
Worlc ID: Telephone:
: ID Type: 1D Card ID NO: Modify Delete
O Group: Default Group @ @ &

Click = to bind the camera. After you bind the camera, the face image will be added to the face database of the camera.
Click = to view the target list as shown below.
B =

(]} |‘_/‘ Xy 2022-01-07 Female 1D Card Default Gro...

O |._/‘ Dm 2022-01-07 Female 1D Card Default Gro...

O |._/‘ N9 2022-01-07 Female 1D Card Default Gro...

O |._/‘ fa 2022-01-07 Female 1D Card Default Gro...

O |._/‘ dsm 2022-01-07 Female 1D Card Default Gro...

O |._/‘ 22 2022-01-07 Male 1D Card Default Gro...

O |._/‘ 2 2022-01-07 Female 1D Card Default Gro...

Click “Custom” to customize the target display information.

Click “Change group” to change the group.
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6.2 Vehicle Management
6.2.1 Add Vehicles

Select the desired vehicle list (allow list or block list) and then click [Add] to add the relevant vehicle information.

Add new vehicle X

Basic Setup

Number plate* l l

Name

Phone

Vehicle Type Small Car L4
Vehicle Color Blue v
Description

6.2.2 View, Modify or Delete Vehicles

After you add the vehicle, you can view, modify or delete the vehicle information as needed.

Vet regstaton Modify  Delete

& Allow List

- Block List

O A123464 Simon Small Car Blue /‘|||||

Select multiple vehicles and then click the [Delete] button to delete multiple vehicle information at once.

6.2.3 Import or Export Vehicles

Click [Export Template]>Export Template(.xIsx/.csv) to export a template. Then fill out the relevant vehicle information.

Export Template{x

Export Templat

After that, click [File import] to import the vehicle information. Click [Export] to export the added vehicle information.

6.3 Sync Records

Click Home->Group Management->Sync Records to go to the following interface.

You can view the sync records or bind the camera to the group or people.

»  Binding the group to the device

Put the cursor on the group name and then E‘] will be shown. Click it to bind the camera.
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o e - | - e =
: ;2 A [ default area A [ default area
L & +

& om ! 2Lt ¢ [} Device NomeB8
& dem
ih | L IP Camera
& N9 | O ne
&

|

& »
i <«
< » 0 ¥
[ Q m “ Cancel

»  Binding the person to the device

Select the person’s name and then click “Synchronize to”. This will bring a window as follow. Select the camera and then click “OK”.
This personal information will be synchronized to the selected camera.

I | I | I
Person List .
_ Person Permissions X

Search Q
" _- _-
-----
a2 4 [ default area 5 4 [ default area
& Dm
2 dsm O'P Cameraiill < [J Device Name88
&fa O 1P Camera
a N9 o
..... = xy
4 »
< , » < >

VIP List

Visitor List

Block List

»  Binding the device to the group or person

Click the “Device” tag, select the device and then click “Synchronize to”. Select the group or person in the pop-up window.
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e T o IEEE =S People name | Al

Device List Authorization Binding x|
Q
B @ default area a0 >0
Device NameB8 Om Y O
M [P Camera O @ Block <
= P Camera I
& Na [ @ Empioyes
P O vk
> O ol
>
4
«
< 3 < >
/' o I o

When the device is offline, the target synchronized to it cannot be deleted. Then you can go to the Sync Records interface to delete the
synchronization records and then delete the target.

6.4 Task Management

Set the face capture source, schedule and applicable scenario.

Peopte and Vehicle Management  Sync Records. | Task

Schedule Template

(9]
H- (2 default area (Oniine/Total num._. | 8 Fac
- oL Vehicie deployment contral w7 Face Capture by IPC 24
B PC

Face Capture by IPC: it is applicable to the face detection camera.
Face Match by IPC: it is applicable to the face recognition camera.

Note: Face recognition NVR, Temperature Reading Panel, Thermal network camera and IPC without face detection function cannot set
task here.

More parameters about face comparison can be set by clicking [Setup].
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Face Comparison Alarm
[J Block List [J Stranger [J Visitor (J VIP [J Allow List

e o

Similarity

Similarity(%) 75
Croen | o

Intelligent Server Setting
Intelligent Server

Enable Face Detection of the Face Recognition IPC
o

Send Captured Pictures to FTP
[J Enable FTP

FTP Server Address
FTP Server Port 21

FTP File Path  /

Anonymous

Croren | o

Face Comparison Alarm: Select face comparison alarm list. For example, “Visitor” is selected, when a person is detected and is

successfully compared with visitor list, alarms will be triggered.
Similarity: Set the similarity of the face comparison.

Intelligent Server Setting: please check “Enable face detection of the face recognition IPC” as needed.

If checked, the intelligent server will get all face capture pictures of the IPC after you configure face comparison parameters and set the
schedule for the IPC. All these face snapshots can be searched in the Search interface (Home—> Search).

If unchecked, the intelligent server will only get the matched face snapshots after you configure face comparison parameters and set the
schedule for the IPC. Only the face snapshots successfully matched with the face database can be searched in the Search interface
(Home-> Search).

FTP Settings: Send the captured pictures to FTP. Please set the corresponding parameters according to your FTP server.

34



7 Search
7.1 Image Search by Face

(@ Select a picture and picture source.

(@ Set the start time and the end time.

(® Set the maximum count and similarity.
@ Click [Search].

| Image Search by Face Face comparison retrieval License plate matching retrieval Smart Snapshot Retrieval Visitor Record

Face Recognition NVR B

Search Q

Faa -——
2~ E [ default area

- I Device Name88

‘ Track List View | Track Map Display

M & NS a 1 2022-01-07 00:23:54 N9_ 42%
O 2 2022-01-07 00:24:01 N 36%
a 2 2022-01-07 06:01:59 N9 51%

SelectImage

m] 4 2022-01-07 06:02:04 N9 39%
0 5 2022-01-07 06:46:00 Ng 2%
0 6 2022-01-07 06:46:00 N9 26%
tart Time 2022-01-07 00:00:00 E
nd Time 2022-01-07 23:59:59 ‘%{
= o 7 2022-01-07 08:01:22 N9 5%

©@ ©®© © ® @ ©® ©

Max. Number 100

imilarity(%s) === 16

<
Select All Clear All Playback Selection
=

Click ® to play the record in a small window.

| Irack Map Lisplay
e
3 2022:01-07 00:24:01 ®
3 20220107 06:01:50 ®
4 20220107 06:02:04 ®
5 2022-01-07 D6ABD0 O]
6 2022-01-07 06:46:00 ®
7 2022:01-07 08:01:22 ®

000006/ 000015 El E m E

8 2022-01-07 08:01:25 NE 35% ‘

®  E-Map Track View:
Create an E-map. You can create or delete an E-map in this interface. The hot spot can be added to the E-map too.
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Create Map

Map Name

Parent Map & 123

Map Type  © Google Map O Picture Map

Search

Menitoring Point

Sensor

& A

- Play Track Line Playback by Tracks @

Play Track Line: Click this button to play the track line on a map.
Playback by Tracks: Click this button to play the track video.

7.2 Face Comparison Search

(D Go to Search =>Face comparison retrieval interface.
@ Select the IPC and match type

(® Set the start and end time and then click [Search] to search the face pictures.

Image Search by Face Face comparison retrleval License plate matching retrieval Smart Snapshot Retrieval Visitor Record

m Exporn Curfage

[ 2 cdefault wea (Oniine/Total me_ |~ ]
o 10214200111 80 CAMOOL
W Device NameBs _|# Camer.. :
m Device Names!
s Dovice NameEE -
B Device Namegg Channel Namaz NS Channel N.}m_c. LR Channe! Name: NS Channe! Name: N9
- Time: 01-07 17:2453 Time: 01-07 17:24:43 Time: 01-07 17:2482 Time: 01-07
e Device Nameg Target Natme Targget Marme: Target Name: Target Name:
W Device Namedt Lits Name: Lib Mame: Lits Name: Lty Name:
TP Camndta Temperature: - Temperalure: - Temperature; - Temperature: - Temperature: -
e Mask Status: Mk Status: Mtk Status: - Mask Status: Muask Status
T 10 NGz - 1080 - 10 NO: - 10 e - 1D MOz -
B P Camera Work I - Work i - Work 11 - Wark 10; - Worlk 11 -
- 1P Camera Remark: Remark: Remark: Remarkc Remark:
™ P Camerad J e
e e
- i
[
o No_Pame
Channel Name: N2, Channel Name: NE Channel Name: N Channel Nama: NS
- NG = Time: 01-07 17:24:15 Time: 01-07 17:23:23 Time 01-07 17:2215 Time: 01-07 17:21:55
i Target Nare Target Narm: Target Name: : Target Name:
Lity Name: Lib Name: Lty Name: Lib E Lib Name:
= Termperatine: - Temperature - Temperaturé: - Temperature: - Temperatue: -
Madk Status: Mask Status Mk Status: Mask Status: Mask Status:
MatchType  All Types 10 N = 1D NO: - 10 N = 10 NG = I0:NCE =
Wk 10 - Work 10 - Work 10 - Work If): - Wk I -
Start. Time Remark: Remark Remark: Remarkc Remark: «
End Time 2201

7.3 License Plate Comparison Search

1. Select the camera.
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2. Enter the license plate and select the match type.
3. Set the start time and end time.
4. Click [Search]

Image Search by Face Face Comparison Retrieval License Plate Comparison Retrieval Smart Snapshot Retrieval Visitor Record
Monitoring Foint ~ = e s | 5 S T
Channel L/ Camera/TP Camera/IP Cameral? Time Perlod L) - 022-01-112 Export Curffage
o Frone: wone: PO rnone: Lgini A ~
@ B () default area (Oniine/Total n Vehicle Type: Vehicie Type: Vehicle Type: Vehicle Type: Vehicle Type:

License Plate Color: Blue License Plato Color: Blue License Plate Color: Blue License Plate Colar: Blue License Plate Color; Blue

Channe! Name: 1 Channel Name: [P Camera

Time: 20220131 14:39:32 0220511 15:35:32 Time: 2022-03.11 19:39:32

licansa plate 1888 licenss piate  00ERE licensa plate.  BE8EH
MName: Name: MName

Phone: Phone: Phore:

Vel Type: Vehicle Type:

¢ Plate Color: Blue License Plate Color: Blue

Charinel Name: 1
Timie: 11 1%:3%30
29999

Channel Name:

Time: 2022-00-11 {srsitey
license plate JEN0N09
Mame

Icense plate

Match Type Al

Fhona: Fhone: Fhone:
- Vehicle Type: Wehicle Types Vehicle Type: Vehicle Type: Vehicle Type:
St License Plate Color: Blue License Plate Cofor: Blue License Plate Color: Blue License Plate Color: Blug License Flate Color: Biue

End Time

7.4 Smart Snapshot Search

The snapshot results from the intelligent server and face recognition devices can be searched. You can search the snapshots of human face,
human body, motor vehicle and non-motor vehicle.

Monitoring Point v

al

£ 133 {Online/Total number0/0)
O @ defsull area (Online/Tolal num...
W Uevice Name88_IP Camneratest
W Uevice Name8S |
W Device NemeB8 |
W Device NameBB [

B Device NameB8 | B
W Device NameB8 [ 49
" N9 L
g
> NI L

Match Type Human face

Search Source Face Recognition |

Start Time: 2022-01-07

End Time 2022-01-07 23:565:59

oo cunes

If the snapshot type is human face, put the cursor on the captured picture and then some shortcut buttons will be displayed.
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Click + to add the capture picture to the library. Select the library on the left and then fill out the information of this target. Click [OK] to
add.

Put the cursor on the captured picture and then click __ to quickly search images by this picture.
Put the cursor on the captured picture and then click L& to quickly download the captured picture.

Human Body/Vehicle Snapshots:

Monitoring Point LV
Q

B 8 @ 123 (Online/Total number2/2)
=- 8 @ default area (Ondine/Tetal n..

Criginal Image

2022-01-07 18:2%43

1P Camy IP Camera &8

Channel Name: 1P Camera

Taeget Type: Human

Capture Thme: 2022-01-07 18:26:58

F022:01-0 3
1P Carera ®8

1P Cami

Pisyback ()

=
Match Type  Human
= 2022-01-07 18:24:18 2022-01-07 18:24:10 20220107 182410 2022-01-07 18:24:00 2022-01-07 182347 2022-01-07 18:23:46 2022-01-07 18:23:45
S Time P)22-00-07 D000 - 5 IP Camera ® B8 1P carmera @ B8 IFamea @B P Camera © B P Camera ® B IP Camera ® B IF camnera [CR=]

End Time 2022-01-07 235959 -

Click @

Click El to view the snapshot details, including the original image, target picture, snapshot type, snapshot time and so on.

to quickly skip to the playback interface and play the record.

7.5 Visitor Record Search

Set the start and end time and click [Search] to search the visitor record in the specified time.

You can also enter the key word in the search bar and click Q to search the visitor record.

Click [Export] to export the current visit record to EXCEL file (image included). Only super administrator supports visitor record export.
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8 Face Greeting

Face Greeting: After successful face comparison, the words/voice of welcome will be heard by the guests and their photos will be shown
on the screen.

Click “Face Greeting” to go to the face greeting interface. The setting steps are as follows:

@ Create a VIP group and add targets for this group in the VIP list interface. Then bind the VIP person and the camera. The setting
details are similar to adding targets to the person list. See chapter 6 for details.

Note: the camera for face greeting must support face recognition function, such as face recognition and access control panel, face
recognition camera and so on.

@  Select the schedule, face match type in the Task interface of the people & vehicle management (See 6.4 for details).

(®  Set camera deployment. Drag the camera name to the preview window. When there are targets detected, the match result will be

displayed on the right panel.

3 () default area (Online/Total n.
1 (Online/Total number:...
B Device Name_IP Camera..
W Device Name_IP Camera.
B Device Name_IPO1
B Device Name [PC

B [P CameraQ7
W [P Camera
W [PC

W [PC

@  View the match result of the greeting screen. Click the “Display Setting” tab to set the sub screen (greeting screen).
In this interface, greeting screen background style, screen display mode, VIP box style, face greeting language and so on can be set up.
Select the sub-screen display channel: double clicking on the sub-screen box as shown below displays a camera selection box. Choose the

desired cameras and then click [OK] to save the settings. Multiple cameras can be selected at a time.
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Camera Deployment VIP Search Display Setting

Face Welcome Sub Screen Settings:

Greeting Screen Background Style y;4aq Screen Display Mode 1

VIP Box Style \wjith borders

Welcome Broadcast or Not

Welcome Voice Play Order yyeicome voice + Guest name
Greeting Language ye|come
Birthday Greetings \we|come
Max. Number of VIP Box (1-5) 3
Frame Holding Time(s) 5

Loop Playback

Single VIP Cycle Time(s) 5,

Single VIP Box Size (ranges from 10% to
99%)

Apply

Link Camera to Sub-screen

No secondary screen detected!

Greeting Screen Background Style: three options: Video, Background Picture and Pure Color Background
Screen Display Mode: 1/4/9/16 screen display mode can be selected.

VIP Box Style: with borders or pure image.

Welcome Broadcast or Not: if enabled, the welcome voice will be broadcasted when the VIP person is successfully recognized.
Welcome Voice Play Order: choose which one to broadcast first between welcome voice and guest name
Greeting Language: please enter the content as needed.

Max. Number of VIP Box: up to 5 boxes.

Frame Holding time: set the duration time of VIP box appearing after the captured face is matched successfully.
Loop Playback: if enabled, the VIP name will be broadcasted in a loop.

Single VIP Cycle Time: set the time of the single VVIP name broadcasted.

Single VIP Box Size: set the percentage of VIP box size occupying the entire screen.

202201710 1A: 302 1K

Close the Sub-screen *

Close Channel
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User Manual

®  Search the face greeting records. Click “VIP Search” tab as shown below.

Start Time 021-02-02 00:00:00 End Time 202 )2 2 5 Search
o [_searcn

& VIP Group
4 . NO Name Gender VIP Level Regdate Telephone Time Monitoring Point Temperature Mask Status Picture Play|

1 4 Female General 2021-02-02 2021-02-02 15:29:44 1PC 36.6°C Mask On E
2 4 Female General 2021-02-02 2021-02-02 15:29:43 1PC Mask On E
4 Female General 2021-02-02 2021-02-02 15:29:16 1PC Mask On =

You can enter the key word to search the target or manually select the target from the library. Then set the start time and the end time and

click “Search” to search the record. The detailed information of this target will be shown. Click to play the record.
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9 Face Attendance

The attendance records of the employees can be viewed and traced after adding the persons to the person list and setting the attendance
rules.

Flow Chart:

1. Add attendance groups and targets—>2. Set the attendance device and configure the device information—>3. Set attendance rules
(attendance period setting, attendance shift setting, holiday setting, personnel scheduling setting, attendance handling) 4. Search

attendance records and export attendance report

9.1.1 AddAttendance Group and Targets

1.  Create an attendance group and add targets for this group in the person list interface. Then bind the person and the attendance camera.
See chapter 6 for details.

Note: the attendance camera must support face recognition function, such as face recognition and access control panel, face recognition
camera and so on.

2. Configure the schedule and face match way of the camera. See 6.4 Task Management for details.

3. Camera Deployment. Go to Face Attendance—>Camera Deployment interface. Face comparison information can be viewed after the
camera is dragged to the preview window.

Note: The compared person in attendance system shall be added in the person list in advance. One person only can be added in one group.

If this person also be added in other groups (like VIP list), the comparison result will not be obtained.

(1]Ea1(E]{e] 8] sueseam &l

View the match result of the sub-screen:

(@  Click Face Attendance->Working Day Setting=>Basic Configuration.
(@ Double clicking on the box displays a camera selection box. Select the desired camera and then click [OK] to save the setting.
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Link Camera to Sub-screen

Select compare channels X

Selectable Device Selected Device
Screen 1
A default area A default area
10.214.55.151 80 ... > IS

Device Name465...
Device Name465...

Device Name465...
Double click the following boxes to add or modify cameras. Aff

Note: After the secondary screen is detected, the configuration Device Name465...
HKIPC75_ >>
IP Camera <<
IP Camera

“ Cance'

(® Click Face Attendance->Camera Deployment. In the camera deployment interface, right click on the screen to select “Project onto”
to select sub screen. Then you will see the face display on the sub screen as shown on the below.

Close the Sub-screen |

Close Channel

9.1.2 Set Attendance Rules

Go to the Attendance Configuration interface to set different attendance rules. The system will compare the pre-defined attendance time
and the actual attendance time and then trigger alarms when an exception attendance event occurs. The attendance rule settings include
basic configuration, attendance period setting, attendance shift, personnel scheduling and attendance handling.

1. Attendance Period Settings
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Camera Deployment Attendance Configuration Attendance Record Statistics

&) Perind Edit Delata

Attendance Handling

If a company has different working time for different employees, you can add different attendance rules.

Click [Add] to set the detailed attendance rule. After that, click [Save] to save the settings.

Basic Setup: set the normal working period.

Start-work time: the normal start-work time

End-work time: the normal end-work time

Valid check-in: Set the valid check-in period. If the employees check in before/after this period, the check-in will be invalid and will be
regarded as “Not check-in”.

Work hours: automatically calculate according to the start-work and end-work time.

Clicking on @ displays another timetable. You can set the detailed rules for work time.

Time setup:

Start-work time: | 09:00 Valid check-in: | 07:30 -1 09:30 Must check in

End-work time: | 12:00 Valid check-out: | 11:59 -1 13:01 (3 Must check out

Work hours: hours /

Start-work time: | 09:00 Valid check-in: | 07:30 - 10:30 [ Must check in
End-work time: | 18:00 Valid check-out:  16:30 -|19:30 Must check out @
Work hours: hours

Must check-in/out: “Must check in” next to the first valid check-in period and “Must check out” next to the last valid check-out period are
checked by default. That is to say, in the first check-in period, the employees must check in; in the last check-out period, the employees
must check out. During the period that “Must check in/out” is not checked, the employees don’t check in/out, who will not be regarded
as “Not check infout” or “Absent”.

Valid Check-in/out: If the employees don’t check in/out during the valid check in/out period, they will be regarded as “Not check-in/out”.

Allow Late/Leave Early:
Over xx min is late: set the allowable minutes for late. If the employees check in within the period after the start-work time, the status will

be “Normal”.
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Advance xx min is leave early: set the allowable minutes for leave early. If the employees check out within the period before the

end-work time, the status will be “Normal”.

For example: The start-work time is set as 09:00, and the late allowable duration is 20 minutes. If the employee checks in at 9:15, the
attendance status will be “Normal”.

Absent:

Late over xx min is absent: if the employees checking in later than this time will be marked as “Absent”. For example: The start-work
time is set as 09:00, and the absent allowable duration is 40 minutes. If the employee checks in at 9:45, the attendance status will be
“absent”.

Leave early over xx min is absent: if the employees checking out earlier than this time will be marked as “Absent”. For example: The
end-work time is set as 18:00, and the absent allowable duration is 40 minutes. If the employee checks out at 17:19, the attendance status

will be “absent”.

Overtime setup: there are three overtime levels. Please set as needed.
Dinner time: if checked, the system will automatically deduct the dinner time from the overtime. The overtime level depends on the time

duration after deducting the dinner time.

2. Holiday Settings

You can set a special day as a holiday. The holiday here takes priority over the attendance shift. That is to say, once a day is set as a
holiday, there is no need for you to check in even if it is scheduled in the working day.

Camera Deployment Attendance Configuration Attendance Record Statistics
Basic Configuration
Attendance Period

Holiday Settings ) Name Holiday time  Holiday days
Attendance Shift

Add Holiday

Personnel Scheduling

Attendance Handling
Holiday name Holiday

Holiday days 1 | C ‘

Start date 2022-01-11 @

“‘ Cancel \

3. Attendance Shift Settings

Attendance Shift: The employees shall perform their duties according to the shift schedule.

Click [Add] to set the shift name and shift schedule.

Shift cycle can be set by day, week or month. The schedule will automatically repeat according to the set day(s), week(s) or month(s).
Day: You can customize the attendance period of each day. The number of days should be between 1 and 31.

Week: The schedule will repeat every 7/14/21/28/35 days based on the week.

Month: You can customize the attendance period of each month.
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Camera Deployment Attendance Configuration ‘ Attendance Record Statistics

Basic Configuration

Shift

Attendance Period @ Search Q Shift Name: Default Shift

Holiday Settings
Attendance Shift

Shift Cycle: 1 v day W

Personnel Scheduling
Attendance Handling i ___I‘

1 day 1 Rest

s

After you set the shift schedule, click [Save] to save the settings.

4. Personnel Scheduling

You can set different schedule for different attendance groups or employees.

Camera Deployment Attendance Configuration Attendance Record Statistics

Basic Configuration
Attendance Period
Holiday Settings

Attendance Shift

Personnel Scheduling

Attendance Handling

Staff List
@ Delete the Scheduling Temporary Scheduling Clear Temporary Scheduling
Q

Search

- @@ Default Group £ 2022 ~ Year 1 v Mon

Jarget Scheduling

4 Shift Day % €8
Start Time 2022-01-11
2 End Time 2023-01-11 5 i
[ o |
q 10 '1‘\ 12 12

Select the attendance group or employee and then click [Scheduling] to select the shift and schedule start time and end time. Finally, click

[OK] to save the settings.
If the schedule for the attendance group or the employee needs to modify, select the group or person, click [Delete the scheduling] to delete

the current schedule.
If there is something wrong with the attendance shift, you can select the person or group on the left and click [Scheduling] to modify.

When the temporary scheduling is needed, select the person or group, click [Temporary Scheduling], select date and period. After that,

click [OK] to save the settings.
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Manual

Staff List »
Clear Temporary Scheduling
Search Q
[ Block 2022 v | Year 1 “ Month

B @ Default Group

& Dm LK< 2022Vear 1Month >»

& dsm . 28 29 30
s Sun Mon Tue Wed Thu Fri Sat
3
& N9 1
&
..... B Employee 2 3 4 5 6 7 8 4 3 6

16 17 . 19 20 21 22
1 12 13

23 24 25 26 27 28 29

= L Temporary Scheduling Temporary Scheduling

18 19 20

Period 9:00-18:00 %

(o] 2 2 y

If you want to modify the temporary scheduling, you can select the person or group and click _ to modify. Click

[Delete] to delete the temporary scheduling of the day.

- [@@ Block < 0 £a v  Moni
- . Modify temporary scheduling X

- & Dm K« <L 2022Year 1Month > »
- £\ daw 26 27 30
2t Sun Mon Tue Wed Thu Fri Sat
AN 1
“o & xy
@@ Employee 3 2 3 4 5 6 7 8 6
. 10 11 12 13 14 15
| 16 17 18 19 20 21 22
10 13
Holies® 23 24 25 26 27 28 29
emporary SchedAk/ 30 3
16 17 20
Rest Period 9:00-18:00 W
Ract

Select the temporary scheduling day and click [Clear Temporary Scheduling] to clear the temporary scheduling.

5. Attendance Handling

If someone needs to apply for leave or correct the check-in/out record, you can enter the attendance handling interface to set up.
Leave/Business-Trip Settings:

Select the employee who want to apply for leave or do business trip.

Click [Leave/Business-trip].

Select the date the employee wants to apply for leave or do business trip.

Select the type, sub type, leave time and remark.

Click [OK] to save the settings.

@ e e 6
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E - click it to set the sub type of leave or business trip.

Basic Configuration Staff List 3 " ;
eave/Business-trip
Attendance Period Q -.-’
ey ST - [@ Block < 2022 Year 1 Mont
Attendance Shift B F-_ Default Group
22
Personnel Scheduling H Sun Mon Tue Wed
b & Dm
Attendance Handling L. & dsm
- & fa
h a N9
&y
@ Employee 2 3 4 5 6
9 10 11 12 13
16 17 '18 19 20

Cancel Leave/Business-Trip:

When the leave or business-trip cancels, you can go to the attendance handling interface to cancel it.
1. Select the person you want to cancel the leave/business-trip and then a timetable will display.
2. Clicking on the Leave/business trip tag will display a Leave/business-trip detail box.

3. Move the slide bar to the right as shown below. Click W't cancel this item.
Leave/Business-trip detail X
Leave type operator Remark Edit Delete

Sick leave admin C/J

In addition, you can also correct check-in/out time for the exceptional records according to actual needs.

Correct Check in/out: If the employee actually starts and ends his/her work in the given time but he or she forgets to check in/out, then
“Correct Check in/out” function can be used.

Select the person you want to correct the check in/out record, find the desired date and then click [Correct Check in/out]. After that, click
the Edit button to correct the check in or out as needed.

| |

You can view the correction information by clicking =

9.1.3 Search Attendance Record

You can search the desired attendance records to view the employee’s attendance status by filtering the conditions, such as attendance
group, name, etc.

1. Click Home->Face Attendance-> Attendance Record to go to the following interface.
2. Set the search conditions, such as time, group, name, attendance status (abnormal, overtime, business-trip, etc.).

3. Click [Search] to filter the attendance records.
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Camera Deployment Workng Day Setting | Atlendance Record | Stathtics.
Time 20220101 1 2022-01-12 —% Group. W 1 v | Name 3 m

Attendance Detall Abnormal Overtime: Busknessrip Leave Paid Leave Detait No Chedk-In/fQut Record 5

2023-01-05 1 3 At Mo Check-in/Out Record e Check-in/Out Record 200 00

S, 2022-01-06 1 3 Abrgent o Check-in/Out Recond - No Check-in/Out Record 00 000
| 2022-01-07 1 3 Absent Mo Check-In/Dut Record Mo Check-In/Out Record 200 000

| 2022-01-08 2 3 Absent No Check-In/Out Record | No Check-InfOut Record 9,00 0oo

| 2022-01-09 1 3 Absent No Check-In/Out Record - No Check-InfOut fecord 2.00 000

2022-0-10 1 ] Abssent Mo Cheek-In/Out Record 163418 .00 00e

i 2022-01-11 1 3 Absent No Check-in/Out Racord - N Chack-In/Out Record .00 000

The attendance detail of each day, abnormal status, overtime and so on can be displayed.
Click [Custom export] to export an Excel of the attendance result. These exporting items can be customized as needed.

Custom Export X

Path E3)
Format Mlsx W
ltems Select All Reverse Clear All
8 Time 8 Group
B Work ID B Name
B Attend Status B Time of Entry
B Time of Exit B Standard(hour)
M Practical(hour) B Come to Work Late(frequency/hour)

B Leave Early(frequency/hour) B Absent(frequency/hour)
B Business-trip{frequency/hour) B Leave(frequency/hour)

B Paid Leave(frequency/hour) B Overtime(frequency/hour)
B Overtime Level

9.1.4 Statistics of Attendance Data

In the statistics interface of Face Attendance, you can view the attendance data in the form of chart.
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Camera Deployment Working Day Setting Anendance Recond Statistics
Gloup W A Granularity| Geoup Week l| Morth | Year Thme 20220101 P 20220112 1o m Expont
— Late Leave Early r— Absent —— Overtime L Leave
= N = —
i
| == Late Leave Early == Absent Overtime == Leave
|
12l
ol el P T e e e s
1 4 [3 7 [ 9 10 1 1 4 8 9 ] 22 3 75 Z ] 1
e T oo vt | tmo | esvecory [N e
et Rk J— o :
1 1 22200 13
1000

Granularity: Group or human can be selected. If Group is selected, the attendance data of each group (department) can be viewed.
If Human is selected, the attendance data of the employees in the group (department) can be viewed.
You can quickly view the attendance data by week/month/year and also can view the attendance data in a specified period.
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10 Live View

10.1 Live View

Go to Home—>Video Preview interface as shown below.

U]

J Original Size

v Full Screen
Close Channel

Start Record

Instant Playback

Audio On

Snapshot

PTZ Control

Start Talkback

Start Channel Talkback
« Main Stream

Sub Stream

Channel Info

Full Screen

(2] C=] o] 8] 5] 5 [ [E) () () (@) [ (=)

The descriptions of the live view buttons are as follows.

1] 05D Calf- ve S
4 @ |25| Igg,l }‘1 |0N| |C]))| Self-adaptive Stream
\[o} Description \[o} Description
1 Screen display mode 6 Show the smart event detection area
2 Full screen 7 Show/hide target tracking box
3 Enable/disable OSD 8 Close all preview
4 Enable/disable broadcast 9 Save the current view mode
5 Manual alarm output 10 Choose the camera stream

Channel stream: main stream, sub stream, third stream and self-adaptive stream can be optional. When the third stream is selected, the
system will automatically switch to sub stream if the channel/camera doesn’t support the third stream.

Toolbar on the display window:
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Button

Button

Description

Description

Monitoring point setting (camera setting)

Close image @ 3D zoom in

@ Start/stop recording Zoom in

m Enable/disable audio @ Zoom out

Snapshot E Fit to window

E PTZ control Enable/disable talkback

Right-click button function:

Menu Description Menu Description
Close . .
Channel Close image Snapshot Capture images
Start Record | Start/stop recordin Start Enable/disable talkback
> ¢ Talkback
Instant N . . Channel Display channel name, IP address and the
Playback Click it to play back immediately Info. current stream
Audio ON Enable/disable audio Stream Choose video stream
PTZ Control | Click it to show PTZ control panel Full Screen | Display image in full screen

4:3/16:9/Original Size/Full Screen: screen display proportion; please select it as needed.

Note: the platform only can enable audio of one window. If the audio is enabled in one window, the audio in previous window will be

disabled.

Monitoring Point Viewing

® Start View

To start live view, please drag cameras from the list to the right display window or select a window and then double click the camera.

The image can be dragged to any window at random.

Monitoring Point v

= (@ 123 (Online/Total number:2/2)

- P
- .
-~ (@) defauw

| B Device Name88 I "'neratestl T

Q

utal num...

- M Device Name8!

~ WM Device Name8:

- MM Device Name88
Device Name!

- M Device Name

- @ IP Camera

- M IP Camera

® Stop View

@  Place the cursor on the live view window to display the menu toolbar and then click to stop viewing.

@ Right click on the live view window and then select “Close Channel” to stop viewing.
® Click on the toolbar of the live view interface to stop all live view.
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10.2 Smart View

In the live view interface, click H on the right of the interface. A menu bar will be shown on the interface as shown below. Then you can

switch the preview mode between video preview and smart viewing mode.

Note: ® it is a smart mode icon but not a functional button. You must click the smart display button under it to show the
corresponding results.

©

a
|

B

n

TryRERRREY

DEDEEEEDORERECEE] &

The descriptions of the button on the right:

Button ‘ Description Button Description
[ » [ Preview only mode @ Smart mode icon
Smart Snapshot: real-time display of snapshots, ) . .
—a . . . = Face Comparison: Real-time display of face
[€] |including face, human body, motor vehicle, [@- _
L -0 comparison results

non-motor vehicle and vehicle plate.

r—_n Plate Comparison: Real-time display of license |
ﬁ.ﬂ . | Full Screen under smart mode
— plate comparison results

Before using intelligent functions, please confirm the default intelligent analysis server is online.
Go to Home->Resource Management->Intelligent Analysis Server. There is a default intelligent analysis server. Please make sure the

server is online.

Add, Edit or Delete Device Device Setting Area Setting Channel Group Setting

Device Type Server Name IP Address Port Client Connection Status Authentication Server Connection Sta... Edit

Intelligent Analysis Server 10.21411.109 6069 Online r/‘

Encoding Device (Online/Total number:13/.

Decoder (Online/Total number:0/0)

Alarm Host (Online/Total number:0/0)
Access Control System (Online/Total numbe|
LED Display Device (Online/Total number:0,

Intelligent Analysis Server (Cnline/Total nul
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If it is the first use of face comparison function, please configure it in the following order.
Create a group -2 Add targets to the group = Set task 2 Real-time View = Search faces

10.2.1 Face Comparison

1. Create a group, add targets to the group and set Task. Please refer to chapter 6 Group Management for details.
Note: Please remember binding the target with a camera after it is added to a group.

2. For the added NVR with face recognition function please set the face comparison parameters by entering Resource
Management-> Device Setting interface. Refer to the following interface.

Add, Edit or Delete Device Device Setting Area Selting Chanmel Group Setting

Encoding Device (v Q5D Setting Image Sexting Stream Setting Motion Detection Mation Alarm Linkage Exception Detection Face Comparison Face Detection Preset Setting

Q
B Successful Recognition Schedule  24x7 - B Stranger Schedule  24x7
8- @) 123 (OnlinefTotal number2/2) i O u g sc >
O (@ default area (Online/Total fum...
@ M 1021420011180
@- # Device Narmeds B 2021.4.7.1921685. 75
B M IP Camera
B @ IP Camera B 0603111803 52151 15
E- & 1P Camera
20217 2610141, 75

B 8 [P Camerad | o 3
- @ IP Cameras B 202184102420 75
- 8 T
. B 2020851020460, 75
o PN -] 0816202217 52151 75
= M R o
£ N B 2021827102142 75

L B

=3

L

Please select “Successful Recognition” or “Stranger” as needed and then set the schedule separately. After that, check the group and set the
similarity. Finally, save the settings by clicking [Apply].
If the face comparison settings cannot be set according to the above-mentioned way, you can log in the web client of the NVR and then

configure face recognition to realize the auto report of the face match result as shown below.

Camera Name | IPC2333

Face Recognition
Live Display Playback Search and Backup Intelligent Analysis Function Panel

Detection Recognition

Face Database = Plate Database =

Function Panel » Face Recognition

B Event Notification

Alarm-out|E-mail | Display | Buzzer Camera Name P " Enable M Successful Recognition [ Stranger
[Push Message| Audio]Light] Parameter Settings Successful Recognition Stranger
Alarm server Face Recognition -
Detection Recgniﬁon Face Group 01;
fo AtEven Face Database Plate Database Tedule ) ]

Face Recognition|LPR|

People/vehicle Ferimeter|More Enable <& Successful RecognifioR (] Stranger Text Prompt ]

Parameter Settings Successful Recognition Stranger

" [] Enable alarm output pulse(Access Control)
% General Event

Motion|sensar] Face Group Similarity (%) - [ Trigger General Record A
Combination Alarm|IPC Offline|
Exception Handling Settings oL s ) ] O Push PC2333

Additionally, please make sure the face detection function is enabled for the Al IPC (click Device Setting—>Face Detection).
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Add, Edit or Delete Device Device Setting Area Setting Channel Group Setting

Encoding Device RV OSD Setting Image Setting Stream Setting Motion Detection Motion Alarm Linkage

Q
‘ (A 123 (Online/Total number:2/2} ‘
B () default area (Online/Total num..
10.214.200111 80
@ Device Name88
& IP Camera
@ IP Camera
& IP Camera
& IP Camerad
& IP Camera5
&1
|
1
(ol
& N « J 1

ON@IPC)
(EEEIGAINN [ Display Max [ Display Min

Max 50 %

Hold Time (s)

Save Source Information

Save Face Information

®H @

Snapshot Interval

=

Snapshot Number

B @

Face Exposure

B B #

®

o &=

Min 3 %

® View the real-time snapshot and comparison result

User Manual

Exception Detection Face Comparison Face Detection

20

ON

ON

305ecs

3

[ c— 50

Face capture results can be pushed by the cameras with face detection function. Human body/motor vehicle/non-motor vehicle capture

results can be pushed by the cameras with human/vehicle classification function. Face Comparison and license plate comparison result can

be pushed after the face/license plate comparison is configured, even if the corresponding cameras are not playing in the live view

interface.

% IP Camera

e 1P Camerad i a 655

J1115 ca

IF Camera
Channel Group

View M IO0EDEEEAERE DR EE &

Self-adaptive Stream

Click to add the captured face picture to the person list.

Fill in the relevant informaiton and then click [OK].

[z
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Add to Group

Search Q Name*: e Name88_IP Cameratest  Birthday: 2022-01-10 @
- [@@ Block
8 Default Group Gender: Male “  Country:

- W Employee Province: City:
Work Type: Work ID:
Telephone: Card Number:
1D Type: ID Card v IDNG:
Remark:
T

VIP List
B ——

Visitor List

s TEVICE NaImess_IP ... VICE NAMESo_IF ... y: )
01-10 18:56:11 ‘ 1-10 18:56:11 01-10 18:56:09 ]
b, moR (R @R L\ BOR |-

Vi SN i

N

Click ﬁ to quickly enter the smart snapshot retrieval interface.

Image Search by Face  Face comparison retrieval  License piate matching reteval | Smart Snapshot Retrieval | Visitor Record

Monitoring Point

= 0 7 0 . era
= 8 () 123 Online/Total number/2) i 4 y L
B B ) default ares (Online/Total . ||/ i ‘ 1 ]
: L 3

22R9

f ) Human face -
MatchType  Haffan face i I
Device Name _
Searen S Intetigen Server |

re

01-10 18:59:2

{ ) EIE@ erotine | 202201102

S

me  2022-01-1000:0000

®  Smart snapshot display settings:

Click .n. on the right corner of the live interface to display the configuration window as shown below. Please select the smart snapshot

display type as needed. One or more items can be selected.

Configuration X

Smart Snapshot Settings

Face detection License plate detection Human body detection Motor vehicle detection Non-motor vehicle detection
Face matching settings

Pop-up prompt Block List ‘) Allow List ‘) Stranger ‘)

Frame Holding Time(s) © Always Show O Automatically Hide(3s) O Automatically Hide(5s) O Automatically Hide(10s)

Statistics display
O Pass-by(Today) O Abnormal Temp [ Mask Off

[J Face Comparison(Today) [ Block List (people) [J Stranger
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Click (] to clear the smart snapshot records.

= Smart Snapshot = @

s e e R

f -\ Human face f r -\ Human face -\ Human face 0 flr-\
N9 E) 3

Device Name88_IP ... Device Name88_IP ... 3
01-10 19:04:23 01-10 19:04:23 1 01-10 18:58:05 '
\_= j BHEZE N \_ -j BIEZE j BIEZERE N l\_ -j
iy S S b

A
The captured picture can be exported. Click Ll and then select the export path and then click [OK] to export

Click El to view the details of the captured picture. Click ® to play back the records.

Target Plcture Original Image

Motor Vehicle

IP Camera

Click the playback button next to El . This will take you to the playback interface. Maybe it will pop up the following tips.

(@) The playback source is inconsistent with the
current one, confirm switching playback source?

Note: Only when the record schedule is set in advance, can the video be played. Click Home—>Record Setting to enter the record setting
interface. Select the desired camera and then select the record schedule.

57



Record Setting Schedule Setting
Storage Playback

Faserd Faed | By eS| )G Channel Name  Stream Type Vv Record Schedule v Audio

@‘ By Tag | Record Backup | Search Picture Q 4P C Main St 7924 o
E amera vViain >tream g en
Record Setting| Schedule Setting 123 =

®  Face Comparison Settings

Pop-up prompt: if enabled, the alarm box of the corresponding face comparison result will pop up. If disabled, the alarm box will not pop
up.

Configuration x

Smart Shapshot Settings

Face detection License plate detection Human body detection Motor vehicle detection Non-motor vehicle detection

Face matching settings

Pop-up prompt Block List () Allow List () Stranger ()

Frame Holding Time(s) O Always Show O Automatically Hide(3s) O Automatically Hide(5s) O Automatically Hide(10s)
Statistics display

[J Pass-by(Today) [J Abnormal Temp [ Mask Off

[J Face Comparison{Today) [J Block List (people) [J Stranger

|__Vehicle denlavment cantral cetting

Frame Holding Time: select the alarm pop-up window holding time as needed.

Statistics display: If selected, the corresponding statistical information will displayed on the top of the preview window.

Pass-by(Today): 76572 Abnormal Temp: 0 Mask Off: 1 Stranger: 71848

®  Face Comparison Records

Click E to view the face comparison details. Click I— to quickly add the captured face picture to the face database.
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Verified Target Info(details) X

Alarm Source: Device Name88_IP Camerat Alarm Time: 2022-01-11 11:02:46

= Face Comparison = oW £
Ve R

i E: B ¢ White List

Device Name&8_IP...
01-11 11:00:09

Name 20221 101620225 Gender Male

Birthday Lib Name

Vs
N

ID Type 1D Card

~

® White List

Device Name88_IP...
01-11 11:00:08 | Work ID

- @8 o
\ )

Click Eto quickly enter the face comparison retrieval interface. Select the camera and click [Search] to search the face comparison
results.

ID No.

Image Search by Face Face comparison retrieval

Monitoring Point h = 1 00H0H Export CurPage

Q
B ) default area (Online/Total nu_
= 10714.300,111 80.CAMO0]
= Device Namel
B Device Namel e e e W i e L
= Device NameBCo s Channel Name: Device NameB8JP ¢ Channel Name: Device NameB8 1P C.  Channel Narme; Device NameB2 1P ¢ Channed Narme: Device NameB8 1P ¢ Channel Name: Device NameS 1P C.
2 Thme: 01-11 11:11:49 Timiz D111 11:11:48 Times 01-11 11:13:48 Times 01-11 11:11:47 Time: 01-11 11:11:47
- Dvice Himett Target Mame: Target Name: Target Name: Target Name:; Target Name;
e Device Nameds [+ Lib Name: - Liby Mame: « Lib Name: - Lty Marme: = Lits Mame: -
WP TaT Temperature: - Temparature; - Temperature: - Temparature: - Tempsrature: -
Mask Status: - Mask Status - Mask Status: - Mask Status - Mask Status: -
- 1D NO: 10 NO: 10 NG: - 10 ND: D ND:
P Camera Wark ICx Waork I0v Waork I Work ID; Wark I
1P Camerah Remark « Remaric - Remark « Remaric « Remark: -
L merad B -
a ™. |
C
-
L
= N | %
L Channel Name: Device NameBB_9 €. Channel Name: Device NameB8 P . Channel Namse: Device Namef8 [P . Chiannel Name: Device NameB8 1P & Channel Mame: Device NameB8 P C
N Thme: 01-11 111147 Time: 01-11 11:1186 Time: 0111 111146 Time 01-11 111146 Time: 01-11 11:1146
- Target Name: Target Name: Target Kame: Targot Name: Target Name: xx
Lily Names - Liby Name: Lity Name: Lily Name: Ll Name: Detault Group
It - Temparature: - Tamparature: - Tampearatura: - Tamnparatire: -
Mask Staus - Mask Status: - Mask Stafus: - Mask Status - Mask Statusx -
Mateh Type Al Types b 1D WC: - 1D N - 10 N - 1D NO: - 10 N -
= Wk I Wark iD: Wark It Waoirk I Wark 1
Start Time 2022-01-11 000000 [ Femaric Remaric Remarc Remark Remaric
End Time H022-01-11 23:5559 FH

10.2.2 License Plate Comparison

If this is the first time for you to set the license plate recognition function, please follow the procedures.

Enter Group Management-> People & Vehicle Management-> Vehicle Registration>Add Vehicles > Task Settings—>View Real-time
License Plate Comparison Results—>Search License Plate Comparison Result

1. Goto People & Vehicle Management - Vehicle Registration interface. Click [Add] to add the vehicle information to Allow List
or Block List.
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People & Vehicle Management Synec Records Task

Persan List VIP List Wisitar List Block List Vehicle Reglstration

Add new vehicle

Block List

Basic Setup

Number plate*

Name

Phang

Vehicle Type Small Car

Vehicle Color Blue b

Descriplion

2. Click the “Task” tab to setting license plate recognition task. Select the license plate recognition camera and then click applicable
scenario. Select “Vehicle deployment control” and click “OK”.

. Sync Records Task
Monitoring Point v Apply Schedule Template

search Q
3+ () 123 (Online/Total number:2/2)

&« IP Camera
- @M RTS|
3- () default area (Online/Total num...
- 10.214.200.111_80_CAMOO1
-~ @ Device Name88 IP Cameratest

Device Name88_. Face Surveillance,Face Greeting,Face Attendance,Access Control Management,Vehicle deployment ...

Applicable Scenario

a Al
B Face Surveillance
B Face Greeting

¢ Device Name88_I™" B Face Attendance

D N 35 1/ B _Access Control Management
® Device Name I I
. . B Vehicle deployment control
-~ W Device NameBSﬁlP-
-~ @ Device Name88 IP L Cancel

3. Ensure that the license plate recognition IPC has already enabled the license plate detection function.

Add, Edit or Delete Device | Device Setting | AreaSetfing  Channel Group Setting

Image Setting Stream Setting Muotlon Detection Motlon Alam Linkage Exception Detection Reglon Entrance Reglon Exfting Preset Set

G

B Display Min 4 % M Display Max 99 %

I £y 123 (Online/Tatal number:2/3)
= & P Camera
- & RT:
B @) default area (Onling/Tatal num..
H- % 10214.200.111 B0
& @& Device Namegd
B P Camedalest
(o=
- (R
-0
L3
- (F
o 1P Camera
- % IP Camera
@ & IP Camera

License Plate Comparison Display Settings

Pop-up prompt: if enabled, the alarm box of the corresponding license plate comparison result will pop up. If disabled, the alarm box
will not pop up.
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Vehicle deployment control settings

Pop-up prompt Block List () Allow List ()
Frame Holding Time(s) O Always Show O Automatically Hide(3s) O Automatically Hide(5s) O Automatically Hide(10s)
Statistics display

[J Vehicles passing(Today) [J Plate Comparison(Today) [ Block List (vehicle)

Frame Holding Time: select the alarm pop-up window holding time as needed.
Statistics display: If selected, the corresponding statistical information will displayed on the top of the preview window.

® License Plate Comparison Records

Click E to view the license plate comparison details.

Pt
01-11 1141:19
Verified Target Info(details) Gy

Alarm Source: IP Cam...  Alarm Time: 2022-01-11 11:41:19

® White List

FP11
IP Camera5
01-1111:41:19
el =]

License Plate

® White List
85087

IP Camerad

01-1111:41:19

MName
Phone

Vehicle Type

Vehicle Color

185087

f.w ® White List

Click E to quickly go to the license plate comparison retrieval interface.

If the alarm window pops up so frequently, you can click [Close the alarm pop-up window] on the bottom left.

L1 Close the alarm pop-up window

10.3 Channel Group View
» Channel Group Setting

@ Go to Home-> Channel Group Setting interface as shown below.
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Add, Edit or Delete Device

o [ o]

Device Satting Area Setting Channel Group Setting

Channel Group Name
Keyboard Number 1
Dwell Time  5Sec

ent Channel Group

default area
1P Camera
O IP Camera
IP Cameral?s
Owe
»
I «

O

)

Select All Rieverse

Add Channel Group ®

Chear All Cancel

Click [Add].

Enter channel group name, channel group and dwell time.
Select the parent channel group.

Add channels to the channel group.

Click [OK] to save the settings.

@ @ ® weE

» Start Channel Group View

After the channel group is set successfully (See Channel Group Setting), go to live view interface as shown below.

Channel Group

o g1
B [P Camera07

G- A

B [P Camera07
B84 IP Camera

IP Camera0?

You can start the channel group view as follows.

2021/02/7/03 16:36:49

1. Choose the screen display mode according to the channel number of the channel group. Select a window and then double click the

channel group name or dragging the channel group to a window to play all channels in the group.

2. In the current screen display mode, select a window and then click
channel group in this window in sequence.

If there is only one sub channel group under the parent group, select a window

beside the channel group name to play all channels of the

and then click € next to the parent group name to play

all channels in the parent group and the sub channel group in the window in sequence.

Select a window and click € next to the sub channel group to play all channels of the sub channel group in this window in sequence.

3. If there are several sub channel groups under the parent channel group, click € next to the parent group name and then all sub

channel groups will play in sequence. The screen display mode will automatically adapt to the channels of the sub group.
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User Manual

27032021 16: 353508

i1
B [P CameraQ7
e fR11

D mio

Click E to play the previous sub channel group; click E to play next sub channel group; click m to stop auto switch among

the sub channel groups.

» Stop Channel Group View

@  Place the cursor on the auto-switch window and then click to stop viewing.
@ Right click the auto-switch window and then click “Close Channel” to stop viewing.
® Click on the toolbar of the live view interface to stop all live view.

Llose Channel

Full Screen

10.4 Plan View

In the live view interface, select “View” on the left menu bar.

View ~

2 Video Previewl?®

Create View

Save View

Modify View

Delete View

® Add View Plan
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(@ Right click “Live View 1” and then select “Create View” or click . to add a new view plan. Clicking “Create View” to prompt an

adding view window. Enter the view name and click [OK] to set view plan.

(@ Select screen display mode and then drag monitoring points or channel group to each window.

(3 Click “View” on the left menu and then right click the newly added view name. Select “Save View” on the pop-up menu to save the

view plan or click on the live view interface to save the view plan.
Double click view name to call the view plan.

® Modify or Delete View Plan
Select the added view and then right click to prompt a pop-up window. Select “Modify View” or “Delete View” to modify or delete the

view plan.

® Start/stop auto-switch

If multiple view plans saved, you can play these views in sequence.

Monitoring Point

[
| Channel Group v

View ~

Video Previewl

8 video Preview?2

IE -~ [ (D DOEEEDOEDQEE

Enter the dwell time (5~3600s) and then click [Start auto-switch] to play these views in sequence. Stop the current auto-switch by clicking
[Stop auto-switch].

10.5 Multi-Screen View

In the video preview interface, multi-screen view can be realized by holding a tab and dragging it to other monitors (graphics card should

support multi-screen output at the same time).
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User Manual

Monitaring Point

Manitoring Paint ~

Channel Group

~ | (G EE (2B

: DEEEEEEEE @ E

Click ﬂ on the float window and select “Return to Main Window” to embed this tab in the main interface.

* O ¥

2022-( Return to Main Window

10.6 PTZ Control

Click n or right click to select “PTZ Control” to enter PTZ control interface. The directions of PTZ, zoom, focus, Iris, preset, track

and cruise can be controlled through PTZ control panel.

PTZ Control

A1 =1 R EA A A o1 r=N 6sol

2 . cruise: U
= . Preset; = :Cruise; : Trace
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10.7 Instant Playback

In the live view interface, right click on a playing channel to select “Instant Playback™ and then set the playback time to play the record

instantly (the record of the channel in the past five minutes will be searched and played from the time that the record exists).

=l 1| T=matem ) IR B B | RN = T ChE=) TE

Original Size
Full Screen
Close Channel
Start Record

o @ ‘x@ e @ @ @ = \!/ @ Instant Playback

Audio On

Snapshot

PTZ Control
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11 Record & Playback
11.1 Record Configuration

This device supports many recording types, such as manual recording, schedule recording, motion alarm recording, smart alarm recording,
etc.

11.1.1 Schedule Recording
Go to Home—>“Record Setting”.

Record Setting Schedule Setting

e Q *1 Main Stream 7:24 Open 0 60 Never Expire
IP Camera Main Stream OFF ' |Open 0 60 Never Expire
IP Camera Main Stream OFF Open 0 60 Never Expire

To set schedule recording, select the channel, stream type and schedule. Then Click [Apply] to save the settings.
Recording Before Alarm: set the time to record before the actual recording begins.

After Alarm Time: set the time to record after the actual recording is finished.

Expire Time: set the expiration time for recorded video. If the set date is overdue, the recorded data will be deleted automatically.

® To set schedule:
(@  Click the “Schedule Setting” tab to go to the following interface.

Record Setting Schedule Setting

7724

O 5424 |_/| |_|m

@ Click [Add].

Add Schedule

Schedule Name & ¢ Input Manually Select All Reverse Clear All

08:02:00-1%:35:00 Input Manually Select All Reverse Clear All

Tue.

OTA8:00- 222700 Input Manualty Select All Reverse Clear All

=
|

08:368:00-22:20:00 Input Manually Select All Reverse Clear All

Thu.

Input Manually Select All Reverse Clear All

Fric

£
i
!
i
§

Input Manually Select All Reverse Clear All

® Enter the schedule name.
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&
@  Set the schedule. Click Q— and then move the cursor to select the time; click ~ and then move the cursor to delete the
selected time. Click “Input Manually” to manually enter the time. Click “All” or “Reverse” to quickly select time. Click “Clear All”
to clear all schedule.

11.1.2 Alarm Linkage Recording

@  Go to Home=> Device Setting interface. Select the desired device to enable and set schedules.

@ Go to Home>Alarm Center>Alarm Linkage as shown below. Select alarm type, enable record, set linkage channel and set
schedules.

®  Click [Apply] to save the settings.

Alarm Log Search Alarm Linkage Settings Schedule Setting Manual Alarm Qut SOP Setting Alarm Task Settings Email Settings
h Alarm Type| Monitoring Point-Intrusion Detection ‘l m All OFF
Q Name Audioc Vv PTZN Record Vv  Alarm Preview Vv  Sna
1 | OFF OFF OFF OFF OFF

[1] Record Linkage Setting / X | oFF OFF
Selectable Device Selected Device OFF OFF

A default area A default area OFF OFF

IP Camera ( 1 OFF OFF
IP Camera ‘i] OFF OFF
IP Cameral75 > OFF OFF
IPC OFF OFF
IPi@iS197 » OFF OFF
IPIBIEG6 K

ON (Q  SelectAll Reverse Clear All - Cancel

11.2 Record Playback

In the main menu interface, click “Record Playback” to go to record playback interface. Record files saved on the HDD/ SD card of the
devices and storage server can be played.

There are three types of record playback: normal playback, smart playback by face, smart playback by license plate.

11.2.1 Normal Playback

151 (= [ 3 &

W Manual Schedule M Video Analysis Il Mation Detection Sensor Face Event Target Counting Behavior Analysis Subsystem | Zone ACC|ATT POS

Area Description
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Area Description Area Description
1 Playback area 3 Record timetable area
2 Toolbar 4 Time and event search area; resource area

Toolbar on Playback Window

Button Description Button Description

‘2‘ Stop viewing @ Zoom in

Audio on/off @ Zoom out
Snapshot E Fit to window

Button Descriptions of Area 2:

Button Description

| 1 | } 4 { } 8 i }IEi Screen display mode button. 1/4/9/16 screen mode is optional.

B2l

Full screen

Enable or disable OSD

Close all window viewing

Get record from network devices

Get record from storage servers

Rewind

Low speed playback

Stop

Play/Pause

Next frame. In the playback mode, click the pause button and then click this button to play
frame by frame.

Click it to select playback speed.

EE@%@@EEE@EE

Click it to play in normal speed.

Forward 30s or backward 30s

L
(=)
(%)

Backup start time

Backup end time

Start backup

] ]| &

vl

1Y
11
vy
LL

Synchronous playback or asynchronous playback
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Right-click button menu

Menu ‘ Description ‘ Menu Description ‘
Close Close viewing Zoom out | Zoom out the current image
g:;g?f Audio on/off Full Screen | Click to enter full screen mode

Snapshot | Snapshot Sub stream | Switch to sub stream playing

Zoom In Zoom in the current image

Other buttons

Button ‘ Description ‘ Button Description
.n Add tag E Event list
. Backup

Set record date, record type (for some devices, “Main Stream” can be selected to play the record, or the record will be played by sub
stream if unselected) and the record playback source in the playback interface. Drag the camera on the right side to playback window for
playing or double click a desired channel to play or click [Search] to search the record files and then click [ > % play.

Playback record type includes manual recording, motion detection recording, schedule recording, sensor recording, object removal
recording, video exception recording, intrusion recording and line crossing recording and so on.

In the timetable, different color bars stand for different record types. For instance, yellow bar stands for motion recording data; blue bar

stands for schedule recording data; red bar stands for sensor record data, etc.
The time scale can be zoomed in by clicking and the time scale can be zoomed out by clicking @ The time scale can be restored

to 24 hours by clicking . When the time scale is zoomed in, drag the timeline to see the time spots.

Synchronous Playback: in a certain time, all channels play back its record at the same time together; if one channel has no record data at
this time, this channel will wait.

>
Click on the toolbar in the playback interface to go to the synchronous playback interface. Please play the record according to the
ways introduced as above. The record bar in synchronous mode is as below.
In synchronous mode, one camera can only have one playing window. All cameras’ record information can be viewed at the same time.

When playing record file in synchronous mode or asynchronous mode, clicking or will be useless unless all the playback
windows are closed.

Asynchronous Playback: when playing some channels’ record at the same time, each channel is independent from the others and each
channel’s playback time is different.

Click to go to the asynchronous playback interface as shown below. Please play the record according to the ways introduced as the
above. The record bar in asynchronous mode is as below.

11.2.2 Smart Playback by Face

For the added face recognition NVR, you can play back by searching face.
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c HEM -
Face Recognition NVR e

o Manual Schechsle 8 Video Anshii I M e i Face Event Target Caunting Behavior Anatpls . Submpstem | Zone  ACC|ATT s

Clicking on enters the above interface. Select the face recognition NVR and then click to add a face picture. You can add the
face picture form local PC, target picture or group. After that set the start and end time, max. number and similarity and then click [Search]

to search the records.

Add a face picture from the local PC: Click to select the desired face picture in the local PC and then click [OK] to save the
settings.

Add a face picture from the target picture: refer to the following picture.

Import Target x

Local Picture Target Picture Group

Monitoring Point ~ B chonnel Time Period 2022-01-11 00:00:00 ~ 2022-01-11 23:59:59

Q

B8- B @ default area (Online/Total n...

el

] m IP Camera

J mw IP Camera

[J mw 1P Cameral?5

e IPC

] . 1P}

] mIF

] w1

.

1/

Intelligent Server / 2

Start Time 2022-01-11 00:00:00 [

End Time 2022-01-11 23:59:59 (=

I [
4

6’ Cancel 1

Add a face from the face database:

1. Click the “Group” tab.

2. Select the face picture from the person list, VIP list or visitor list.
3. Click [OK] to save the settings.
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Import Target x

Local Picture Target Picture Geaup

VIP List
Visitor List

Block List

O Show All Nodes

Defalt Group Total 1 entries

m Cancel |

The picture must be added to the corresponding list in advance, or no picture can be searched. Refer to Chapter 6 Group Management for
details.

Note: The record source is from the HDD of the face recognition NVR. The comparison record of this person must exist in the HDD, or no
record can be played.

el 02/0372021 0B:z:29:16

Face Recognition NVR -~
1 Q
& [0 @) default area
Bl

¥ Device Name

Select Image

Start Time 2021-02-11 000000
ind Time 2022-01-11 2358:59

Max. Number 500

similarity(%)

=

11.2.3 Smart Playback by License Plate
The vehicle records can be searched from the NVR or intelligent server. The setting steps are as follows:
1. Select the ANPR camera or NVR.

2. Enter the license plate number or click [Select plate] to select the plate from vehicle database or license plate captured when the
vehicle entering or exiting the parking lot.
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License Plate cap_lu:!e

a [ 5 default area
B
7 & Device Name

License Plate | A123456 |
Start Time: | 2021-02-03 00:00:00 |
End Time | 2021-02-03 235

EI : select the record source from the storage server. License plate captured by ANPR camera or ANPR camera bound to the lane of the
parking lot can be searched.

E: select the record source from the HDD of the NVR.

Note: before you start searching, the license plate detection must be enabled and corresponding alarm linkages and the schedule must be
set in advance.

Maim Log Search | Alanm Linkage Settings | Schedule Sefting  Manual Alam Out SOP Setting Alarm Tatk Settings Emall Settings  SIRA Alarm Setting
- : s e 0

Off OFF OFF Off Off OFF OfF OFF OFF OFf
OFF OFF OFF OFF OFF OFF OFF OFF OFF OFF
OFF OFF OFF OFF OFF OFF OFF OFF QFF OFF

i OFF OFF OFF OFF OFF OFF OFF OFF OFF

! OFF OFF OFF OFF OFF OFF OFF OFF Te24

| Off OFF OFF OFf OFF OFF Off OFF OFF OFF

11.2.4 Playback by Time Slice

(D Go to Home->By Time Slice interface.
@ Select channel (or monitoring point), set the start time and the end time, select the record source and then click [Search].
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By Time Slice By Event By Tag Record Backup Search Picture

[eliee e Hatie| Record Backup  To Storage Playback

3 Q
= B & 1 (Online/Total number:9/10)
[ me 1021475222 37777
C) mw 10.214.75.222 37777
_| mw 113 IP Camera

L W 113 [P Cameratest
1 m [P Camerads

| o~
L) mm Py
0w R
B 2022-01-12 10:58:32

@ O £ 1PVS (Online/Total numberd...
@ O & NVR (Online/Total numberl..,
2 O Gy default area (Onding/Total n..
=- O o (Onfine/Total numberd...

tart Time: 2022-01-12 00:00:00
nd Time: 2022-01-12 23:59:50 =

® Click EI to play the record.

Playback

00:00:03/00:05:00 Iil El ‘1’ IE’

Click E button on the top right corner to play in full screen mode.
Double click the image to switch to slice search mode by day.

Double click an image to switch to slice search mode by 5 minutes.
Restart searching or click “Slice Per day” to return to the slice per day interface.

Record Backup: In the Search by Time Slice interface, select a time slice and then click “Record Backup” to back up the record file
during this period quickly.
To Storage Playback: In the Search by Time Slice interface, select a time slice and then click “To Storage Playback” to play the record

file in the storage playback interface.

11.2.5 Playback by Event

@ Go to Home-> By Event interface.
@ Select the desired monitoring point, set the record source, the start time and the end time and then check events.
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By TimeSlice. | ByEvent | ByTag  Recoed Backup  Search Pictur
Monitoring Point ~ LSS Q) Batorethe avent O 122 1o Storape Playback Tip'z Filter By (Namej, [Start Time]. (End Time]. [Event Typej
Q | No. htame Start Time End Time: Duraiion Type Playback Record Backup |

214,752 31777, 1 2022-01-12 10:58:30 2022-01-12 11:00:39 [ Schedule ) (%)
- 1021475222 377

o 113 IF Camera

- 1130P Camera

- * 113 1P Cameratest

P Camera®s

Staat Time:

End Time: 2

s R Paged / LTowl 1 4 4 W bl

® Click [Search]. The searched record data will be listed. Click @ to play the record; click @ to back up the record data.

11.2.6 Playback by Tag
Note: The tag cannot be added to the record from the HDD of the NVR.
@  Go to Home->Record Playback interface.

Select a channel and put the cursor on the right center. Then a tag icon (E|) will appear. Click this icon to add tag.
Go to Home—>By Tag interface. Select the start time and click [Refresh] to search the added tags.

® 0O

Click in the playback column to play the record.

11.3 Record Backup
In the main menu interface, click “Record Backup” to go to the backup interface. The setting steps are as follows:

(@  Select the desired monitoring point.
Select date and click “More” to select the start and the end time and event type.

v
Click / to get records from device or storage server.

Set the start time and the end time of backup. Then click [Backup].

@

®

@

(®  The backup progress will be seen during backing up the record. Click m to pause; click @ to stop backing up the record; click

to clear the backup list.
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By Time Slice By Event By Tag Record Backup Seanch Plcture

Monitoring Point v lan 2022 | 3

(o) Mon Tue Wed Thu Fi  Sat Sun

Total numbersy/ 10y 1 2

yTotal numberd),

m 2
g 16 4
o

2

31 L ]
hia, Chapne! Stast Time: ‘End Time Duration Progress Operatior Backup Path

@ N CLmE a,

“Backup on device”: This function is applied to the added NVR devices. Search the record from the HDD of the NVR in this interface and
then insert a USB storage device into the USB port of the NVR and then click this button. Then the recorded files will be backed up to the
USB storage device remotely.

11.4 Search Picture

In this interface, pictures stored on the SD card /HDD or storage server can be searched and viewed.

Note: the searched pictures are the snapshots triggered by alarm events (like motion, sensor, smart event, etc.).

By Time Silce ByEvent  ByTag Record Backup Search Picture.

Search ResultiDevice Nameda53
Q| p
8 B @ 1(Online/Total numberd/10} |
] e 1021475222 377777
W 1021475222 31717
me 113.P Camnera

1 = 113 |P Camers

113 1P Cameratest

¥ Camerads
-

iy 2072-01-17 DO0EIT
-

Bmq...
B & PVE (Online/Total numberl..

m e NVR [Online/Totsl number:l... I
8 B¢ i Ine/Total n. |
W By I (Online Total nemberd.
Start Time: HE2-01-12 0000
End Time: 022-01-12 2

i Manual B Schedule

Fi Video Analysts Motion Detection

Bl Sensor B Face Event

et Counting 8l Behavior Analysds
B Subsystem | Zone B ACC | ATT

i Reverse

[ sewcn |

oot Al Reverse Download 4 ™ The 1 J119Pags W B| ParPage 10 Entry 1-10 Totak 1184

@ Select the device.

(@ Set the start time and the end time.
® Choose events.

@ Click [Search]
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12 Alarm Management

12.1 Alarm Server Configuration

Alarm server is in charge of receiving and recording alarm information of connected devices and then sending the alarm information to the
relevant user terminal system or devices in accordance with prior alarm settings. There is a default alarm server.

Go to Home—>Add, Edit or Delete Device = Alarm Server interface to view the online status of the alarm server. If it is not online, please

check its network connection.

Add, Edit or Delete Device Device Setting Area Setting Channel Group Setting
a

Device Type Server Name IP Address Port Client Connection Status Authentication Server Connection Sta... Edit

Encoding Device (Online/Total number:1/1) e S 10.214241.91 6033 Online Online E‘
Decoder (Online/Total number:0/0)

Alarm Host (Online/Total number:0/0)

Access Control System (Online/Total number:0/0)

12.2 Alarm Configuration

@ Go to Home->Device Setting interface.

Add, Deicte Device | Device Setting Aséa
Encxding Ovies v e WOiSetting  Focusing Setling  Motion Detaction  Molion Alarm Linkage  Exception Detection | License plate detection (1
& Dretection sres Shielded area
@ @ default ares (Ondine/Total numb,,, ’
L Bl Display Min 4 % B Display Max 20 %
iP 197
‘ [ |

Save inspaction panorama

Save the detection Target mag

At Halding Time 20

B frigger 5D card snagshat

B Trigger SO card recording

Trig

B Trigges FTP

FIP Server Address

Select the desired device to enable alarms (refer to the user manual of the corresponding device for the detailed settings).

® Go to Home—> Alarm Center-> Alarm Linkage interface.

AlmmTyge. Monitoring Point-Mation Detection m All OFF ese Q

¥ TV Wall v Trigger En

Name Audio ¥ PTZControl | Record 1¢ Alarm Preview % Snapshot ~  Alarm Output ~ Voice Broadcast v Open Door
1P 197 ~ OFF OFF Link to itself (On) OFF OFF OFF OFF OFF OFF
Link to itself {Off)
single ~ OFF OFF OFF OFF OFF OFF OFF OFF

Free Choice

Select area, alarm type and then enable alarm linkages.
All ON: enable all alarm linkages of the current alarm type and area (schedule excluded).
All OFF: disable all alarm linkages of the current alarm type and area (schedule excluded).

Select ™ beside the device name and select “ON” to enable all alarm linkages of the device (schedule excluded).
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Alarm Type Monitoring Point-Motion Detection v m Apply Filter Q

1P197 OFF |OFF OFF OFF OFF OFF OFfF OFF OFF {OFF
single ﬁOFF | OFF OFF OFF OFF OFF OFF OFF OFF OFF

Select ~ beside the title (like record) to enable record linkage of all devices (schedule excluded). Select “Link to itself (On)” to quickly
select the camera itself as the record camera.

Alarm Type Monitoring Point-Motion Detection All ON Reset

1P 197 v |OFF

smgle v OFF OFF OFF OFF OFF OFF |

The alarm linkage settings of PTZ control, record, alarm view, snapshot, alarm output and TV Wall are the same with each other. Here take
record linkage for example to introduce the setting steps.

[IP 197] Record Linkage Setting

4 B default area 4 [] default area

single O IP197

»
K

3

B ON | Search () Select All Reverse Clear All 0K

Check the selectable channel and click to select the channel; check the selected channel and click to remove this channel; click

to select all channels; click s to remove all selected channel.
After the channels are selected, check “On” and then click “OK” to save the settings.

Note: Before checking voice broadcast, please upload the voice first (See chapter 20.7 Audio Uploading for details).

Before checking Email, please set the sender’s email address and the recipient address first (See chapter 10.5 Email Settings for
details).

Before checking SOP, please set the SOP first (See chapter 10.3 SOP Settings for details)
® Set alarm schedule. Select the schedule of the desired device. 7*24 or 5*24 is the default schedule. Other schedules need to be set in
advance. Click the “Schedule Setting” tab to set (See Schedule Recording—>To set schedule for details).
Note: 1. For the alarm linkage items related to face recognition, you can set them separately, including face comparison alarm linkage,
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stranger alarm linkage, block list alarm linkage, visitor alarm linkage and VIP alarm linkage.

2. For the combined alarm of DVR/NVR, you can configure the alarm linkage items in the platform. If the combined alarm is set after
the NVR/DVR is added to the platform, the platform cannot automatically receive the combined alarm data. Please reboot or reconnect
your NVR/DVR and then the platform will display this device under the alarm type of “Encoding device-combined alarm”.

12.3 SOP Settings

Click the “SOP Setting” tab in the alarm center interface to go to the following interface as shown below.
1. Click “+” to add a SOP name.
2. Click “Create” to create a SOP action.

3. In the alarm linkage settings interface, select the alarm event and enable SOP of the relevant device.

AsimLog Semch | AlamilinksgeSefiings | Schedule Serifsg  Manual Alem DUl SOPSelling  Alem Task Settigs Emall Sellign SIRAMsm

i Rocord % Al Prviow v Snapehol % Alwm Oulpal | v Volto Broadcst v OpenDosr v TWWal w ThggerEmall v o8 v Schodule v
o ot it | [P 1571 S0P Linkage Setting % o
UnSeloct S0P Sebect SOP

~B

4, Click E to extend the alarm list.

5. Click C/J to handle the alarm. Select the SOP action and then click “Save Process”. After that, choose disposition and enter
remark as needed.
The disposition includes: False alarm, true alarm, customer test, technical event, service test.
Alarm Log Search Alarm Linkage Settings Schedule Setting Manual Alarm Out SOP Setting Alarm Task Settings Email Settings SIRAAlamm seivice configuration
S0P + @y [ oo | ouer |
e @ Index Edit  Dolte S0P Action
1 £ Tl 1
=i

Adarm Thme: 2022-01-12 171958
Name4653 19166

Disposition  Faise Alarm

Rermark.

~ Storage Plagbark | Device Playback | Storage Snapshat | Device Capture alarm Processing | Handing Status  Disposition - Remark

» ®®
&R
N
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After the alarm is processed, the alarm handling status and disposition will be shown as below.

Alaren Time. Alarm Type » Storage Playback  Device Playbock  Storage Snopshol  Device Caplure | Alarm Processing || Handling Status . Disposition  Remark
® = “ T
" & [4

>

If “SOP Filter” is enabled, the alarm events of the channel set the SOP will be listed.
If “Alarm Preview” is set for the monitoring point, select the corresponding alarm items and then right click to choose “Alarm Preview” to
jump to the alarm preview interface.

larm ® Motion Detection ® Face Alarm 8 Other Intelligent Alarm ® Subsystem Alarm # Zone Alarm  # Sensor Alarm  # Access Control Alarm @ Offline Alamm ® Server Alarm  ® Alamm Task (D

Alarm Time Alarm Type v~ storage Playback  Device Playback  Storage Snapshot  Device Capture  Alarm Processing  Handling Status  Dispasition  Remark
022-01-12 17:221 ace Compari ® B B
2022-01-12/17:22:10 Device Name#553,1P166 Monitoring Point-Face Comparison ® E Z |

12.4  Alarm Task Settings

In this interface, you can set the leaving alarm task.
Leaving alarm: When someone leaves the predefined area and doesn’t come back within the set time duration, the system will perform
alarm linkages.

To set a leaving alarm task:
1. Enter the Alarm Task Setting interface.

2. Click [Add] to add the alarm task.
Set the task name, interval time, schedule and choose the camera.

Multiple cameras can be added to an alarm task.

Alarm Log Search Alarm Linkage Settings Schedule Setting Manual Alarm Out SOP Setting Alarm Task Settings Email Settings SIRAAlarm service configuration
<
O hannel Number  Channel Schedule  Interval Time(min)  Alarm Type Edit Delete
Add Alarm Task x
‘ Task Name
Interval Time(min) 10
Schedule 7+24
Alarm Type  Alarm task-Leaving Alarm
Selectable Device Selected Device
4 [J default area
>
O e 197 <
O single
»
K
< > < >
() SelectAll Reverse Clear All “ | Cancel
3. Set the alarm linkage items. In the alarm linkage settings interface, select the alarm type as “Alarm task-Leaving Alarm”. Then

enable the desired alarm linkage (like “Alarm preview”) and set the schedule.

80



Alarm log Search | Alarm Linkage Settings ~ Schedule Setting  Manual Alarm Out ~ SOPSetting  Alarm Task Settings  Email Seftings  SIRAAamm service configuration
Q | Naime Audic. v FPTZContol v Record N AlamPreview v Snapshot v AlamOufpit v VolceBroadeast v OpenDoor v TVWall v Trigger £

default area

" W ION OoN oN ON oN ON ON ON ON ON

4.  Go to the Device Setting interface to enable Intrusion and set the detected area.

Note:

1. The selected camera must support and enable intrusion function, or leaving alarm will not take effect. If the camera supports
vehicle/people classification, please check “Human” as the detection target.

2. After the leaving alarm task is set and intrusion is enabled for the camera, when someone enters the predefined area and stays there,
this person will be judged as “ON Duty” so that leaving alarm will not be triggered and the intrusion alarm will not be displayed on
the alarm list; but when this person leaves and doesn’t return within the set time duration (interval time) or no one appears in the set

time duration, leaving alarm will be triggered.

Alarm Log Search Alarm Linkage Settings Schedule Setting Manual Alarm Out SOP Setting Alarm Task Settings Email Settings SIRAAlarm service configuration

O Task Name  Channel Number  Channel Schedule  Interval Time(min) Alarm Type Edit Delete

1 1 1P 197 7424 10 Alarm task-Leaving Alarm [ T

12,5 Email Settings

Alarm information can be received by the specified Email address if the Email parameters have been set in advance.
Click Home->Alarm Center->Email Setting to go to the following interface. Add the sender and recipient’s email information here.
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Alarm Log Search Alarm Linkage Settings Schedule Setting Manual Alarm Out SOP Setting Alarm Task Settings Email Settings SIRAAlarm service configuration
Sender’s Name Email Address
SMTP Server SMTP Port
Security No W
Username Password
| ecient Add Emil
T ——. Recipient
E-mall Address
o JECEEN

In the sender’s Email information area, fill out the corresponding information and then click “Apply” to save the settings.
Clicking on the [Add] button adds the recipient information.
After that, in the alarm linkage setting interface, you can trigger Email.

SOP Setting  Alaim Task Settinga Emall Semings  SHUAALem service condlguration
M o [ PN - a

s Log Semch | Alam Linkage Settings Schedule Setting  Manual Alarms Out

Alarm Typa| Monitoring Point-Motion Detectson

OFF OFF.

OFF O

12.6 Alarm View

Having set the alarm preview linkage, the alarm view window will prompt when an alarm is triggered.

Maern Linkage Settings | Scheduls Setting Manual Alarm Out SOPSetting  Alamm Task Settings Email Settings SIRAALaNM service configuration

Alarm Type. Monitaring Polnt-Motion Detection

Alarm Log Search

e |/ 119 197) Alact Preview Linkage Setting X o ofF o oFF
OFF OFF OFF OFF OFF
-l ﬂfliﬂlll aea @2 A [ detauit area
1 ( 0 w197
O single
>
. >
i<q
3 4
Q St Al Revérse cnmm@; Cancel

In the alarm preview interface, you can select multi-screen display mode by right clicking on the preview window as shown below.
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Alarm Preview

Original Size

v Full Screen

Z@HEOTAQQHE ¥

Close Channel
Start Reco
Instant Playback
Audio On
Snapshat
PTZ Control
Start Talkback
Channel Talkback
v Main Stream
Sub Stream
Channel Info

Full Screen

Click - on the bottom right corner to expand the alarm list as shown above. Hover the cursor on the top of the alarm list and then a
bidirectional arrow will appear. Drag the alarm list up or down to extend or shrink the alarm list.

Click or to play the record or captured images.
Right clicking on an alarm item displays a menu as shown below. Click “Alarm Preview” to jump to the alarm preview interface.

Offiine Atarm @ Server Alarme @ Atarm Task (D

Marm Tune Alarm Source Aarm Type w | Storage Playback  Device Playback | Storage Snapshot | Device Alarm Processing  Handling Status. Disposition  Remark

NENKN

12.7 Alarm Log
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Manual

| Al Log Semch

Alarm Linkage Settings Schedule Sesting

1 2022-0112 1750:21

oring Point
2 2022:01-12 17:50:18
B 8 o defaull men 3 2072-01-12 175017
@ Dodeeiy i 4 2022-01:12 17:50:14
B9 Device Names653 1.
CI 9 Device Name4653 1., 5 2022-01-1217:50:13
O Device Named653 L
O ipie7 & 022:01-12 17561
3%: douiia 7 2022-01-12 175009
00 % single
B 2072-01-12 175008
a 2022-01-12 1750407

i 2022-01-12 175006

1 2022-01-12 17:50:06
12 2022-071-12 1715005
13 2022-0-12 15003
14 2022-01-12 175002
15 2022-01-12 174554
L 2022:01-12 174953
1 20220112 174952
_“.”\m 18 2022-01-12 17:45:52
19 2022-01-12 17:49:45

NManisal Alarm Out

S0P Setting

Device Named&53 IP166
Drevice Named&53 IP166
Device Named&53 IP165
Diewvlen Named&53 IP16S
Desice Namedisd IP166
Divvice Narned653, 17156
Device Named&53 IP166
Device Named6s3 17166
Device Named653 IP166
Device Nameds53 1P166
Device Namedg53 IP165
Dievice NamedBt2 IP166
Drewies Namadita IP166
Diewice Named&s3 17166
Device Named&s3_IP166.
Drewice Namedbs3 IF166
Device Named&53 1F166
Device Named&53 IR166

Dewien NamedEs3 IP1EE

Alarm Tarsk Settings

Ernail Settings:

Monltoring Point-Face Match
Manitoring Peint-Face Maich
Manltaring Point-Face Maich
Monitoring Point-Face Match
Manitoring Peint-Face Match
Maonitaring Point-Mation Detect
Manitoring Paint-Face Match
Monitoring Poim-Face Match
Manitating Poim-Face Match
Monitoring Polnt-Motion Detect
Monitaring Point-face Match
Monitoring Point-Face Match
Monitoring Point-Face Match
Monitoring Point-Face Match
Maonitoring Point-Face Match

Monitoring Point-Face Match

Monltaring Point-Face Maich

Manitaring Point-Mation Detect

SIRAALamm service configuration

Monitoring Point-Excepiion Detection

[CRONORONONCHOHONONONONONOGRONONORONO)

44 The 1

[APage W M PerPage 50

»

EFEEEREEEREEEEEARREREER

»

Entry 1-50 Totak 170

pshot Search

to play the record; click D to open the snapshot search window as shown below.

Start Time 2022-05-18 17:27:44

to ng Po Search Result[Device Name IP05]

4

[J 2022-05-18 17:29:23

(] 2022-05-18 17:29.09

(] 2022-05-18 17:29:36

O 2022-05-18 17:28:44

0 2022-05-18 17:29:16

v

End Time 2022-05-18 17:29:44 E

Select All Reverse Download

I4

4 The 1

/1Page W k| PerPage 10/ Entry 1-8Total8

Check the searched image and then click “Download” at the bottom of the interface to download this picture.

12.8 Manual Alarm Out

Click “Manual Alarm Out” tab to go to the following interface.
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Alarm Log Search Alarm Linkage Settings Schedule Setting Manual Alarm Out SOP Setting Alarm Task Settings Email Settings SIRAAlarm service configuration

Alarm Output v

E- B @ default area

[0 & Device Name4653 Al...
[J 8 Device Name4653 Al...
8 Device Name4653 Al...
8 Device Name4653 Al...
& Device Name4653 IP...
8 Device Name4653 IP...
8 Device Name4653 IP...
8 Device Name4653 IP...
Device Name4653_IP...
8 Device Name4653 IP...
8 Device Name4653 IP...
8 |P 197_AlarmOut1

8 double AlarmOutl

8 single AlarmQOut1

Alarm Holding Time 5 v

O00O@e0OD0OO0ODO0OO0OD0DO
L]

8 single_AlarmQut2

Select the camera, set the alarm holding time and then click [Trigger Alarm Out] to manually trigger the alarm out of the camera; click

[Close Alarm Out] to manually turn off the alarm out of the camera.

12.9 Anti-theft Alarm System
12.9.1 Add Alarm Host

Go to Home—>Add, Edit or Delete Device—> Alarm Host interface. Click [Add] to prompt the following interface.

Add, Edit or Delete Device ‘ Device Setting

Device Type @ Search

Fncoding Device (Online/Total number:4/5)

Area Setting Channel Group Setting

Pecoder (Online/Total number:0/0)
Alarm Host (Online/Total number:0/0)
Pccess Control System (Online/Total numbe Add Alarm Host

| ED Display Device (Online/Total number:0,

ntelligent Analysis Server (Online/Total nun HK Network

Alarm Host1 Module o = -- ssese 1 6

torage Server (Online/Total number:0/1)

[Media Transfer Server (Online/Total numbe:

Bccess Server (Online/Total numberd/1)

Please add the host name, serial number, port, username, password, subsystem number, zone number, area and access server. Then click
[OK] to save the settings.

12.9.2 Subsystem Setting

Go to Home->Anti-theft Alarm->Subsystem interface as shown below. “Arm”, “Disarm”, “Clear Alarm” or “Refresh Status” can be
operated in this interface.
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Su Zone Alarm Linkage Settings

bsystem
Alarm Host v Clear Alarm Refresh Status Detonate tear gas Cancel tear gas

Search

B- @ default area

Alarm Host1 U SubSystem_1

Status: Arm

Bypass 0 Bypass Recovery 6

Alarm 6 Unknown 0

12.9.3 Zone

Go to Home—> Anti-theft Alarm—>Zone. “Bypass”, “Bypass Recovery” and “Refresh Status” can be set up in this interface.

Subsystem Tone Adarm Linkage Settings

Alarm Host

|5 G detauit area | Zone 1 Zone 2 Zone 3 Zone & Zone 5
Stanus: Alaem States: Alaem Statug Alarm Status: Alarm Status: Alarm
Zone
Status Alasm

12.9.4 Alarm Linkage

Go to Home—> Anti-theft Alarm—>Alarm Linkage Settings interface as shown below. The settings of alarm linkage here are the same as
alarm linkage of alarm center.

Suibwyriem Zone  Alarm Linkage Settings

Al Type Subsystem-Arm

Asarm Hostl SubSystem | W OFF OFF OFF OFF OFF OFF OFF OFF
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13 E-Map

The e-map service is used to store the e-map information of the system. The client landing anywhere can share the same e-map.

13.1 E-Map Settings
13.1.1 Create E-Map

Go to Home—>E-Map Setting interface. Click [Create Map] to create a map.

E-Map Setting

Map Management v Create Map Modify Map Delete Map
New York
Map

Create Map

New York
- O

oand sheriots _Wap

Enter E-map name, select parent e-map and map type. Then click [OK] to save the settings.

13.1.2 Add Hotspot

The hotspots include monitoring points and sensors. Drag a hotspot to the corresponding area on the map as shown below.

E-Map Setting

Monitoring Point v
'

U S /s I

'V g I. iPlQldrl | I’
MONGopyA

A Beiiing / r
eljing -
PLE'S REPUBLIC '+

OF CHINA i :

T
Subsystem ~ —— -
g — |- ¢
Zone e T

51

.
.

Click [Modify Map] to change map name and parent map.
Select [Delete Map] to delete the added map.

Click at the bottom of the interface and then right click on hotspot alarm item. Select “E-Map” to quickly skip to E-map monitoring
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interface.

Map Management v

I o

Map of the World
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# Device Alarm  ® Motion Detection # Face Alarm @ Other Intelligent Alarm  ® Subsystem Alarm  Zone Alarm  # Sensor Alarm 8 Access Control Alarm 8 Offfine Alarm 8 Server Alarm # Alarm Task (@D

Alam Time Alarm Source Aarm Type v | Storage Playhack  Device Playback  Storagfe Snapshot  Device Capture  Alarm Processing. | Handiing Status.  Disposition  Remark
/|
{ emap ) =
7
7,

13.1.3 E-Map Monitoring

Go to Home->E-Map Monitoring interface. Select a window on the right and then double click the monitoring point to view the real-time

image.
Map Management ?
i R € T ¢ OCEAN
3
double
‘[ 1P 197 | 1TED
& U G s single = 7 ‘g.?IAT ES
; - I A ol
2 P Cameras
AKHSTAN
v MONGOLIA
23 A = e
¥ Ueq:ng ;&f
_PEOPLE'S REPUBLIC )
- OF CHINA ,ﬂxg

°
ew Delhj

INDIA

I
INDONESIA

ending Alan

Switch to Alarm EMap: if “Yes” is selected, the system will automatically switch to the E-map on which the alarm occurs.

Auto Alarm View
Alarm view: if you select “Yes”, the monitoring video will automatically pop up on the right window when an alarm is triggered.

Put the cursor on the preview window (right panel) and then a toolbar will display. Clicking on closes the preview. Click “Close All
Stream” to stop all previews. The preview window will be overlaid on the map by clicking “Overlap”.

In addition, click [Filter Alarm Type] to filter the alarm type.
If multiple cameras need to play, you can drag the window on the right panel to the right. Then an independent monitoring interface will

display. You can choose the screen display mode as needed.
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14 TV Wall
14.1 Add TV Wall Server

Go to Home—> Add, Edit or Delete Device> TV Wall Server interface as shown below. There is a default TV wall server. Please check

whether it is online.

J Add, Edit or Delete Device ‘ Device Setting Avrea Setting Channel Group Setting

Delete Search

Encoding Device (Online/Total number:4/5)
Decoder (Online/Total number:0/0)
Alarm Host (Online/Total number:1/1)

m] TV Wall 10214.24191 6036 Online Online E/J [
Access Control System (Online/Total number.0/0)

An adding TV Wall window will be prompted by clicking [Add]. Click [Refresh] to quickly add the TV wall server in the same local
network, or add the TV wall server by manually entering server name, IP address and port.

14.2 Add Decoder

Decoder is used to decode the video signal transmitted by the transfer server. The decoding output is a standard video signal. The decoder
is necessary for decoding videos on the TV wall.
Go to Home->Add, Edit or Delete Device—>Decoder interface.

Add, Edit or Delete Device | Device Setting Area Setting Channel Group Setting

Device Type @ Search

Encoding Device (Online/Total number:4/5)

Decoder (Online/Total number:0/0)
Alarm Host (Online/Total number:1/1)

Access Control System (Online/Total number:0/0)

Add Decoder

LED Display Device (Online/Total number:0/0)
Manually Add

Device Quantity:7

Quickly Add

Intelligent Analysis Server (Online/Total number:1/1)
Storage Server (Online/Total number:0/1)

Media Transfer Server (Online/Total number:1/1)

Decoder 10.214.40.98 255.255.0.0 220.betab | 00:18:AE:96:85:40

Access Server (Online/Total number:1/1)

Alarm Server (Online/Total number:1/1) Decoder 10.214.48.253 255.255.0.0 212 00:18:AE:83:79:1C

TV Wall Server (Online/Total number:1/1) Decoder 10.214.40.97 255.255.0.0 220.betaé | 00:18:AE:96:85:43

The steps for adding decoders are the same as the setup for adding encoding devices (see Add Encoding Device for details).

14.2.1 Create and Connect Decoder

The decoder which needs to be connected to the platform must be the master decoder and in platform mode. Login the web client of the
decoder as shown below.

Go to Basic Settings—> System Settings to check the user permission and running mode of the decoder and make sure its user permission is
master and its running mode is platform. Then apply the settings and restart the decoder.
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Basic Settings

Running Mode |PIatForm
User Permission |Ma&ter
Device Name |Decoder ‘
MAC 00:18:AE:00:45:D1

Soft Version 2.1.3

Version Date 20210121

Kernel Version I4R2-H5F3-H5F3

The decoder will not be online until it is bound to a TV wall. Please create a TV wall first and then bind the decoder to the TV wall. See
chapter 12.3.1 for details.

Add, Edit or Delete Device ‘ Device Setting Area Setting Channel Group Setting

Encoding Device (Online/Total number:4/5)
Decoder (Online/Total number:1/1)

Alarm Host (Online/Total number:1/1) O Decoder(1) 2 10.214.48.253 8888 E E/] I

Access Control System (Online/Total number.0/0)

14.3 TV Wall Management

Go to Home->TV Wall Management-> TV Wall Setting.

J TV Wall Setting ‘ TV Wall View TV Wall Task Settings TV Wall System Setting

TV Wall v

TV Wall +

Decoder Output

14.3.1 TV Wall Settings

¢ Create TV Wall
Go to Home->TV Wall Management->Edit TV Wall. Select a TV wall server and then click +to create a TV wall.
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TV Wall Setting TV Wall View TV Wall Task Settings TV Wall System Setting

TV Wall v
B Croto TV Wall X
TV Wall Server TV Wa

TV Wa Create TV Wall1

TV Wall Number

Edit ID “ Cancel

€ Initializing
(D Double click the created TV wall to prompt a TV wall window.
@ Click “Initialize” to create TV wall layout

TV Wall Setting TV Wall View TV Wall Task Settings

€ Merging\Splitting
Merging: drag on the screen and then release. The “Merge” button will be shown. Click it to merger these small windows.

Splitting: select the merged window and click “Split” to restore the window to the previous status.
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The online decoder displayed in the decoder output list is the binding decoder of this TV wall. Drag the outputs to windows on the right in

sequence and then click “Save” to save the settings.

®  Decoder Binding

Go to Home—->TV Wall Management->TV Wall System Setting interface as shown below. In this interface, decoder bind can be set up.

Decoder bind configuration: modify the binding state between decoder and TV wall.

TV Wall Setting TV Wall View TV Wall Task Settings TV Wall System Setting

Channel Number Setting Decoder Bind Configuration TV Wall Backup Alarm setting on Wal

Device Name  Output Number IP Address Port Online Status ~ Select TV Wall  Open in the Browser

Select TV Wa

Create TV Wall1

Edit

©

Change Boun'4 TV Wall

Click to change bound TV Wall. After the decoder is bound to the TV Wall, the online status will be “Online”.

TV Wall Setting TV Wall View TV Wall Task Settings TV Wall System Setting

Channel Number Setting Decoder Bind Configuration TV Wall Backup Alarm setting on Wa

Decoder(1) 2 10.214.48.253 8888 Online Create TV Wall1 E

Device Name  Qutput Number IP Address Port Online Status ~ Select TV Wall  Open in the Browser

Edit

7

Return to the decoder management interface as shown above. The online status of the decoder indicates that the decoder is successfully

bound with TV wall. Go to TV Wall Setting interface as shown below. Drag the outputs of the decoder to the window on the right and save

them to complete output bind.
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Modify TV Wall:
Click next to the TV wall name and then modify the TV wall information as needed.

TV Wall Setting TV Wall View TV Wall Task Settings TV Wall System Setting

INAVEN i) Create TV Wall1

A TV Wall Initialize Save

+
& Create TV Wall1(1) @Er
=

Modify TV Wall

TV Wall Server TV Wall
TV wall Create TV Wall1

TV Wall Number

Edit ID “ Cancel

Check “Edit ID” to modify the ID number of the TV wall. Note that the ID number of the TV wall cannot be repeated.

14.3.2 TV Wall View
4 Create Plan

Go to Home—> TV Wall Management-> TV Wall View->TV Wall Plan.

Click + beside the TV wall name to create the TV wall plan name.

TV Wall Setting TV Wall View TV Wall Task Settings TV Wall System Setting

Monitoring Point @K Preview

Channel Group

Decoder Input
Create Plan

TV Wall Plan

Create TV Walll (1) @;M

Plan Name 1_Plan_1

Plan No.

Edit ID “ Cancel

€ Configure Plan

User Manual
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Double click the plan name to show the plan.

Drag the monitoring points to the corresponding window respectively to decode image.

TV Wall Setting TV Wall View TV Wall Task Settings TV Wall System Setting

Monitoring Point @ Preview %  *1Plan1 X

Q

E- @ default area (Online/Total number:3/3)

® double

® single

¢ Toolbar Menu

e e e - 5 N T T

1.  Screen mode: 1\4\9\16\25\36 screen mode is optional.

2. Open Window: Click [Enable PIP] and then drag on a window to open a small window on it. Click [Disable PIP] to stop opening

window. The small window can be dragged to anywhere on the big window.

Click [Hide ID] to hide the window number; click [Display ID] to display the window number.
Click [Save] to save the current plan.
Click [Save as] to save it as another plan.

Renumber: Click it to renumber the window of the plan from left to right and top to bottom.

N e g o

Select a window assigned a monitoring point and then press the right mouse and drag to another window to copy monitoring point to

8.  Double click a window to play the video.
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User Manual

*1_Plan 1

€ Right-click Menu

*1_Plan_1 X

Screen Display Mode

Set as Alarm Window

Set as Playback Window
PTZ Control

Stop Decoding

View Decoder Output Info.

Clear TV Wall

1. Screen mode:1\4\9\16\25\36 screen mode is optional.

*1_Plan_1 X

Screen Display Mode

Set as Alarm Window

Set as Playback Window
View Decoder Output Info.

Clear TV Wall

2. Zoom in\out: if the current screen mode is multi-screen display mode, click “Zoom In” to zoom in the current image. Click “Zoom

Out” menu again to restore to the previous status.

3. Save as Alarm Window: click it to save the current window as an alarm window. The alarm linkage image will be displayed in this

window. Go to Home—> Alarm Center->Alarm Linkage (or Home—>Alarm System->Alarm Linkage) interface. Select TV wall linkage

item to set alarm linkage.

Alarm Center

Alarm Log Search || Alarm Linksge Settings)
Schedule Setting | Manual Alarm Qut
S0P Setting | Alarm Task Settings

Email Settings

siraAlarm service configuration

ETEETE

PTE Conine w  Mlaw Fedier v Shapwhal v A Cispul v Vo B

4.  Setas Playback Window: when decoding images, click this menu to play the records of the current channel (the record source is the

current record source).

5. PTZ Control: click this menu to prompt a PTZ control panel of the current decoding window. Direction control, zooming and

focusing, Iris control, speed, preset, track and cruise calling can be operated through this control panel.
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6.  Stop Decoding: click it to stop decoding the current image.

7. View Decoder: view the information of the decoder.

*1_Plan_1 X

View Decoder Output Info.

No.  Screen Number Decoder Decader Output's Name
1 1 Decoder(1) Qutput1
8.  Clear TV Wall: click it to clear the decoding configuration of the current output.

4 Screen Merging or Splitting

Drag the mouse to select multi-window and then click [Merge] to merge these windows.

€  Auto-Switch Group

1.  Create Auto-Switch Group
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@  Click Auto-Switch Group under the screen and then click I 1o create auto-switch group.

X Auto-Switch Group

-+

@ Select “Auto-Switch Window” to select the window group.

X

Create Auto-Switch Group

Auto-Switch Name New Group_Dwel Auto-Switch Interval 10

2 Auto-Switch Window ® Monitoring Point

2

(®  Click “Monitoring Point” to select the auto-switch channel group.

b

Create Auto-Switch Group

Switch Window = Monitoring Point

Channel Management x
Monitoring Point v [l

@r“.l :

<

@  Enter auto-switch name and dwell time.
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Create Auto-Switch Group x
Auta-Switch Interval | 10~

I Auta-Switch Name  New Group_Dwell

= Auto-Switch Window = NMonitering Point
++ 40
Ho, Monitodng PoiftName
1 1P 197
2 double
i single

0K Cancel

2. Execute auto-switch

Click I! to execute auto-switch. The specified channel images will be played in the specified windows in sequence.
Clickn to stop playing the current auto-switch.

N Auto-Switch Group

3. Modify or delete auto-switch

Right click the auto-switch name and then select Modify or Delete to modify or delete the auto-switch.

New Group Dwell
e
E u Modify

cuaaole PIP I

[11F41Fe] fas]

Note: If there are overlapped auto-switch window in a plan, the auto-switch groups will not be executed at the same time.

4 Auto-switch plan

1.  Create auto-switch plan

Click L behind the TV wall plan name to set the auto-switch. Click “Join in” to select the plan. Then set dwell time and click [OK].
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TV Wall Setting TV Wall View TV Wall Task Settings TV Wall System Setting

Monitoring Point B¢ Preview 1Plan2 %
Channel Group

Decoder Input

TV Wall Plan A Auto-Switch Setting
i - T
4 Create TV Walll {1) i L@ 5 Plan Name Move Up  Operation
1_Plan_1(1) G ” T ~

1_Plan_2(2]

Auto-Switch Interval @

2.Start/stop auto-switch

TV Wall Setting TV Wall View TV Wall Task Settings TV Wall System Setting

Monitoring Point @ Preview 1Plan2 %
Channel Group
Decoder Input

TV Wall Plan

[+C)e

1_Plan_1(1) o4 Start Auto-Switch

1_Plan_2(2)

A‘ Create TV Wall1 (1)

Click ® behind the TV wall name to start auto-switch plan. Click the Stop button to stop the auto-switch.

3. Modify auto-switch plan

Click L again to modify the auto-switch plan.

Note: If the current auto-switch plan needs to modify, please stop it first.

14.3.3 Decoder Input
Go to Home—->TV Wall Management—->Decoding on TV Wall->Decoder Input. Drag an input to a window to execute decoding.

100



TV Wall Setting TV Wall View TV Wall Task Settings TV Wall System Setting

Monitoring Point @ Preview *1 Plan2 X
Channel Group

Decoder Input

(1): InputD

4 & Decoder(1)

14.3.4 Playback

¢ Playback on TV Wall

Click “Preview” on the left panel. Then this button becomes “Record”. Click at the bottom of the left panel to extend the filtering

condition. Click EI/ EI to get records from device or storage server, check the alarm events and then drag the cameras (or channels)
to a window to search and play the records.

= Auta-Switch Group

Of course, the specified time and event types can be set to search the specified records.

€ Playing control

I T [ T

During playback, the record can be controlled by the above buttons.

€ Right-click menu
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User Manual

1_Plan_1 X

Screen Display Mode
Set as Alarm Window
Recent Channel
Playback Stream Type
Stop Decoding
View Decoder Output Info.

Clear TV Wall

1. Screen mode:1\4\9\16\25\36 screen mode is optional
2. Zoomin

3. Save as an alarm window
4.  Save as preview window:: the current channel or the historical channel is optional.

Playback stream type: main stream or sub stream is selectable.
Stop decoding
View decoder information
Clear TV wall
The following picture is an example of TV Wall.

® N o o

14.3.5 Task Setting of TV Wall

Go to Home—>TV Wall Management->Task Setting. Click + behind the TV wall name.

Select plan name, enter task name, set run time and enable plan task.
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TV Wall Setting TV Wall View TV Wall Task Settings TV Wall System Setting

Create Task

Create TV Wall1 (1)
: Plan Name 1_Plan_1 A%

Task Name New Plan_Task

OJ Run Plan Task Time  00:00:00

O Everyday O Every Week

Click to start the task. Click the Stop button to stop this task.

TV Wall Setting TV Wall View ‘ TV Wall Task Settings TV Wall System Setting

New Plan_Task

Start Time: 00:00:00

O Auto Run
Sun. Mon. Tue. Wed.
Thu. Fri. Sat.
O or

Modify or delete task

Double click the TV wall name and then the tasks will be displayed on the right window.

New Plan Task
1 Plan_1
Start Time: 00:00:00

] Auto Run
Sun. Mon. Tue. Wed.
Thu. Fri. Sat.

O o

7
Click I:l or E to modify or delete the task.

14.3.6 TV Wall System Configuration

Go to Home->TV Wall Management->TV Wall System Setting interface as shown below. In this interface, the channel number can be set
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up.

»  Channel Number Settings

Channel number configuration: set the channel number and make the channel convenient to be controlled by the network keyboard

controller. Users can export these channel number in this interface.

TVWall Seting  TVWall View  TVWall Task Settings | TV Wall Syszem Setting

gueation  TVWell Backup Alan

Chanee] Number Setting

Canfiicts Between Channels” Nusnber

Monitoring Point W No. Mams Channe| Number

[ T——— Cancel

» TV Wall Backup
When importing the former system configuration files to the new version, the TV wall configuration file will not be imported together. So

you need to import the TV wall configuration file separately.
Click [Backup TV Wall] in the last version to back up the TV wall configuration files. Then click [Restore TV wall] in the new version to

restore it.

TV Wall Setting TV Wall View TV Wall Task Settings TV Wall System Setting

Channel Mumber Setting Decoder Bind Configuration TV Wall Backup Alarm setting on Wall

Backup TV Wall Restore TV Wall

Caution: It will take several minutes to restore system configuration. Do not shut down the computer during restoring. The authentication server will
restart automatically after restoration.

» TV Wall Alarm Linkage Settings

The alarm closing time can be set. If “Automatically closing alarm on Wall” is selected, you can set the time that TV wall alarm
automatically turns off. The alarm preview window will automatically turn off the alarm linkage video according to the set time until
next alarm is triggered. If not selected, you need to close the alarm preview window manually.
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15 Access Control Management

Before using access control management system, please make sure whether the access server is online.
Go to Home—>Resource Management->Access Server. There is a default access server which can be modified. Please confirm its online
status. A new access server can be added by auto search or manual adding.

Ak, Eclit of Delete Device: Dévice Setting Area Sesting Channed Group Setting

Encoding Device (Onfine/Total numbera/) e

Diacodar (Onking/Total numbeei/1] : : . Por ‘Subsystem Number  Zone Number | Cl c 5 : . Delete
Al Hest (Online/Total number /1)

Access Control System (CnlineTotal numbserd/0)
LED Display Device (Online/Total number0/0)
Intelligent Analysis Server (Online/Total number /1)
Stearage Server (Online/Tatal fumberD/1)

Media Transfor Server (Onfine/Total numbiee 171}
Access Server (Dnline,Total number1/1)

1021424191 Ondine

— ]

Cuickly Add Manugily Add

Then add access control system. Go to Home—>Resource Management-> Access Control System. Then click “Add” to add.

Add, Edit or Delete Device Device Setting Area Setting Channel Group Setting

Encoding Device (Online/Total number:4/4)
Decoder (Online/Total number:1/1)

Alarm Host (Online/Total number.0/1)
Access Control System (Online/Total number:0/0)

Add Access Control System

LED Display Device (Online/Total number0/0)

Intelligent Analysis Server (Online/Total number:1/1) Access Control

0.0.00 63722 admin sssees ZKTeco
System1

Storage Server (Online/Total number:0/1)

Media Transfer Server (Online/Total number:1/1)

15.1 Remotely Open the Door

Go to Home—> Access Control Management.
The access control devices are listed as shown below. Double click a device to display the doors controlled by this device.

Access Control Event Linkage Record Search E-Map Access Control
Access Control Devie BOBSECC Q
Search Q

B a4 Access Control Systemil

#1 (0001)

#1door#1 (... #1 door #2 (... #1 door #3 (... #1 door #4 (...

Double click a door icon to view the detailed information of this door. The door can be opened or closed remotely in this interface by

clicking the corresponding buttons.
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Access Control Detail X
Door Name: #1door#1 (01.01)
Connection Status: Online

Door Magnetic Status: Close
#1 door#1 (01....

Alarm Status: Null

@OEelC

15.2 Event Linkage

Go to Home-> Access Control Management->Event Linkage.
In this interface, the alarm linkage related to the door can be set up.

#1 dioe #1(01.01) ¢ OFF QFf OFF OFF (R OFF OFF OFF

#1 clooe #2 (0103 e OFF OFF o OFF OFF OFF OFF OFF OfF (]
| #1 dooe 83 (01.02) | OFF OFF OFF OFF ok OFF OFF OFF OfF o
1 dlaon #4.(01.04) ~ OFF OFF OFF OFF OFf OFF OFF OFF OFF

15.3 Record Search

Go to Home—>Access Control Management->Record Search.
The alarm information of the access control devices in a long period of time can be searched in this interface. The relevant linkage record

and snapshot of the central control system and intelligent server also can be viewed.

AccessControl | Ewentlinkage | Record Search | E-Map Access Control

Thisd-Pasty Aecess Controf Systern | Itelligent Server
Start Time 2022-01-13 000000 - End Time 2022-01-13 235959 <24 m“

154 E-Map Access Control

Before setting E-Map Access Control, the E-map shall be set first by going to Home—>E-Map->Door. Drag the access control devices to

the specified location of the E-map for monitoring.
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E-Mag Setting

Map Management
W

ring Point

Lt

Subsystem

Lone

coess Control System
B @ =1doar #1 [00.01)

W @ #1door #2 (01.07)

LW #1door #4 (01.04)

&1 deor #1 (01.01)

N A
devices.

Access Control

Fvent Linkage

e s #1 G006 B2 (D10

~ T

Return to Home—>Access Control Management->E-Map Access Control interface to view the current status of these access control

r m

m 1

Record Search E-Map Access Control
v LT T \
1
Qg .l \
I \
| |
]
! \
I' l'
| "
i
1 )
| IP
| 1 )
#1 doar #1 (11.01) | A\ !
1 A
1 |
| \
\ ——
| m— I
« e — —— e I’
l #1 door #3 (01.03) |1
+ |
|
S - . 1.7 S |1 — s L
o \
| |
» !
|
!
Switchio Alarm ..  OVYes O No l l
Auto Mlarm View O VYes O No ' !
O rc [ Smart IPC
[ subsystem 0 Zone |
1 Sensor o Door |
When the access control device trigger an alarm, the door icon on the map will jump and the red exclamation mark icon will display in
front of the name of the access control device.
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16 Parking Lot Management

16.1 Add ANPR Camera

Before using parking lot system, please add ANPR cameras first. The ANPR camera is use to capture the license plate of the vehicles

entering or exiting the parking lot.

There are two ways to add ANPR camera.

1. Click Home—>Resource Management->Add, Edit or Delete Device->Encoding Device to enter the encoding device adding interface.
Click [Add] to add your ANPR camera.

2. Add the ANPR camera to your NVR with license plate recognition function and then add this NV/R to the platform.

16.2 Add LED Display Screen

Before using parking lot system, please add the LED Display Screen which is used to display the information of the vehicles entering or
exiting the parking lot.

Click Home—>Resource Management->Add, Edit or Delete Device>LED Display Device to go to the LED display device adding
interface.

Add, Edit or Delete Device Device Setting Area Setting Channel Group Setting

—
Device Type Add ) Delete
=

Encoding Device (Online/Total number:13/3 a

Decoder (Online/Total number:0/2)

Add LED Display Device

Alarm Host (Online/Total number:0/0)

Access Control System (Online/Total numbe Device Na... Type IP Address Port Delete
LED Display Device (Online/Total number:0, I LESEE:ES;HY 1P Screen 0000 5000

Intelligent Analysis Server (Online/Total nun

Port: the default port is 5000.
Type: please select IP screen.
IP address: enter the IP address of the IP screen.

16.3 System Settings

16.3.1 Parking Lot Settings

Go to Parking Lot Management->System Settings—> Parking Lot Configuration as shown below.

Vehicle Monitoring Integrated Search Repoct Statistics. System Settings 'ﬂ

Parking Lot Configuration | Vehicte Group Management  Block List Mansgement  Schedule Setting

Parking Lot + 0 v
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®  Add or Delete Parking Lot

Click E2 to add a parking lot as shown below.

Parking Lot Configuration Vehicle Group Management Block List Management Schedule Sett

Baslc Cenfiguration

New parking lot X

Parking Lot

Parking Lot

“ S

Select the parking lot and click I to delete it. Note that there must be no entrance or exit or vehicle group under the parking lot, or it
cannot be deleted.

®  Basic Configuration

Select the parking lot and then set the relevant parameters for it. You can modify the parking lot name, set whether to allow temporary
vehicle access even if the parking space is full, total parking space, number of the current vehicles (in order to ensure the accuracy
counting of remaining parking space, please make sure that no vehicle entering or exiting), remaining parking space, number of overflow

vehicles, barrier gate opening duration and repeated license plate waiting time. After that, click [Apply] to save the settings.
Total Parking Space: the set total parking space
Number of the current vehicles: the number of vehicles staying in the parking lot

Remaining parking space: Total parking space minus the number of the current vehicles (if the number of the current vehicles is more

than or equal to the total parking space, the reaming parking space will be “0”).

Number of overflow vehicles: the number of the current vehicles minus total parking space (if the number of the current vehicles is less

than the total parking space, the remaining parking space will be “0”).

Repeated license plate waiting time: the same license plate will be identified once within the set waiting time

®  Temporary Vehicle Timeout Settings

Overtime Parking of Temporary Vehicles: if enabled, timeout threshold and daily alarm email sending time should be set. Once the

temporary vehicles that stay in the parking lot exceed the set timeout threshold, an email will be sent according to the set time.

®  License Plate Settings

Local license plate and special license plate can be set (Charge will be made).

®  Entrance and Exit Settings
Click [Add] next to “Entrance/Exit Setting” to create an entrance/exit. You can directly modify the entrance name and click [Apply] to

save the setting.

For the added entrance/exit, click ™ to delete it. Before deletion, please ensure that there is no lane information under it, or it cannot be
deleted.

® | ane Management

Click [Lane Management] next to the entrance name. This will bring a lane setting window. Click [Add] to add a new lane. Set the lane

name, lane type and temporary car release way (manual/auto release). After that, click [Apply] to save the settings.

® Binding ANPR Camera
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In the lane management window, click [Setup] of the linked ANPR camera line to bind the ANPR camera as shown below. Multiple

cameras can be bound to one lane.

Vehicle Monitoring Integrated Search Report Statistics Systern Setlings

Parking Lot Configuration Vehiche Group Management Block List Managerment Schedule Setting

Parking Lot +u v I Lane Management X
Main P — |vehicle access even If the parking space Is full
=
& main

T nt veticles* 101 [#1  Remaining Parking Space Nurnb
R Lanel z = =
Ao Bind License Plate Capture Machine *
1d ANPR Camera Linked ANPR Camera
O — ~ =
4 [ default area 5 |4 OPs
Ene| Lene Name* Lanel P gy o mlle

Lane Type* Entrance “ / 1 1P Camera 4 [ default area
: o | :
1 1P Camerad L3 IP Camera

Temporary car cpening method  Automatic release

+ N RES 3 < ¥
Linked ANPK Camera [l 1

Q

) Enable 485 Screen

O Cancel |
Linked LED Screen

Apply Cancel |

® Binding LED Screen

In the lane management window, click [Setup] of the linked LED screen line to bind the LED screen as shown below. One screen can be
bound to one lane only.

Lane Management

vehicle access even if the parking space is full

nt vehicles* 1016 |Z| Remaining Parking Space (

a Lanel Bind display
Lane2
d LED Screen Linked LED Screen
] O LED1
¢ Lane Name* Lanel <
Lane Type* Entrance
Temporary car opening method  Automatic release

I Linked ANPR Camera [PCIP CameraZekg
(o |

[J Enable 485 Screen

IP Camera5
Linked LED Screen >

More b4

® Binding RS485 Screen

In the lane management interface, you can also bind RS485 screen. Enable RS485 screen, select the screen type and then click [Apply].

Before binding RS485 screen, please ensure that the license plate capture camera has been connected to the screen via RS485 interface.
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Lane Management X

Lanel

Lane2

Lane Name* Lanel
Lane Type* Entrance

Temporary car opening method  Automatic release

Linked ANPR Camera IPCIP Camera

Enable 485 Screen

Type Car easy to pay LED scree

Test Welcome Send text

More rFs

Bind Vehicle Group All

® Binding Vehicle Group

In the lane management window, click “More” to bind vehicle group. Select the vehicle group as needed. Then click [Apply] to save the
setting.  All vehicles in the vehicle group bound to the lane will be allowed to enter/exit in the parking lot.

Vehicle Monitoring Integrated Search Report Statistics | System Settings ‘

Parking Lot Configuration | Vehicle Group Management Block List Management 9 Lane Management X

. Basic Configuration
@@ main Total Parking Space* 500 Lanel Inir

Lane2

Barrier Gate Opening Duration(s)* 15

Temporary vehicle timeout configuration

[J Enable overtime parking of temporary vehicles Em
Lane Name* Lanel

Entrance/Exit Setting Lane Type* Entrance

Temporary car opening method  Automatic release

Linked ANPR Camera IPCIP CameraZehg I

Enable 485 Screen

Entrance Name Entrancel

Lanel Entrance Autom

Type Car easy to pay LED scree

Test Welcome Send text

Lane2 Exit Autom

More -~ —

Bind Vehicle Group Al

Entrance Name Entrance2

:

Note: A parking lot can add multiple entrances and exits; an entrance/exit can add multiple lanes; a lane can bind multiple license plate
capture camera; but one license plate capture camera only can be bound to one lane of the entrance/exit in the parking lot. The name of the
parking lot cannot be repeated; the names of entrances/exits in the same parking lot cannot be the same; the names of the lanes in the same

entrances/exits cannot be the same.
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16.3.2 Vehicle Group Management

Go to Parking Lot Management->System Settings—>Vehicle Group Management interface as shown below.

Vehicle Monitoring Integrated Search Report Statistics System Settings

Parking Lot Configuration Vehicle Group Management Block List Management Schedule Setting

Parking Lot

2 &2 Main
- @ main

®  Add, Modify or Delete Vehicle Group
Add Vehicle Group:

Move the cursor onto the parking lot name and then B2 will be shown. Click this icon to add a vehicle group.

Click & to edit the vehicle group. Click 4 10 extend the remaining menu and then click ¥ o set the passable area of the vehicle

group and admission schedule.

Parking Lot C Vehicle G

n ! Block List Management Schedule Setting
Add car group x

i L
|
B @ main

\ Vehicle group name*

More v
Set passable area X
Add car group X

B &2 Main
- B aj Entrancel

Vehicle group name*
More @ #n Lanel(Entrance)
- $#a Lane2(Exit)

Passable Area* A / ;
- B 2§ Entrance?

Admission Schedule* 7424 #a Lanel(Entrance)

Reminder: Only valid for admission

Modify or Delete Vehicle Group:

Move the cursor onto the vehicle group name and then will be shown. Click this icon to delete. If there are vehicles added in the
vehicle group, it cannot be deleted. You must delete all vehicle information first and then this vehicle group can be deleted.

Move the cursor onto the vehicle group and then will be shown. Click it to modify the vehicle group name, passable area and
admission schedule. After that, click “OK” to save the settings.

o
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Vehicle Monitoring

Parking Lot Canflgurathon

Integrated Search

Repon Statistics

Vehicle Group Management

System Settings

Block List Management

Admission Schedule:?*24

Schedule Satting.

& g8 Main Passatle AreaMain
= m Unbind selected m Fie Import Export Template
| @ & main

762

2027-01-12

Biue

] N Small Car

Vehicle Information Settings
Add Vehicle Information: Select the vehicle group , click [Add] to add a new vehicle. Fill in the relevant vehicle information. The number

plate must be entered.

Parking Lot Configuration | Vehicle Group Management | Block List Management Schedule Setting
Parking Lot Al | Admission Schedule: :
Passable Area:Main Add new vehicle

2- & Main

Basic Setup

. ﬁn? main Number plate*

Name
O X] Phone Blue
Vehicle Type Small Car v
Vehicle Color Blue v
Description

[J Permanent validity period

Starting Time* 2022-01-13

[<PJ [P

2027-01-13

“ ca ncel

End Time*

Delete Vehicle Information:
Select the vehicle information and then click [Delete] to delete the vehicle information.
Note: If the vehicle information you want to delete is bound to other vehicle groups, it will be deleted too in other vehicle groups.

Bulk Binding: in the vehicle group management interface, select the vehicle group and click [Bulk Binding] to bind other vehicles to
this vehicle group.
Note: one license plate only can be bound to a vehicle group of other parking lots. It cannot be bound to other vehicle groups of the

same parking lot.
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Vehicle Monitoring ~ Integrated Search  Report Statistics | System Settings

Block List

Parking Lot Configuration

Parking Lot Nal | Admission Schedule:7*24

8- &@ Main Passable Area:Main - . . .
Bulk import (from vehicle registration) X

@ @ main S g

] Number plate Name Phane \

Vehicle Group Schedule Setting

Selectable o ‘Selected

o e

C 2000

ABC32

(m}

123ABC

?
~

Permanent validity period Starting Time: 2022-01-13

= EndTime: 2027-01-13 1= @ Cancel

File Import: Click [Export Template] to export a. cvs or .xIsx file. Then open the template, edit all vehicle information and then save

Click [File Import] and then select the edited file to import all vehicle information.

.cvs template file includes three attributes, including plate number, owner’s name, owner’s phone.

A B C D
(B1)Numbe¢ (B2) Ownei (B3) Owner s Phone
Al123456 Simon 11111111111

W= (L2 | D |

Xlsx file includes many attributes, including plate number (compulsory), owner, owner, phone, vehicle color, vehicle type and so on.

| 4 A B C D E F G H
1
2 Number plate | Owner's Name | Owner's Phone Description Vehicle Type Vehicle Color Start Time End Time
3 A123456 Simon <> 11111111111 Discription Small Car Blue 2022/01/13 2022/01/13
4
[S

also click & to unbind.

16.3.3 Block List Management

Vehicle Search: in the search bar, enter the key words to search the vehicle information.

Go to Parking Lot Management - System Settings—>Block List Management interface as shown below.

Unbind Vehicle: Select the vehicle you want to unbind and then click [Unbind selected]. In the pop-up window, click [OK]. This vehicle
will be removed from the current vehicle group. The vehicle information will not be deleted and the binding relationship between the
vehicle and other vehicle groups will not changed. This vehicle also can be bound to the other vehicle group of this parking lot. You can

Modify Vehicle Information: in the vehicle group management interface, select a vehicle and then click to change this vehicle
information.
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Parking Lot Configuration Vehicle Group Management Block List Management Schedule Setting
Block List Management v w File import Export Template

|
Add new vehicle X
Basic Setup
Number plate*
Name
Phone
Vehicle Type Small Car v
< Vehicle Color Blue v
Description
o]

Block list is created by default. Click [Add] to add the vehicle information. The plate number must be entered. The vehicles added to the
block list cannot be added to any other vehicle groups.

Select the vehicles and then click [Delete] to delete the vehicles from the block list. Import the vehicles to the block list is the same as
vehicle import to other vehicle groups.

Click to modify the vehicle information in the block list. Click [OK] to save the settings.
16.3.4 Schedule Settings

Go to Parking Lot Management—-> System Settings—>Schedule Setting interface as shown below.

Click [Add] to pop up schedule adding window. Click “Input Manually” to enter the start and end time. Then click “OK” to create the
schedule. Choose the schedule and then click [Delete] to delete the schedule. Click to modify the schedule. 7*24 is created by default
schedule which cannot be deleted.

Vehicle Monitaring Integrated Search Report Statistics System Settings

Parking Lot Configuration Vehicle Group Ma Add Schedule

Schedule Name & &  Inpul Manually Select All Reverse Clear All

06:43:00-1902:00 Input Manually Select All Reverse Clear All

06:30:00-16:57:00 Input Manually Select All Reverse Clear All

Input Manually Select All Reverse Clear All

Start Time  00e00:00

[7]

Wed.
End Time  00:00:00

N o]

<P

v
z | Input Manually Select All Reverse Clear All

Input Manually Select All Reverse Clear All

Input Manually Select All Reverse Clear All

o _

Input Manually Select All Reverse Clear All

—
OK Canced

16.4 Vehicle Monitoring

Click Parking Lot Management->Vehicle Monitoring. Then you can view the real-time lane monitoring video, vehicle passing information,

remaining parking space and so on.
16.4.1 Real-time Vehicle Preview

Drag the camera on the left panel to the preview window to view the real time video. 1/2/4/9/16 screen display mode and stream can be
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selected. Click to close all previews.

Report Statistics System Seftings 'n'

Wehicle Monltoring
Moni Paint _ | Vehicle Pass Information
Licerae Plate Pict

Teqm af Vasdity

4 -F

ES|E3RR{E3]FT) &=l

| Pass Recoed» Oniy display the cument preview window records . B Auto Retease B Manual release B Not releasad
s Tiene, UcemaFlate, | PassTypn.  ParkingTyps  Vehicko Type  Pakinglot Entrance Lana  LaneType g 35aces eropoxty vebies are et
2022-01-13 11:57:84 LE2TMO Mot released  Temporary Car Small Car AAAAMAA  Entrancel Lanel Ertrance m m
r i A Not reieased Temparary Car Small Car B Entranced i

Mot releassd Temporary Car Simalt Car @ current Parking . | B ﬂml;lw?ulli..
2022-01-13 11518 ITMGZ Notreleased  Tempeiraty Car Small Cae BRESEAR L Entrance & AAAAAAA Total Parking . [
-~ 100

16.4.2 Pass Records

Under the preview window, you can view the real-time vehicle passing records. If “Only display the current preview window records” is
checked, the system will only display the vehicle information identified by the camera that is playing in the preview window. If disabled,
the vehicle information identified by all cameras under all parking lots will be displayed. You can also filter the passing record by selecting
“Auto Release”, “Manual Release” or “Not Released”.

When the scrollbar on the right of the passing record area is in the top or bottom, the passing record may not refresh; when the scrollbar in

the middle, it will stop refreshing and the current passing record page will not change.

Venicle Monttoring | Integrated Search  Repoet Statistles  System Settings -3

Muonitoring Paint | LT Vehicle Pass Information
Q
B @ Anasaan
m g Entrancel
B s LaneliEntrance)
@ & Entrance?
| = @ eeppuss

License Plate Pict

[1]fz]fa]fe]fs) « ]
Fass Recordz Oy desplay the cunent preview window records B Auto Release B Manual refease B Notieleased
Pans Time Gconse Flatn Pass Typw | Parking Typn| | Vebicle Type.  Parkinglot  Entrance  Cone|  Lane Typa | | No parking spaces, 1emporary venicies are pronit
2022-01-13 11:57:44 12TIA0 Not released  Temporary Car Small Car ARARAAN Entrancel Lanel Entrance
o]
2022-01-13 11:57:44 PUT245 Notreleased  Temporary Car Semall Car BHSBEEE Entrance? ntranc

o
ITMOZ.  NoUreleased  Tempcran Car Senall Car 108REED Entiance &2 current Parking . & Remaining Parkl.

Temporary Car Small Car BREEERD Entrance o ARAAAAA Tota Parking - [

>

16.4.3 Pass Information

On the right panel of the vehicle monitoring interface, it shows vehicle passing information. In the current area, you can view the vehicle
image, license plate, lane type, vehicle type, term of validity, enter information and the vehicle status. You can also modify the information

of vehicles unreleased (or manually released), including license plate, vehicle type and so on.

Select a preview window and then the passing record area will refresh the vehicle information identified by the camera; Select a passing
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record, vehicle pass information area will display the selected vehicle information and the passing record will not refresh. Re-select the

preview window to continue refreshing.

Vehicle Manlioring | Inegiated Search  Repont Statlstics  System Seftings .
= 1 [ ] —— e i — 7 T [TenTcle Pass intormanen ]
Monitoring Point ~ s g \ . 5 T
s License Plate Pict...
Bl > o ! g ; A -— -

B @ ananman
o a1 Entrance]
5 #n Lanel{Entrance)
M g Entrance?
| '@ &8 BBBBERE

License Plates ¢yqeap
Parking Type: Temporary Car
Vehiche TYpe conap Car

Pt T 2022-01-13 120458
EBBBBBEE_Entrance? Lin.,

Exit

Term of Validity: Null

[Enter Information

No entry information matched

A

| Pass Record> LI Only display the cument preview window records B Auto Release B Manual release B Notreleased
Pass Time ticense Plale  Pass Type | Parking Type | Vehicle Typs'  Parking Lot Enirance Lane Lane Type ) remparary car, automatic release
2022-01-13 115744 112TM0 Nolreleased  Temporary Car Small Car ARBAAAR  Entrancel Lanel Entrance
- Manual el Modity infee._
2022-01-13 115744 PUT245 Hotreleased  Temposary Car Small Car B8BBBEE Entrance? Entrance
@ current Parking .. X Remaining Parkd..
2022.01-13 1200:36 CH1688 Auto Release  Temparary Car Small Car AABERER Entranci2 ' it
2022-01-13 115744 2102 Notreleased  Tamgorary Car Small Car UOBER0E i Entrance i ARAAAAA Total Parking .. [#
o~ 100

On the lower right of the vehicle monitoring, it is remaining parking space display area. You can select the parking lot as needed. Click
to select the parking lot you want to display and then edit the total parking space and remaining parking space. Please make sure there
is no vehicle entering or exiting before modification in order to guarantee the accuracy counting of the remaining parking space.

16.4.4 Search Pass Information

In this interface, the information of the vehicles entering and exiting the parking lot can be searched.
Set the filtering condition, such as the start and end time, license plate, vehicle type and lane. Click [Search] to search the records.
Click a passing record and then the corresponding license plate image will be displayed on the right. You can zoom in and download it.

At present, up to 3,000,000 passing records can be stored and 120,000 vehicle passing images can be matched to these passing records.
To modify passing record: select a passing record, click [Modify], select the vehicle type and click [OK].

To export the parsing record, search the desired passing record and then click [export] to export the records to the specified file named
after “Integrated Search + data” (eg. Integrated Search_20220112_11233555). The export file is .xIs file.

Venhice Monitoring | Integrated Seatchy | Report Statistics  System Settings -3
o cl "~ -
Integrated Search St Tine 7077-01-13 000000 ~o-  End Time 7073-01-13 735859 (| License Plate ] pass picture
Pass Info. 1 I T
Vehicle Type Al Type of Parking Al Pats Type: Al Parking Area AAAAAANBEEERER A L
Overdue Parking
[ ovon |l wosiy |
N - Pass Time Licerse Plate  Passing Parking Lot | Entrance Lane Direction  Wehicle Type  Type of Parking | Operalor
2022-01-13 120811 168 BHEEEES Entrance Small Car Temparary Car admin
2 0220013120811 0 AABALRA Entrancel Lanel Entrance Sl Car Temparary Cat adein
2022-01-13 120810 28K BEABSNA : Eait Srmall Car Tempatary Car admin

16.4.5 Search Overdue Parking

In this interface, you can check the information of the vehicles which stay in the parking lot longer than the predefined parking duration.
Before searching, please make sure you have enabled overtime parking of temporary vehicles in the parking lot configuration interface.
(Click Home—>Parking Lot Management->System Settings—>Parking Lot Configuration)

16.5 Report Statistics

Go to Parking Lot Management->Report Statistics interface. In this interface, vehicle flow statistics of all parking lots can be searched and
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viewed via line chart, bar graph and pie chart.

Vehitle Monitaring Integrated Search Report Statistics Systern Settings
Parking Lot w
|| Traffic Flow Statistics Granularlty  Enance Fxpart Excel
C
BB ARAAAAA
B &) Entrance]
=1 Entranced
& [l & spssass

1168 o

The Total Vehide Of Enter The Total Vehicle Of Leave

dl Traffic Flow Statistics 8 Entrance® Exit i

240

fleport Type ¢+ Dialty Repon
Date: B F

On the left panel, select the parking lot and entrances/exits you want to view the statistical information. Then select the report type and
data. Click to select the desired date; click & to select the date range. After that, click [search] to display the statistical information.

a

The Total Vehicle Of Leave

Traffic Flow Statistics

240 -

B Entrancel Exit il

11:00-12:00 |

—— EntrancelEntrance 194 |
160 = N

The default granularity is “Entrance”. You also can select “Parking Lot” and click [Search] to refresh the vehicle flow data. The

report type, time and granularity will be shown on the top of statistical information. The total number of vehicles entering or leaving can
be viewed too.

Click % to view the data statistics in the line chart; click il to view the statistics in the bar graph. You can view the entrance or
exit information as needed. Put the cursor on the statistic chart/graph to view the detailed information.
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Parking Lot w |
) I
W B aaaaaa 160}

8 A1 Entrancel

w
B EntrancelEnfrance B EntrancelExt
Proportion of Vehicles Entering Proportion of Vehicles Leaving
® Evmamcrl ® Envance]
Raport Type R
Daie: @ M
L e PRI aian

Export: You can choose to export Excel or image as needed. Click [Export Excel], select the path and then click “Save” to export the
files(.xls). The file name format is “Report Statistics_ Date”.

Click [Export Picture] to export pictures (.png format).
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17 Body Temperature Measurement

17.1 Add Temperature Reading Devices

This platform supports thermal network camera and temperature measurement panel access.
1.Click Home—>Resource Management->Add, Edit or Delete Device=>Encoding Device to go to the encoding device interface. Click
[Add] to add the temperature reading devices.
2.Click Home—>Resource Management->Device Setting to go to the device setting interface. Select the temperature reading device
and then click the “Thermal imaging settings” tab to enable temperature measurement function.
3.Set the temperature unit, high temperature threshold and low temperature threshold (different devices may have different settings).
4.Click [Apply] to save the settings.

Device Setting Area Setting

17.2 Temperature Screening
17.2.1 Configuration

1. Click Home-> Temperature Measurement->Live Preview—> L go to the following interface.
2. Set the temperature measurement parameters as needed.

Live Prreview Search Statisties

Manitoring Peint N o B =
Contgraion

Abnormal temperature threshold: please set the value according to the actual condition. When the temperature detected is over than the

set value, alarms will be triggered.

Record validity: Set how long the platform will keep the temperature records. If it is enabled, the temperature records will be cleared

beyond the set days.

Pop-up automatically: if enabled, the abnormal temperature alarm processing box will pop up automatically. Additionally, you can enable

“Pop up non-mask alarm box” as needed.
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Data Display: you can choose “Hide normal data”. That is to say, if the temperature of the person scanned is normal and the mask is

detected, these data will not be displayed on the client.
Data Reset Settings:

a. Reset time and type: please reset time of the temperature data as needed. These data can be reset every day, every week or every
month.

b.  You can reset the statistics by clicking [Reset].
Data sources of Temperature Reading Tablet: including comparison data and detection data. If comparison data is selected, the platform

will receive the temperature reading result and face comparison result; if detection data is selected, the platform will receive the

temperature reading result and face detection result, but it is not sure whether the person is matched with that of the face database

Voice Prompt: Please set the over temp voice prompt and non-mask voice prompt as needed. When no mask or elevated temperature is

detected, the set voice prompt will be heard.

17.2.2 Live Preview

Drag the thermal cameras/temperature measurement and face recognition terminals to the preview window. In this interface, you can view

various statistical information, such as total pass-by(today/total), Over-temperature(today/total), mask off (today/total), etc.

Live Preview Search Statistics #
onii " s
I =y
Q —
= () default area (Online/Total n... |[B e 3 570872020 11:51:23) | Abnormal record P

B IPC

& Mask Off

1PC

08-05 11:26:39

1PC166

09-04 00:48:33

Descriptions

@ Camera list, including temperature measurement terminal/panel and thermal
network camera.

® Preview Area; drag the camera to the preview window to play.

® Statistical display area, including such as total pass-by counts(today/total),
Over-temperature counts (today/total), mask off counts (today/total)

@ Pass-through records (snapshot display area)
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® Abnormal record display area, including mask off, over temp

® Snapshot statistics in recent 7 days

Putting the cursor on the snapshot picture appears a “+” icon. Click this icon to add this picture to the group of the face database.

W Default Group

The default is the device bound to the target distribution Group

L ox_Jcancel

The thermal image and visible light image will be displayed simultaneously if the thermal camera is dragged to the preview area. Right

click on the thermal camera window and then select the fourth stream to view the thermal image as shown below.

oY

= 0
8/ ey 13:37:04Lh
| p’ -

Pass-Through Records B

S~

»  Alarm Handling

Click the captured image on area ® to pop up an alarm handling box as shown below. You can edit the personal information, including

name, phone number, ID number, address, whether to go to the infected area, etc.

Click “+” on the top right corner of the snapshot image to add it to the group of the face database.
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Alarm Handling X

Snapshot Camera 214.75.222 37777 Snapshot Time 2022-01-13 14:34:09
Temperature i Suspected Over Temp  Yes

Mask Status Undetected Infected Area

Status Name

Phone Number ID Number

Address

Remark

Pop up Automatically @D

Pop up automatically: if enabled, the alarm handling box will automatically pop up on detecting an abnormal event (over temp/mask off).

»  Full Screen Display

In the temperature measurement interface, click E to enter temperature warning system interface.

i) 794

20210204

Click to exit the full screen mode.

17.2.3 Record Search

Select the camera and then set the filter condition (like the start and end time, temperature range, keywords, etc.) to search the records.
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Live Preview Seanch Statlstics

#

B B Q) detault area (Online/Total n.. m

1 No P 2027-05-18 152317 E

368°C Mask On

Stat Time 2022-05-18 00 =

End Tima  2022-05-18

8

Range Al

Mak Status A

Status
Infected Area Al s
Recognition Success Al

Keywords ¢ ¥

14 # The 1 /1Page ¥ b| PerPage S0 o Entry 1-1 Totakl

In the above interface, you can view the target picture and the original picture, body temperature, mask status, alarm handling status, etc.

17.2.4 Statistics

In the statistics interface, you can view the total pass-through counts, abnormal temperature counts and mask off counts.

Live Preview  Search | Statltics ﬁ

Monitoring Point

@ 8 @ 1(Online/Total number2/2) Pass-by (Total):984 Abnormal Temp:71 Mask Off: Curve Chart
[ &y IPVE (Onidine/Total number0/0}
O @ Wit (Ondine/Total numbariidg) 312
Cl 6 default anea (Online/Total numbery) ~*= Pass-by (Total) == Abnormal Temp Mask Off
0o Tine/Tatal number0/0)
260

208

156

People/number

104

ReportType:  Daily Report
pate: @@ 222011 Statistics by Camera

DN .

-y
. Click it to switch between date and date range.
Choose the camera and then set the start time and end time. Click “Search” to view the statistics.

You can view the statistics via a line chart or bar graph. The statistical data can be exported by clicking “Export”.

124



18 Industrial Temperature Measurement

18.1 Thermal Network Camera Settings

Click Home—>Resource Management->Add, Edit or Delete Device>Encoding Device to go to the encoding device interface. Click [Add]
to add the security thermal network cameras.

Add, Edit or Delete Device Device Setting Area Setting Channel Group Setting

Device Type @ Select Area Select Transfer Server Select Storage Server Upgrade _
a

Encoding Device (Online/Total number:9/14
Decoder (Online/Total number0/0) Edit Device Name Type Channel Number ~ Alarm In Number  Alarm Out Number [P 4
Alarm Host (Online/Total number:0/0)
Access Control System (Online/Total numbe| ~

PCa azfehg Standard Dev 1 1 1
LED Display Device (Online/Total number:0, D e core e

Intelligent Analysis Server (Online/Total nur

0O O O O ps

Storage Server (Online/Total number:1/1)

r/\ P Camerab Standard Device 1 1

18.1.1 Temperature Measurement Settings

After adding the security thermal network camera, click Resource Management->Device Setting—>Temperature Measurement
Configuration to go to set the temperature measurement parameters.

Add. Edit or Delete Device Device Sefting Area Setting Channed Group Setting
Encading Device [Vl stream Setting Privacy Mask Setting RO\ Setting Matlon Detection Motion Alarm Linkage Line Crossing Detection Intrusion Fire Detection

& @ 123 (OnlineTotal number2i2)
o & e tem

s
Industrial tam

B A AT

W @ default area (OnfineTotal nurmib..

- I

White
Black
Ralnbow coding

Fed

Color Type: White/Black/Rainbow coding/Red

Restore: Click it to restore the set image to the previous image.

18.1.2 Temperature Alarm Settings

In the device setting interface, select the security thermal network camera and then click the temperature alarm tab as shown below.
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Add, Edit o Delete Device Device Setting Area Sefting . Channel Group Setting
uslon Exreption Detection Vigliant Face Detection Target Counting Reglon Entrance Reglon Exiting Fire Detection £ Alarm

Q1 B Enable Temperature Alarm
Gy 1 (Oniine/Total numben?/7) . - g
F £ IFVE (Onfine/Total number/2) i
M- @) NVR (Gniine/Total numberl/1) a Ruiber] Arwa 006 23 o [—_/|
8 [ default area (Onfine/Tokal me.. : /
M 102141333.9008 e Fies s b 5 8 [
S 0 Rute3 Paint 09 05 0 4
# 102144046 9008
M 10.214.47.208 9008 0 Fiuted Point 096 03 ] [
# 102144988 9008 ; _
» 107144089 (=] Fuiel Line 096 01 ] [__/l
& 1021455759008 a Puies Line 096 0l 0 r/|
oo S
- P ia7 g L] Rule? hia 0% 0 0 [T/l
o8 1P Camera
i Cottir 5] Ruted Paint 096 05 o ~
S 2 2 o s . :
S D Camacad

Enable temperature alarm.

Set the rules. Up to 10 rules can be set.

Double click rule name, type, emissivity, distance and reflective temperature of each rule to modify them.
The rule type includes point, line and area.

Edit: set the alarm rule.

Alarm Rule X Alarm Rule X

Alarm Rule Above(Average temperature) % Alarm Rule | Above(Average temperature) W

2
Alarm Temperature  0.00°C L TR Above(Average temperature)

Alarm Output B Output1 B Output2 Alarm Output Below(Average temperature)

After the above alarm rules is set and temperature alarm is enabled, set the alarm linkage items of monitoring point-temperature alarm in

the alarm linkage interface. When the detected temperature exceeds the set threshold, the related alarms will be triggered.
Start Draw: select the type and then draw on the image.

Clear: clear the drawn point/line/area.

Schedule: Set the schedule of temperature alarm.

Alarm Setting: Set the alarm of the IPC.

18.1.3 Fire Detection Settings

In the device setting interface, select the security thermal network camera and then click the fire detection tab as shown below.
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WAl on Detection Motion Alarm Linkage Line Crossing Detection Intrusion Fire Detection

Add, Edit or Delete Device Device Setting Area Setting Channel Group Setting

Encoding Device
(D) [ndustrial ten

H- @ 123 (Online/Total number:2/2)
=- @ Industrial tem

:
i E- @ RTSP

- ) default area (Online/Total numb...

Schedule Alarm Setting Apply JEEELERIE

Schedule: set the schedule of fire detection, 7*24 by default.
Alarm Setting: set the alarm of IPC.
Apply: Click it to save the settings.

Enable: Check it to enable the fire detection function.

18.1.4 Alarm Linkage Settings

Click Alarm Center-> Alarm Linkage Settings—=>Monitoring Point-Fire detection alarm
Enable the alarm linkage items, like record, snapshot, alarm output, etc.

When the detected temperature exceeds the set threshold, alarms will be triggered.

Alarm Log Search Alarm Linkage Settings Schedule Setting Manual Alarm Out S0P Sening Alarm Task Sentings Ermall Sertings SIRA Adarm Setting
Alarm Type Monitoring Point-Fre detection atam m - j I ._ i n Q
© Meme  Awhe v PRZComol v Reod v AlmmPrviw v Sapol v AmOugut v VokeBosdkas v OpenDoor v TVWal v
A Inclustrial tem v | OFF OFF OFF OFF OFF 0FF oFF oFF oFF
RTSPRL CANOOT 7 OFF OFF OFF OFF OFF OFF OFF OFF OFF

18.2 Temperature Measurement
18.2.1 Video Preview

Go to the video preview interface and then drag the thermal camera to the window to play. The default video stream is the fourth stream
(thermal imaging stream). You can switch the stream under the preview window. The temperature measurement rule and the current

temperature will be displayed in the image. When the temperature alarm is triggered, they will turn red.
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Vido Previow Data Analysis Search

2022/01/713 14:36:45

Menitoring Point ¥ Industrcial tem
Q

|
B @ 123 (OnlineTotal mumbes:1/1)

£ default ares (Onling/Total numb,,,

T (1) 22 (1) (5] (3] ) =

18.2.2 Data Analysis
Select the data analysis tab to enter the following interface. Select the temperature measurement rule (multiple rules can be selected) and

click [Apply] to view the real-time temperature reading results and image.

Preview [ata Analysis. Search

Q

T 841z onne/ton umbenl/l | Real-time Temperature Plot
= |

0 & default area (Online/Total nu 50

053 0440

Temperature measurement settings: Click L to open the temperature measurement setting window. You can choose whether to

display detection rules and real-time temperature, set sensitivity and temperature rise alarm.
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Temperature Measurement Settings %

Display Detection Rules D
Display Real-time Temperature ()

Sensitivity

~

0.50°C
Temperature Rise Alarm t)

Alarm time setting for abnormal temperature change(s)

-~
L

Abnormal Value of Rise
0.50°C

T JeEm

You can set the alarm linkage items of temperature rise alarm. When the rise of the temperature exceeds the set value, the relevant alarms
will be triggered. Go to Alarm Center->Alarm Linkage Settings interface and select “Monitoring Point—Abnormal temperature rise” to set

the alarm linkage items.

Note: At present, the system will detect the temperature every 10s. If the temperature goes up 0.1°C every one second, the temperature will
rise up 0.5°C after 5 seconds, but alarms will not be triggered immediately. Alarms will be triggered when the temperature rises up 0.5°C

or higher after 10 seconds.
Different colors stands for different temperature measurement rules. You can view the temperature reading results.
Statistical type: Maximum/average/Minimum temperature.

Show dots: if enabled, the statistical temperature plot will show the dots as shown below. Put the cursor on the dot and then the detailed

data will be displayed.

Video Preview | Data Analysie | Search - 3
Maenitaring Paint Lvs
Q

9 B a 121 Onine/lotsumbes’/ )| Raal-time Temperature Plot Maximum temperature | Shew dots (@) @

7 cefault sres (Online/Total n 50

—— . &

2 | 13:2T:8
2 ] il s | ]

Temperatura/*C

[37: Clickit to export the temperature measurement data to the specified file.

Refresh Rules: Click it to refresh the monitoring points and then select the desired rules

Apply: After you select rules, click it to view the line chart.

Real-time Preview: click I on the right to extend the video preview window. Select a rule on the left monitoring point panel, this rule

will be highlighted. Click any point in the preview window to view the real-time temperature.
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Note: Dual lens thermal cameras don’t support temperature reading by clicking any point.

Lidustrial ten 2022401713 14=d0:31

28:68°

18.2.3 Record Search

Click Industrial Temperature Measurement->Search to go to the following interface. Select one or more rules, set the start and end time

and click [Search] to view the temperature data.

Video Preview [iata Anabysis Search ‘#
L coon |
] 23 {Onling/Total numben1/1} ik e ; Mﬂmﬁlg l’dﬂl Nm et M o
1ty defauly ares (Online/Total nu.. 111 1441:50 ndistriol term 2457 249500 10
8 2022-01-13 144148 3325 3455°C 3535°C 10
9 P022-01-13 10:40:28 21.75°C 2175°C 2175°C
10 2022-01-13 143907 21.255C 21.25°C 2128 !
1" 2022-01-13 143857 2335°C 2335'C 2335°C 5
12 13 143816 rcdust Z1A5C PLASC 2145°C 9
13 20 1 36 ndustrial tem 2195*C 2195%C 2195°C 9
5 14 20220113 143726 Industrlal tem 2175'C 2175 21.75°C 1
15 H022-01-13 143605 2385C 2385°C
15 2022-01-13 1434114 21B5°C 2188 3
17 2022-01-13 1433:24 20.95°C 2255°C 24.45°C 10
16 2022-01-13 1433114 indusstrial em 2085°C 275'C T 10
19 2022-01-13 14:32:34 indusirial tem 21.35°C 2}35°C 21.35°C
20 13143204 21.25°C ik d 2135°C
2 2022-01-13 143204 ndusirial tem 23357 2335% 23.35%C
tart Time 2072-01-13 3
e v 017 22 20220113 142831 industrial tem 2145°C 21.45°C 2145°C L]

“ 14 # e 1 [390Page W Pl Perage 50 Entry 1-50 Tatal: 43477

Start/End Time: The end time shouldn’t be earlier than the start time.
Export:  Click [Export] to export the temperature data to the Excel file as shown below.
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A B c D E E G
7 6 2022-01-13 14:41:59 Industrial tem 21.25°C | 21.25°C | 21.25°C | 7
8| 7 2022-01-13 14:41:59 Industrial tem 20.85°C | 22.45°C | 24.35°C 10
g | 8 2022-01-13 14:41:48 Industrial tem 33.25°C | 34.55°C | 35.35°C 10
10 [ 9 2022-01-13 14:40:28 Industrial tem 21.75°C | 21.75°C | 21.75°C 7
ul 10 2022-01-13 14:39:07 Industrial tem 21.25°C | 21.25°C | 21.25°C 7
2l 1 2022-01-13 14:38:57 Industrial tem 23.35°C | 23.35°C | 23.35°C 5
S RE 2022-01-13 14:38:16 Industrial tem 21.45°C | 21.45°C | 21.45°C 9
1 13 2022-01-13 14:37:36 Industrial tem 21.95°C | 21.95°C | 21.95°C 9
157 14 2022-01-13 14:37:26 Industrial tem 21.75°C | 21.75°C | 21.75°C 7
15 15 2022-01-13 14:36:05 Industrial tem 23.85°C | 23.85°C | 23.85°C 5
17 16 2022-01-13 14:34:14 Industrial tem 21.85°C | 21.85°C | 21.85°C 6
1w 17 2022-01-13 14:33:24 Industrial tem 20.95°C | 22.55°C | 24.45°C 10
1] 18 2022-01-13 14:33:14 Industrial tem 20.95°C | 22.75°C | 27.75°C 10
20! 19 2022-01-13 14:32:34 Industrial tem 21.35°C | 21.35°C | 21.35°C 6
n| 20 2022-01-13 14:32:04 Industrial tem 21.25°C | 21.25°C | 21.25°C 7
»n! 2 2022-01-13 14:32:04 Industrial tem 23.35°C | 23.35°C | 23.35°C 5
23| 22 2022-01-13 14:28:31 Industrial tem 21.45°C | 21.45°C | 21.45°C 9
22 23 2022-01-13 14:28:11 Industrial tem 21.15°C | 22.15°C | 23.75°C 2
5] 24 2022-01-13 14:27:30 Industrial tem 21.95°C | 21.95°C | 21.95°C 4
6 25 2022-01-13 14:27:09 Industrial tem 20.85°C | 22.65°C | 24.55°C 10

Delete: if the rule is deleted, all historical temperature measurement records under this rule will be deleted too.

Video Preview Data Analysis Search ﬁ
Monitoring Point R
= No. Time Mondtaring Paint Name Aura
Industrial te
L3 i B i) Indusiri, ] 10
n 2022:11 2125 F135°C 2175°C
B3 1 -4 o El [
_— & _"‘- Dedeting rubes will defete history reconds togather
E 12 2022-0 Do you wanl to delets? 2145"C
B E
- B i 13 2027-(1 21957C 2195°C )
B W 3
14 e 2175°C 21757 T
@ default area (Online/Tatal mu. - “ Canced 3 =
15 P02 Brmrarremrors B 2IBEC 2285°C 2385°C
16 2022:01-13 14:34:14 Irdustrial tem 21B5°C 2185°C 21554 &
17 Industrial tem 2445
8 i 275 0
14 Industrial tem 2138
20 2022.01-13 143204 Incusrial tem 2125 2135 7
2022-01-13 143204 Indlustrial tem 23.35°C 23.36%C 23.36%C
Start Time
fusea 2 2022-01-13 14:2831 Industrlal tem 21.45°C 2145°C 25457C
End Time
14 # The 1 fS90Page W bl Per Page S0 Entry 1-50 Tatal: 40477
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19 Target Counting

19.1 Task Management

1.  Enable “Target Counting” function of the IPC.

Note: the added camera must enable target counting function.

IPC with Target Counting function

Add, Edit or Delete Device

B (31 default area
ak
£ Device Name
- @ IP Camera
5 IP Camera
- (3 IP Camera0l
- (% IP Camera02
- 8 IPC
& IPC

-0 B H B @ e

& oo

Device Setting

Encoding Device Al
yarch Q

Area Setting

in Intrusion Exception Detection

[P Cafnera0Z

¥ oN

Alert Line Direction

Channel Group Setting

Privacy Mask Setting

(@ save Panoramic Picture [0 Save Target Cutout

Motor Vehicle Sensitivity Detection

& Human Sensitivity Detection

& Non-motor Vehicle

Sensitivity Detection

ROI Setting

| Target Counting |

50

50

Preset Setting

50

2. Go to Home—>Target Counting interface. Clicking on # enters the following interface. Double click the camera with the target

counting function and then select “ON”. After that, click [Apply] to save the settings.

Real-time Statistics Histarical Statistics

Monitaring Point v

Heat Map

Flow Contral

a| Flow Statistics

@ T £ 1 [Online/Total number2)
O gy V6 (Online/ Total numbert_

o 1 G NVR (Online/Total numberd...
T G default area (Online/Total n. Statistica

O 6y L, (Onkine Total numberd_ Manitor|

Total

1 Statis

e Y [
_ 8

Compared to the same period Yesterday

Task Management x

Hurnan

Auito Refresh Interval:

=gy 1 {Onbine, Total numberd10)

W 1021475222 3777
W 1021475222 37777

W 113 0P Cameral13113
113 0P Cameratest
- P
- 1P Comerats y
-7
ul
-
@) 1PV6 {Dnfine/Total numberd/L)
£ WVR (Online/Tatl number:2/4)
£ defautt area (Ontine/Total num...
[A] Ine/Total numberD/1)

Vokce alam alert.  Please wail

aN

Entrance

Apoly

od Yesterday

19.2 Real-time Statistics

Go to Home->Target Counting->Real-time Statistics. Double click the camera with the target counting function to view the live image.

®

1 minute

0

Insicle

The camera will automatically count the number of people/motor vehicle/non-motor vehicle crossing the predefined line and the system
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will automatically analyze the traffic flow trends.

Before view the statistics, please go to Home—>Resource Management->Device Setting—>Target Counting interface to set the alert line,

entrance/exit, detection target, etc.

Real-time Statistics | HeatMap  Historical Statisties. Flow Cantio ﬁ
Manitering Point L
Q Flow Statistics Compared to the same period Yesterday Human st Refresh Intervak 1 minute C E

B 8 4 1(Online/Totasl numbend/4)
B8 w112 1P Camera

0m P Date: 2022-01-13
B o iz
= Ny
Oy 1PV (Oniine/Total numberd._ |
B O @ NVR (Online/Total momber0l...
= Device Namedg53 1 1 a,
z : -14.46% 1388
O @ default area (OnliveTotal n..
O {Online/Total numberd... Total NO.IN)Human Compared to the same period Yesterday Total Exiting/Human

1 Statistics of Total Traffic Flow -

53

440

Husman

Please select the type as needed to view the flow trend. Click |Q\ to refresh the current statistics.

Set the auto refresh interval: The system will automatically refresh the statistics at regular intervals.

Date: 2022-01-13
Statistical Type: Human
Monitoring Point 113 _IP Camera; IP; . .

-14.14% 1389 -11.25% -314

Total NO.(IN)/Human Compared to the same period Yesterday Total Exiting/Human Compared to the same period Yesterday Inside
Statistics of Total Traffic Flow ~ ey [ihy
528 -
440 -

352

264

Hurman

176 -

88

00:00 01:00 02:00 03:00 04:00 05:00 06:00 07:00 08:00 09:00 10:00 11:00 12:00 13:00 14:00 15:00 16:00 17:00 18:00 19:00 20:00 21:00 22:00 23:00 24:00

In the above interface, you can view the statistics of people/vehicles entering or exiting. Scroll down to view the traffic flow statistics via

pie charts and tables.

133



Proportion of Human&Vehicle Entry in Each Channel

Target Counting Table(Human)

Device Name4653,
1

Flow:840.00
Proportion:77.99%

® (® 113 IP Camera
*® P

® ® AR
® (® Device Name4653_1

Lzl

41/1p

Proportion of Human&Vehicle Exiting in Each Channel

® (® 1131IP Camera
L O ]
®
() Device Name4653_

41np

19.3 Heat Map

Go to Home-> Target Counting—>Heat Map interface.

Please create a map first.

Real-time]

otal number3/10) Office o
-0 1021475222 37777 =L
-% 1021475222 3777 n
™9 113 P Camera Engineering Conference Elevator
Department Reom ‘kEu\ Front
=9 113 1P Cameratest Door .I_
-9 P I_ —————— Comidor— — — — ‘_R;e_ "— -
-‘v 1P Camerads | I ‘ D-skpbo g
— Conidor I CGonference | Conferench Domestic |
s = | Room Room  fservice | Fommerds | M2rketing | P
-0 | Department ook,
@ 1PV (Online/Total number0/1) ) |
( NVR (Online/Total number:2/4) Test | | Lobby
@ default area (Online/Total num... Department | ]
@ 4 (Online/Total number0/1) i ! !
I |
| I |
—————————— - — — — Comidor — — — — —
Corridor —
113IP Cameral13113
Sensor
Internetional R General
Subsystem RAD Department Financial Marketing Manager
" Room
Warehouse
B
\,_,, Q F8[Reet] |

Drag the camera with the target counting function to the specified area.

Put the cursor on the camera icon and then you will see the detailed flow statistics.
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Map Management W

o Flow Summary Statistics

Human

Tatal Now(IN) Auto Refresh Tnterval: | 1 minute C
5521
Tatal No.(IN) Total No.{OUT)
3518 3286

Max. Daily Mumber (Inside)

Current Number (Inside)

B &1
&2
‘ Office
i We We Canference
Enginsaring e
Room - aor
Department Female Male | | | Xe | From
~ Comdor— — — — — — — — — — Comldar— — — — - — 0 _®
Recepticn
-1 . Desk
- "n Confarence | Confarency Domastic
o Marketi
Reom oo ] 1
1 ) Service | Comeerss | poparment Goidhe
Test 4653 1P166 1 Lobby
Department \ Prchasing
\ Dpparimant
1 [
Aaan Cameratest — — — — — — — = = = = Comidor — — — — —
10204 TRidRS {777, 113 1P Cameral13113 ——
Test Room 6
Internetianal General
R&Dl}g Financial Marksting R Managsr
P P Room
B IFC B Smart IPC |
O Subsystam O Zone
O Sensar O Door

The deeper the red color is, the more targets (human/vehicle) gather there.

19.4 Historical Statistics

Go to Home—>Target Counting->Historical Statistics. In this interface, the statistic results in a long period of time can be searched which

Traffic Ranking of Each Menitoring Point

Ranking  Monitoring Point Name mm| lehwl

1 911 »
2 96 @
k) 113 IP Camerall3113 @
4 Device Mame4853_IP166 [ O]
5 113.IP Camera ®»
6 113 1P Cameratest 0 @

1021475222 31777 O]

can be shown in the table or curve chart. Additionally, the statistics of different targets can be viewed here.

Real-time Statistics Heat Map

Manitoring Point v
Bl - 1 coninestotal numbenda)
00}

L) &y BPVE (Ondine/Total numb }

m O G) Nt (Oniine/Total numbani/1)
LI & default anea (Online/Total mumbery D)
1 2y 2891 (Online/Total numbend/0)

Histoeical Statistics

Flow Contral

a| Traffic Flow Statistics

Date : 20,

Statitic Type : Human

Report Type ; Daily Report

Monitoring Polnts : 113_iF Camera; IF

2263

Total NO. (N)

Statistics of Total Traffic Flow -

Average traffic flow of each

wazi-
Statistic Type = Human ?assr
Report Type ©  Duily Report
Date: 13 B o0 ezas!-
B Fter Channel ‘

19.5 Flow Control

channel

5876

Total NO.

{ouTy

Averige waffic flow of each channel

-]

Export Pleture

3178

Irvsiche

1469

iy

Flow Control: Control the people/vehicles entering or exiting in a specified area to avoid overcrowding. When the people/vehicles stay in

the specified area exceeds the threshold, the alarm will be triggered and no entry icon will display.

Click Home—>Target Counting—=>Flow Control to enter the following interface.

Click to add a task. Multiple tasks can be added as needed.
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Real-time Statistics Heat Map Historical Statistics Flow Control

Task list
_ Add Task =
Task Name Task 01
Maximum Threshoid
o Type
Schedule
Selectable Dovice Selected Device
L ‘ >
113.IP Camera <

1P

4 O MR »
Device Named653 1 (<
(] Select All Reverse Clear All “ Cancel

Then the available number and inside number can be viewed as below.

Task 01 MW= <[-
Available
Inside
0

Click -0 to view the quantities of the people/vehicles entry and exiting.

iy |
Click =" to enter the flow control preview interface.

Person Flow Control

Task 01

Allowed Occupancy

Current Occupancy

2285

Click u: to view the access status and the allowed/current occupancy.
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Person Flow Control

Task 01

Allowed Occupancy

Current Occupancy

User Manual

In the above interface, you can switch the camera and view the image. When the people/vehicles inside exceed the threshold, the icon will

turn red.

Click on exits the current page.
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20 Evacuation System

The host status, MICs status and EM MIC status of the evacuation system can be viewed in the platform after the evacuation system is
added to the platform.

1. Before using the evacuation system, please make sure whether the access server is online.
Go to Home—>Resource Management->Access Server. There is a default access server which can be modified. Please confirm its online

status. A new access server can be added as needed by auto search or manual adding.

Add, Edit or Delete Dovice | Device Seting Avea Sefting  Channed Group Sefting

Lo [ ]

Acceas M43 oo

(Encodineg Device (0n@ne/Total rmberd/a)

Decoder (Online/Tetal numbent 1)

[ Alsern Hent (DnlineTetsl nussber1/1] o
| Access Control System (Omiine Total number0/T)
LED Disphay Device {Dniline/Totad rumber/m)

5 m
{Stcsage Sesver (OnsneTotal mumbecs) CuickiyAdd | Manually Add Server Quantited m

vrlsieip bt _—-_

| hccess Serves [Online/Total numbes:1/1)

Add Access Server

L2uian ot

2. Go to Home->Resource Management->Evacuation System interface. Add an evacuation system by clicking [Add].

Add, Edit or Delete Device ‘ Device Setting Area Setting Channel Group Setting

Delete

Device Type

ncoding Device (Online/Total number:1/1) Add Evacuation System
ecoder (Online/Total number:0/0)
larm Host (Online/Total number:0/0)

VA-6200MA

ccess Control System (Online/Total numbe| : admin (ITT Y]
[vacuation System (Online/Total number:0/!
ED Display Device (Online/Total number:0,

htelligent Analysis Server (Online/Total nun

torage Server (Online/Total number:1/1)

3. Go to Home->Evacuation System.

J Host Status | MICS Status EM Status

Evacuation System V8 General Status

Search Q Main Amp Status .
_____ 2 an Standby Amp Status .
AC Power Status [ ]
AR DC Power Status %)
System Emergency Output 2

Speakers Zones Status

Zonel Zone? Zone3 Zoned Zone5 Zoneb Zone7 Zone8

Line A @ o o ® ® ® ® ®
LinnrB ® ® ® ® ©® © ©® o

Contact Input Status

Inputl Input2 Input3 Input4 InputS Inputé Input7 Input8

Line A @ o o ® o ® ® o

Contact Output Status

In the above interface, you can view the host status, MICS status and EM-MIC status. Click @ on the top right corner to view the
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meanings of each icon.

Host Status. MICS Status EM Status

G default area

o

Status description:
Main amplifier status: Normal or fault
Standby amplifier status: Normal or fault
System Emergency output status: Emergency mode/normal
Partition state: Normal, working, open circuit, short circuit, overload, fire alarm (line A and line B; each line has 8 zones)
AC power supply status: 220V AC normal or fault
DC power supply status: 24V DC normal or fault
Contact input state: normal, short circuit, open or trigger (each host set a total of 8 trigger display)
Contact output status: link or close
Remote MIC status: network status (online or offline), device status (normal or fault), computer connection status(normal or fault)

EM MIC status: network status (online or offline), device status (normal or fault), computer connection status(normal or fault)

®  Search the online/offline status of the evacuation system
Go to Home—>Operation and Maintenance Management->Status Log. Select the type as “Evacuation system online/offline” and then click

[OK] to view the online/offline status of the evacuation system.

Check and Export Log Backup and Restore Configuration Real-time Status Status Log

Start Time —05-18 00:00:00 @ End Time 2022-05-18 23:59:59 @

No. Type Record Time  Node Name Details

cctAll Reverse  Clear All Q | cancer | “

~

"DDD/

wice offline
W
O
Evacuation System Online
Evacuation System Offline
W
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21 Account and Permission

21.1 Create Account

Go to Home—> Account and Permission.

J User Management ‘ Permission Management

Online User Management

Edit Security Questions / Answers

O admin ON

Super Administrator

00:00:00:00:00:00 OFF

There is a default super admin user (the username is admin; the password is 123456). The super admin user cannot be deleted.

If it is the first time for you to log in, please select the super admin user and then click “Create Security Questions/Answers” to set the

questions and answers. It is very important to reset the password if you forget your password.

J User Management | Permission Management

Online User Management

Edit Security Questions / Answers

I 1
Edit Security Ques'ions / Answers

User Name admin

Password Enter Password

x

o]

Cancel

10:00:00:00

/

Create Security Questions / Answers

Question:

Answer:
Question:
/ Answer:

Question:

Answer:

Edit Security Questions / Answers X

Click [Add] to prompt an adding user window as shown below.

Add User *

Enable B

User Name*

Password®

Confinm Password*

Display Passward [

Permission Group*

Remark

Password strength® O Weak O Middle © Strong

Contains four types of uppercase betters, lowercase letters, numbers and specal
charactars, and the password lenath is not less than 8 diaits!

ain wiac aaeress (.

Cancel

Enter user name and password. Then select password level, permission group (it must be set in advance). Binding MAC address or remark

can be filled in as needed. After that, click [OK] to save.

21.2 User Permission Settings

Go to Home->Account and Permission = User Permission Group Setting.

(D  Click [Add] to create permission group.
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User Mar P ission M. it Online User Management

Add Permission Group

Permission Group Name

J System Permission Operation Permission Area Permission TV Wall Permission Target Permission

Select All Reverse Clear All

[J Resource Management [ Server Management [J Record Setting

[ Alarm Management [ E-Map O TV Wall Management
[ Parking Lot Management O Configuration [J Target Counting

[ Search [J Face Greeting [J Face Attendance

[ Access Control Management [J Body Temperature Measurement [J Group Management
[J Data Dashboard [J Evacuation System

“ cane

@  Enter permission group name.

(®  Select system permission, operation permission, area permission and TV wall permission as needed.

21.3 Online User Management

In this interface, you can view the online user who log onto the management server. The user type includes monitoring client, web client,
platform SDK, APP, etc.

User Management Permission Management | Online User Management

1 10.20.52.7 admin Monitoring client Super Administr...
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22 Operation and Maintenance Management

22.1 Check and Export Log

Go to Home->Operation and Maintenance Management.
Click the “Check and Export Log” tab as shown below. All types of logs can be searched and exported here.

Check and Exportlog  Backup and Hestore Configuration.  Real-time Status  Status Log
T T T BT TR
St e BB 113000000 127 End T 20 NER . | oo |
No. Iain Type Record Time Node Name. Liser Address Details. Storage Playback  Deyice Flayback  Storage)
1 Alarm Log 2022-01-13 145856 I jone
2 larmiLog 2027-01-13 145855 Device Named853 1156 Mone o)
Al Log 2027-01-12 145853 Devicw Nameds53_IP166 Manitoring Point-Fa Nane Nans @
4 Alann Log 7401-13 145853 Manitoring Point-M. Mone None
Alarn Log 2022-01-13 145857 None Mone
6 Alarn Log 2027-01-13 145851 I Marnitoring Point-Fa None Mone
Operation Log 2020-01-13 145851 Barrler Gate Mone Mone QFF

Select the log type, set the start time and the end time and then click [Search] to search logs. After the logs are searched, click [Export] to

export these logs.

22.2 Backup and Restore Configuration

Go to Home->Operation and Maintenance Management. Click “Backup and Restore Configuration” to go to the following interface.

Check and Export Log Backup and Restore Configuration Real-time Status Status Log

Backup System Configuration Restore System Configuration

Caution: It will take several minutes to restore system configuration. Do not shut down the computer during restoring. The authentication server will
restart automatically after restoration.

You can import the former system configuration files to the new version. Click [Backup System Configuration] in the last version to
backup the system configuration files. Then click [Restore System Configuration] in the new version to restore the system configuration.

22.3 Viewing Online Status

Go to Home—>Operation and Maintenance Management->Online Status interface.
You can view the online status of encoding device, decoders, alarm host and storage servers and the record status of the storage server and

encoding devices.

Check and Export Log Backup and Restore Configuration Reat-time Status Status Log
Encoding Device Decoder Online Alarm Host Online - s Record Status of the Record Status of
i.:- COnline Status = Status <_.~:.—....‘ Status Fa il ol - Serref Unilte Statu .-"""_; p Storage Server y Encoding Device:
b ’51.61% ‘:I; N 0% ‘:'l 3 0.00% 100% 75% i § 0% \ . 28.57%
W Oniine: 16 Y m o Y i W Online: 1 W Online: & WY W Video rocornding: O L AT i
n n n [ ] " L n
Dovice Name  Type  Channel Number.  Alarm In Number | Alaim Qub Number | 1P Address/IP Range/Domain Name/Serial.,  Pat  Online Stalus | Afarm Status | Open in the By
F
& PVG 4]
@ NVR 0
@ defautt area
& 02147522237 Dahua 2 77 [+ E
Standard D.. 1 1 9008 Onlire n B
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22.4 Viewing Status Log

Go to Home—->Operation and Maintenance Management—> Status Log interface.

Check and Export Log Backup and Restore Configuration Real-time Status | Status Log L
Ftart Time | pi2#-01-13 00:00:00 End Time 2022-01-13 23:59:59

1 Server online 2022-01-13 14....

2 Server offline 2022-01-13 14....

3 Encoding device online  2022-01-13 14:... P

4 Monitor online 2022-01-13 14.... IF

5 Encoding device online  2022-01-13 14:... IP Camera5
6 Meonitor online 2022-01-13 14.... IP Camera5

In this interface, record status, online or offline status of servers and monitor client can be viewed.
Set the start time and the end time and then click [Search] to search status logs.
The searched logs can be exported by clicking [Export].
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23 Configuration

23.1 Record and Snapshot Settings

Go to Home—> Configuration.

Playback Source

Save Recording Files To

Save Backup Files To

Backup File Format

Save Snapshots To

From Network Device

C:frecord

C:/backup

AVI

C:/capture

Snapshot Number 5

Max File Size for Manual Recording and Record Backup

© 512MB

Apply

Q16B O 2GB

In this interface, the storage path of recording files, backup files and snapshots, backup file format, snapshot number and max file size for

manual recording and record backup can be set up here.

23.2 Local Settings

Go to Home-> Configuration-> Local Setting.

Auto Startup

Auto Login

Trigger audio when the node is offline
Show tips when the node is offline

Full name display for DVR/NVR's channels
Resource tree automatically expands
Substream display of new view

Show alarm state for the monitering point
Show device name on E-map

Verify the password before exiting the program
Decoding Mode

Resource Tree Sorting Rules

Video Configuration Rules

Select Language
Temperature Unit
Time Display Format
Alarm Sound

Node Dropped Sound

Sensor Alarm Sound

O Soft Decoding © Hardware Decoding

© Sort by Name O Sort by Time

O Specification First @ Clarity First

English(United States)

°C

yyyy-MM-dd hh:mm:ss
o)
)

o)

Apply

Auto Startup: if enabled, the system will automatically start when the computer starts.

Auto Login: if enabled the system will automatically log in when running this software next time.

Trigger audio when the node is offline: if enabled, the system will trigger audio when there is node offline.

Show tips when the node is offline: if enabled, the system will pop up tips when there is node offline.

Full name display for DVR/NVR’s channels: if enabled, the DVR/NVR’s channel name listed in the resource tree will show the
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DVR/NVR name and the channel name. If disabled, only the channel name is shown.
Substream display of new view: if enabled, the new view will be displayed at substream.

Show alarm state for the monitoring point: if enabled, the alarm state will be displayed in the monitoring point list as shown below.

Monitoring Point v

Q
B- Q) default area (Online/Total num...
-| Il Pevice Name_IP01
- [ Device Name_IP03
Device Name_IP04
- [l Device Name_IP05
Device Name_IP07
B Device Name_IPC
Device Name_M232IE-HFPS
B IPC

Show device name on E-Map: if enabled, the device name will be displayed on the E-Map.
Decoding Mode: Soft decoding or hardware decoding is optional. When the graphics card doesn’t support hardware decoding, please
select “Soft Decoding” and the video decoding will be taken over by CPU.

Temperature Unit: °C or °F can be selected
Verify the password before exiting the program: if enabled, you shall enter the password before exiting the program.

In this interface, you can also select the resource tree sorting rules, video configuration rules, language, time display format and upload

various alarm audio files.

23.3 Overload Settings

This system supports CPU and memory overload protection. When the system overloads, the monitor client will restrict the new live view
and playback operation and the overload tip will prompt. Go to Home—>| Configuration=>Overload Setting. Select the overload upper limit
and then click [Apply] to save the settings.

Overload Upper Limit  CPU:85% Memory:85%

Apply

23.4 Alarm View Settings

Go to Home—> Configuration> Alarm View Setting.
Record and Snapshot Setting Local Setting Owerload Setting Alarm View Setting 050 Position Setting POS Config

Automatic Pop-up Alarm Page (@D
Full screen display when popping up
Cloge Alarm Page  © Auto Shutdown Manual Shutdown
Time  305ec

Number of Screens

In this interface, users can enable “Automatic Pop-up Alarm Page” or “Full Screen Display when Popping up”, set “automatically

/manually close alarm page” and select the number of screens (1/4/6/19 optional).
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23.5 OSD Position Configuration

Click Home-> Configuration>0OSD Position Config to go to the following interface.

Apply

Drag the slider to the position you want to show the OSD and then click “Apply” to save the settings.

23.6 System Configuration

Click Home—> Configuration->System Config to go to the following interface.

System Name
Alarm Preview Using Third Stream
Hide Alarms Cutside The Linkage Schedule

Same Alarm Reporting Interva

Device Time Correction B Device Time Correction (Automatic synchronization of platform time to equipment every 2 hours) B Synchronize Time Zone ESlsaltllrEREER TN
Service Fault Determination Time 1 Mins
Log Retention Time: 365 Day

License Plate Language Default

Apply

In this interface, you can enable “Alarm preview using third stream”.

Enable and set the same alarm reporting interval and its linked alarm type.

Choose “Synchronize devices” and “Synchronize Time Zone” and then click [Synchronize Platform Time] to synchronize the device times
with the time of the platform.

Hide alarms beyond the alarm linkage schedule: Alarms will not be viewed beyond the alarm linkage schedule.

Service fault determination time: set the failure duration time. When the server failure exceeds this period of time, it will be determined as

“Offline”. The spare server will take over.

23.7 POS information Settings

Go to Home->Configuration>POS Config interface as shown below. In this interface, you can set the position, display time and quantity
of the POS information.
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Record and Snapshot Setting Local Setting Overload Setting Alarm View Setting OSD Paosition Setting POS Config

Duration (s ) 30

Max number 10

Apply

Note: The video files with POS information saved as DAT format can be played with DatPlayer and the POS information will be shown on
the screen.

23.8 Audio Uploading

Go to Home-> Configuration>Audio Uploading.
Click [Add] to bring the following box.

Record and Snapshot Setting  LocalSetting  Owverload Sefting Alsm View Setting 05D Position Setting ~ POSConflg  SystemSetting | Audio Uploading Setting

il Audio Uploading Setting *x

Click [Browse] to choose the audio file and then enter the audio name. Click [OK] to save this audio. After the audio is uploaded
successfully, you can listen to it.
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24 Data Dashboard

Before opening the data dashboard, please makes sure the intelligent server is online.
Go to Home—>Resource Management-> Intelligent Analysis Server interface. There is a default intelligent server and make sure it is

online.

&

Encoding Device (Online/Total number:59/7

Decoder (Online/Total number:0/5)
Alarm Host (Online/Total number:0/1)

Access Control System (Online/Total numbe)

LED Display Device (Online /Tatal pumberd

Intelligent Analysis Server (Online/Total nun

| Storage server (Unhine/1otal number:1/1)

Add, Edit or Delete Device Device Setting Area Setting

Device Type Server Name

Intelligent Server

Channel Group Setting

IP Address Port Client Connection Status Authentication Server Connection Sta... Edit
10.214.200.200 6069 Online Online Z

24.1 Create Intelligent Dashboard

Go to Home—>Intelligent Dashboard.

The current board has no content

Immediately Create

Click [Immediately Create] to create the layout of the data dashboard. Drag the module you want to display to the right preview window as

needed. After that, click [OK] to save the settings.

Basic Module

Statistical Chart Of
Attendance Data

Face Comparison

Face Comparison
Statistics

Body Temperature
Measurement

E-Map

E-Map Monitoring

Calendar

Attendance Data
Line Graph

Face Comparison
Record

Body Temperature Measurement

Heat Map

Preview

Property Setting(Alarm Statistics)

Service Device Monitoring Point Sensor

Subsystem Zone Access Point

Cancel

Hover the cursor onto the module in the preview window and then you will see a deletion button (

). Click it to remove the module
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from the preview window.

Layout X
Basic Module Preview

Calendar

Statistical Chart Of  Attendance Data
Attendance Data Line Graph

Face Comparison

Face Comparison
(o i

ra
After the data dashboard is created, click Eto display it in full screen mode. Click or ESC to exit the full screen mode. Click
E to set the layout of the dashboard.

24.2 Basic Module

Video window supports 4-screen display mode. Click I to extend the monitoring points. Drag the camera to the preview window or
double click the camera to play the video. You can drag the playing window to other windows.
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Other modules can set its attributes that you want to display as needed.

Basic Module © Preview

Face Comparison

Face Comparison  Face Comparison
Statistics Record
- Property Setting(Statistical Chart Of Attendance Data)
Body Temperature Measurement

Body Temperature

Measurement M Late Leave Early Overtime E Absent
E-Map
Leave
E-Map Monitoring Heat Map

Cmart Cnanchnt

Cancel

Alarm Statistics

Monitoring Point ESI}lEhI
\ Record(EncodingDevice)

Monitoring Point: 65018 Record(Stora

ver

cess Control System

Alarm Host

Service: 73

Decoder

Encoding Device 10/31

O Door: 265

24.3 Face Comparison Display

Face Comparison display includes face comparison statistics and face comparison record display. In the layout interface, drag these two
modules to the preview window. Then you can set the attributes as needed.
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Basic Module

Video Windows Device Status

Alarm Statistics Calendar

Statistical Chart Of  Attendance Data
Attendance Data Line Graph

Face Comparison

Face Comparison
Record

Body Temperature Measurement

Body Temperature
Measurement

E-Map
E-Map Monitoring Heat Map

Cmart Snanchnt

Preview

Property Setting(Face Comparison Statistics)

Passed today Abnormal body temperature Withou

Block List Stranger

“ ‘ g

Smart Snapshot module: You can set the snapshot channel and attributes.

Face Comparison Statistics

14305

In the face comparison records, you can view the comparison similarity. Click to quickly skip to face comparison retrieval interface.

Click to pop up the detail box. In this box, you can modify the personnel information; click

database.

-\ @ Stranger

Y ma

-\ @ Stranger

Y |am

R - Stranger

] @ Stranger

Y mE

R . Stranger

24.4 Body Temperature Measurement Display

Alarm Source L Alarm Time 1113 4.

to add this person to the face

Verified Target Info(details) x

Add to Group x

VIP List

Cancel Brock Ust El -

In the layout interface, select the body temperature module and then set the attributes you want to display as shown below.

Preview

Calendar

i Attendanee Diata

Line Graph

Body Temperature Measurement

E-Map

Heal Mag

Property Setting(Body Temperature Measurement)

B Passed today 8 Suspected fever Without a mask

“ Sliichs
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The body temperature measurement of the intelligent dashboard is shown as below.

Body Temperature Measurement

Without a mask
Capture Stat 2

cted fever Without a mask

24.5 E-map Display

E-Map includes E-map monitoring and heat map analysis. The layout settings are as follows.

Basic Module Preview

Device Status

Alarm Statistics Calendar

Statistical Chart Of  Attendance Data
Attendance Data Line Graph

Face Comparison

Face Comparison ~ Face Comparison
Statistics Record
Property Setting(E-Map Monitoring)
Body Temperature Measurement

Body Temperature

Measursment IPC Smart IPC [J Sensor [J Subsystem
E-Map
0O Zone (J Door
Heat Map

Smart Gnanchnt

“‘ Cancel \

You need to set the hotspots in advance and then you can view here. Please refer to E-Map—> E-Map Monitoring for details.

297 ks of
Map Management N Map Satellite

New York

[osars sbone v docs 52iaz oeze | Terms s | et s mas e |
Close All Stream  Fitter Alarm Type | Clear All

Heat map module: The more people/vehicles enter, the deeper the color is. Move the cursor on the monitoring point to view the current

traffic flow. You need to set the E-map and hotspots in advance. Please refer to E-map settings chapter for details.

Besides the above hotspot setting, you can set other parameters as shown below.

152



Basic Module Preview
Video Windows Device Status
Alarm Statistics Calendar

Statistical Chart Of  Attendance Data
Attendance Data Line Graph

Face Comparison
Face Comparison  Face Comparison

Statistics Record
Property Setting(Heat Map)

Body Temperature Measurement
IPC Smart IPC Subsystem

Body Temperature

Zone Sensor Door

Measurement
E-Map Human N Total No.(IN)
E-Map Monitoring Human minute -]
Smart Snanchnt Mator Vehicle

Non-motor Vehicle
Cancel

In the heat map module of the intelligent dashboard, you can view the statistics of human/motor-vehicle/non-motor vehicle.

Heat Map
Map Management v

®
- :
l

L

|P Cameradp Camera5) o

24.6 Smart Snapshot Display

You need to set the snapshot attributes in the layout interface and then the relevant data can be viewed on the dashboard. The smart

snapshot type includes face, license plate, human body, motor vehicle and non-motor vehicle. Please select them as needed.
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Preview
Statistical Chart Of  Attendance Data
Attendance Data Line Graph

Face Comparison

Face Comparison  Face Comparison
Statistics Record

Body Temperature Measurement

Body Temperature
Measurement
E-Map
Property Setting(Smart Snapshot)

E-Map Monitoring Heat Map T

Face detection [J License plate detection
Smart Snapshot

Human body detection Motor vehicle detection

Traffic Flow Statistics Smart Snapshot Channel 1P Camera;IP Camera;IP Car

Traffic Flow  Traffic Proportion

“| Cancel \

24.7 Traffic Flow Statistics Display

You need to set the statistical type, auto refreshing interval and channel in advance. Please refer to Target Counting - Task Management

for details. Then set the layout of traffic statistics and display attributes.

Smart Snapshot

Human Ll

Human pinute

“ Concel

Traffic Flow Statistics Traffic Ranking of Each Monitoring Point(Total No.(IN))

IP Camera; 8019
|

Entrance: 364

Exit:
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24.8 Remaining Parking Space Display

Select the parking lot in the property area and then you can view the remaining parking lot here.
Remaining Parking Space

100/100

100/100

P1P1P1 . 9257/10000
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25 Web Client

25.1 Operating Environment of Web Client

The web client supports IE9/IE10/IE11, Firefox or Google browser. Please make sure that your browser supports the downloading and use
of the Web Client. Here we take IE Client for example.
»  Check whether the IE browser prohibits Active X control from downloading:

Open IE browser, click E%Internet Options—> Security—>Custom level...to pop up a security settings window. Then enable all sub
options under “Active X controls and plug-ins”.

»  Check whether there are other components or antivirus to stop downloading Active X control. Please close other components and

configure antivirus and firewall to allow the installation of the plugin files.

25.2 start IE Client

Before starting IE client, make sure all servers must be started first.

< Login

Input the IP address or domain name of Authentication Server and the web server port, for example: http://192.168.50.3:8088 (In this
example, IP address is 192.168.50.3. The default web server port is 8088) to go to IE Client. Then input the user name and password you
created in Account and Permission interface, select the language and platform and then click “Login” to login to the IE client.

EEUENEN Please enter username.

GEEEUTIG I Please enter password.

Login to: Platform

'\ Login

Please download the relevant Active X controls according to the tips if you login to the IE client for the first time.

In the platform interface, users can modify the login password and remotely set the monitor client and configuration client. In the web
monitor client, click “Return to Configuration” to go to the web configuration client. In the web configuration client, click “Return to
Monitor” to go to the web monitor client. In the web monitor client or configuration client, click the platform logo to return to the platform

interface.

The operation steps of this web client interface are similar as the monitor client. Please refer to relevant chapter for details.
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26 Troubleshooting

1.  How to modify the password by yourself?
Login monitor client and then go to the Account and Permission interface. Select the account and click I 1o modify the password.

Modify User x

[}

Old Password*

Password*

Confirm Password*

At least 8 digits in length, including three or more of numbers/lowercase lettersfuppercase
letters/symbals

Display Password OJ

Bind MAC Address

Remark

2. Unable to work normally after starting server.
1)  Please check whether the port is occupied and view the run status of the service as shown below

1% Windows Task Manager ln o’ S

File Options View Help

|Applimtions I Processed | Services | performance I Networking |Users |

=
Mame FID Description Status Group =

AudioEndpointBu... 1100 Windows A...  Running LocalSy:
ServerTrayMgrApp 5056  ServerTray... Running N/A
AlarmServerApp 2852 AlarmServ...  Running N/A
TvwallServerApp 3456  TvWalServ... Running N/A
StorageServerApp 2860  StorageSer...  Running N/

i MediaTransferSe.,, 1096  MediaTran... | Running | MNfA
ConfigServerdpp 4316 Cc:nﬁgSner\r...I_|5.ﬁi$I NfA
AuthenticationSe... 4592  Authentica...  Running MN/A

[m]

wpsdoudsvr WPS Office... Stopped MN/A
FhuDongFangyu 4796 Runining MN/A
Wsearch 4540  Windows S...  Running MN/A
WMPMetworkSve 4688 Windows M...  Running MN/A
wmiApSry WMI Perfo...  Stopped MN/A
whengine Block Level.., Stopped MN/A =
1| 1 | 3
Processes: 60 CPU Usage: 0% Physical Memory: 59%

3. The device information cannot be seen or the device is offline after the user logins to the monitor client.

1)  Please check whether this user account is an administrator account. If this account is an operator account, please check whether it has
the authority to view the device information.

2)  Please check whether the media transfer server of the device has been started.

4. The alarm information cannot be received after the user logins to the monitor client.

1)  Please check whether the schedule of the event (including motion alarm, sensor alarm, line crossing detection, etc.) is set in the
NVMS system.

2)  As for remote login device in the monitor client, please check whether alarms and alarm schedules of the remote login device have
enabled.
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5. The record cannot playback after the user logins to the monitor client.

1) Please check whether the storage server is online. If it is online, please check whether this account logged on has playback
permission.

2)  Please check whether the record source selected has record data. If you want to get record data from a storage server, please check
whether to set the record schedule of the storage server or not.

3)  Check whether there are record data in the playback channel and whether the record source and the start time and the end time of the
playback is set up correctly.

4)  Please check the record schedules of the storage server are set correctly.

6. The configuration of devices cannot be modified remotely after the user logins to the monitor client.

1)  When the device configuration is required by the monitor client and prompts “Someone is configuring. Please try later”, please open
the IE browser to login to the device remotely and then go to “Online user” interface to see if there are any other users logging in.

2)  Please go to the live to see whether the device is being set up.

3)  If the problem still exists, please contact your device manufacturer.

7. The preview image on the client cannot display fluently.

1) Please check whether the CPU occupancy rate of the client platform is 100% or there still has usable memory. This situation will not
emerge when the CPU occupancy rate is less than 75% and there still has usable memory.

2)  Please check whether the network environment is supported, including whether the uplink bandwidth of the device and stream match
and whether the downlink bandwidth of the media transfer server and the streams of all channels of devices match.

3)  Please check whether the media transfer server is overload operation.

8. After starting the authentication server and media transfer server, the storage server still cannot save.
1)  Please check whether channels of devices are added to the storage server.

Notes

1. Please use super administrator or standard user (permission control is set to “Never Notify”) to log in operation system, install and use
servers and client software.

2. The resolution of the surveillance client’s monitor shall be more than 1280*960.

3. If you want to delete the files of a server, please stop the server first.
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Appendix

1. How to get video streams via Media Stream Server
Media stream server is used to get the video stream by the third-party via RTSP/HLS/RTMP protocol.
(1) Configuring media stream server
®  Right click the server tray icon and select “Display main interface” to pop up the server tray interface as shown below.

®  Click “Configure” of the stream media server.

- ServerTrayUl
Server Spatus ot Part Configure
Configuration Server P Running o 7002 Apply
m HTTP Server P Running aO 8080 Apply
Transfer Server P Running [ ®] B006/2009 Canfigure
Storage Server P Running & 5009 Apply
ServerP Address: Sz | AL © ’ =
10.20.52.7 e B roser, @D o i
Tver P Running @O Apply
1 Anatysis Server P Running [ @] G069 App
P Running & 6073 Configure
[ Running [ @] Configure
Display main interface e e o LA @
0(c)5(h)36(m)19(e) Agpiication Server P runion @D 5093 Auply

Quit

®  Confirm the IP address of the management server and stream media server. The default IP addresses of both are

“127.0.0.1”. If these two servers are distributed, please enter the IP address according to the actual network parameter.

Streaming Gateway Config X

Fa

Http Port 8090

Management Server User admin

Mariagement Server Password | eeeeee | ‘

Management Server I[P 127.0.0.1

o
E=}w L=i QR =d g e L i v 8 riviv)

Stream Media Server [P 127.0.0.1

RTSP Port 554
HLS Port 8091

RTMP Port 1935

[ PrePull

[C] Enable Authentication

o S

(2) Get URL and test video playing

®  Open the postman tool (or use the Google browser) to get the channel code of the camera added to the platform (NVMS).

159



The format of GET: http://stream media server’s IP:8090/api/device/list

Mo Frviromment L

gl X 070IT4E —— N 31745 LI s

Untitled Request

cer TR e v m o

WALUE DESCRIFTION

®  Request 3 URL addresses of the camera as shown below.

(POST)
. . 4+ N Emvirsnmen . '
Untithed Request
£ = 1 send - [EM
o2 5
g
E: :‘“! '.::xt:. \' SOS0S T~ $102- 0000 - ATAD- SN FTASIEL",
“stremn fee: 2 .
= = ma

The format of 1 marked in the above picture: http://stream media server’s IP:8090/api/live/video
The format of 4 marked in the above picture:

{
"channel_code": "XXXXXXXX", (copy from the step 1)
"stream_type™: 2

¥

®  Use the VLC player to test video playing. Enter the obtained URL to the VLC player as shown below. In the real
application, the third-party can get the channel code and URL address and integrate them to their own platform.
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& Open Media
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